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A Word to Reader

This book will be useful of all those who are preparing for interviews and various

competitive examinations, where the most basic and also in-depth understanding of

computers is required. The book is divided in three parts—

* Fundamental—Cover basic questions on computers from day to day

awareness of computers.

* Application—Cover questions related to computer applications, it includes

Windows Operating System and Keyboard Shortcuts, Microsoft Office,

Microsoft Word, PowerPoint, Access and Excel.

* Advance—Covers questions on advance topics on computer, it includes

Operating system, Software Engineering, Data Structures and Algorithms,

Electronics Data Processing, Data Mining and Data ware house, Parallel

Computing and Window Programming, Data Base Management Systems.

Author hopes that this book will fulfil the needs of those who are in search of

relevant questions on computers.

With best wishes,

— Dr. Alok Kumar

yoursmahboob.wordpress.com
        (shared by Sujoy)



CONTENTS

Computer : Fundamental

➨ Computer Awareness…………………………………………………………… 3–13

➨ Computer Security……………………………………………………………… 14–16

Computer : Application

➨ Microsoft Windows Operating System………………………………………… 19–19

➨ Microsoft Windows Keyboard Shortcuts……………………………………… 20–23

➨ Microsoft Office…………………………………………………………..…… 24–25

➨ Microsoft Word………………………………………………………………… 26–28

➨ Microsoft Excel………………………………………………………………… 29–42

➨ Microsoft PowerPoint…………………………….………….………………… 43–54

➨ Microsoft  Access……………………………………………………………… 55–60

Computer : Advance

➨ Operating System……………………………………………….……………… 63–84

➨ Software Engineering………………………………………………...………… 85–110

➨ Data Structures and Algorithms………………………………………...……… 111–114

➨ Data Mining and Data Ware House………………………………………….… 115–124

➨ Electronics Data Processing…………………………………………………… 125–127

➨ Parallel Computing………………………………………………..…………… 128–131

➨ Window Programming…………………………………………….…………… 132–135

➨ Data Base Management System (DBMS)……………………………………… 136–144

yoursmahboob.wordpress.com
        (shared by Sujoy)



COMPUTER : FUNDCOMPUTER : FUNDCOMPUTER : FUNDCOMPUTER : FUNDCOMPUTER : FUNDAMENTAMENTAMENTAMENTAMENTALALALALAL

Computer AComputer AComputer AComputer AComputer Awwwwwarararararenessenessenessenesseness

Computer SecurityComputer SecurityComputer SecurityComputer SecurityComputer Security

yoursmahboob.wordpress.com
        (shared by Sujoy)



yoursmahboob.wordpress.com
        (shared by Sujoy)



COMPUTER AWARENESS

1. The following device allows the user to add
external components to a computer system
(A) Storage devices
(B) Keyboards
(C) Ports/ system boards
(D) Diskettes

2. Software that manages data in more than
one file at a time and these files are treated
as tables with rows and columns rather than
as lists of records is
(A) Relational Data Base Management

Package
(B) Data Base Management Package
(C) Documentation Package
(D) None of these

3. A program that remains in the memory while
other programs are executing
(A) Resident Program
(B) Non-Resident Program
(C) Permanent Program
(D) None of these

4. The total time elapsed between submission
of command and data to a computer and
getting the result of computation is the
(A) Access time (B) Response time
(C) Entrance time (D) None of these

5. An  automatic  machine  that  is  made  to
perform routine human tasks is
(A) Computer (B) Robot
(C) Tanker (D) None of these

6. The time required to complete a single,
continuous execution of an object program
is called
(A) Run time (B) Access time
(C) Random time (D) Response time

7. Computer network is a
(A) A distributed data processing system
(B) Multiple computers are linked together

for the purpose of data communication
and resource sharing

(C) Both A & B are false
(D) Both A & B are true

8. A process  of collecting, organizing, storing
and   otherwise   maintaining   a  complete
historical  record  of  programs  and  other
documents  used  or  prepared  during the
different phases of the system is called
(A) Documentation (B) Document reader
(C) Data process  (D) None of these

9. What are connector symbol?
(A) They are used in a flowchart
(B) It represents a junction in a flow line
(C) Often used to transfer flow between

different pages of a lengthy chart
(D) All the above

10. Console is
(A) A device that enables human operators

to communicate with the computer
(B) A device that enables human operators

not to communicate with the computer
(C) Communication between computers
(D) None of these

11. Constant is a value written into a program
instruction
(A) that does not change during the

execution of the program
(B) that can change during the execution of

the program
(C) that can vary during the execution of the

program
(D) none of these

12. A removable direct-access storage medium
containing multiple magnetic disks mounted
vertically on a single-shaft is referred as
(A) Tape pack (B) Disk pack
(C) Cylinder (D) None of these

13. Diskette is a
(A) A low-cost, thin flexible magnetic disk

storage device
(B) High volume  storage device
(C) Primary storage device
(D) None of these
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4  |  M.C.Qs. on Computer

14. An optical input device that is used to read
documents printed in a special type font is
known as
(A) Document reader (B) Documentation
(C) Printer (D) None of these

15. For checking spelling one uses
(A) Dictionary Disk (B) Index disk
(C) Directory (D) None of these

16. Process of finding/ correcting program errors
is
(A) Bugs (B) Debugging
(C) Hacking (D) Cracking

17. Diagnostic routines is a
(A) Programs used to print error messages
(B) Indicates system problems and

improper program instructions.
(C) Both A & B are true
(D) None of these

18. The term DBMS is referred to
(A) Data Base Management system
(B) The software used for the management,

maintenance and retrieval of the data
stored in a data base

(C) Both A & B are true
(D) None of these

19. The speed at which data is transferred from
the main memory to another medium on
which data are recorded is referred as
(A) Data transfer rate (B) Byte
(C) Buds (D) None of these

20. The time period during which a computer is
malfunctioning or not operating correctly due
to machine failures is referred as
(A) Downtime (B) Uptime
(C) Runtime (D) None of these

21. Automatic execution of high-priority computer
programs that have been designed to pre-
empt the use of computer resources is
referred as
(A) Foreground processing
(B) background processing
(C) black processing
(D) white processing

22. Digitizer is an input device
(A) Used to convert graphic and pictorial

data into binary inputs for a digital
computer

(B) Used to convert graphic and pictorial
data into analog inputs for a digital
computer.

(C) Used for debugging
(D) None of these

23. A storage devices where the access time is

effectively independent of the location of the

data is referred as

(A) Direct access  (B) Secondary storage

(C) Primary storage(D) None of these

24. A pictorial representation that uses pre-

defined symbols to describe either the logic

of a computer program or the data flow and

processing steps of a system is referred as

(A) Flowchart (B) Algorithm

(C) Program (D) None of these

25. A flat, circular plate coated with a magnetic

material on which data can be stored by

magnetization of portions of the flat surface

is

(A) Disk (B) Tape

(C) Pen drive (D) None of these

26. Disk operating system is referred for

(A) DOS

(B) Operating system which contains the

disk-oriented commands and uses disk

devices for permanent storage

(C) Both A & B

(D) None of these

27. Document reader is

(A) An optical input device  used to read

documents

(B) A device that arrange the documents

(C) A device that is used to edit document

(D) None of these

28. One or more identifying lines printed at the

bottom of a page are referred as

(A) Header (B) Footer

(C) Index (D) None of these

29. FORTRAN  is

(A) Formula Translation

(B) A high-level mathematically oriented

programming language

(C) Both A & B

(D) None of these

30. A CPU designed specifically to handle the

communications processing task with main

purpose is to off-load communications

processing task from the host computer so

that the host computer can be dedicated for

applications and data processing jobs.

(A) Backend processor
(B) Front-end processor
(C) Node processor
(D) None of these

yoursmahboob.wordpress.com
        (shared by Sujoy)



M.C.Qs. on Computer  |  5

31. An adder which adds three binary digits and
outputs a result bit and a carry bit is referred
as
(A) Half adder (B) Quarter adder
(C) Full adder (D) None of these

32. Emulator is a program that
(A) Permits one computer to execute the

machine-language instructions of
another computer of a different make

(B) Which is not broken down into smaller
units

(C) Permits one computer to execute the
machine-language instructions of
another computer of same make.

(D) None of these

33. Emulator is a program that
(A) Permits one computer to execute the

machine-language instructions of
another computer of a different make

(B) Which is not broken down into smaller
units

(C) Permits one computer to execute the
machine-language instructions of
another computer of same make.

(D) None of these

34. EDP is referred to
(A) Electronic Data Processing
(B) Data processing through equipment

that is predominantly electronic such as
digital computer

(C) Both A & B
(D) None of these

35. Internet banking is an example of
(A) Electronic funds transfer (EFT)
(B) EDP (Electronic Data Processing )
(C) EBCDIC
(D) ASCII

36. EBCDIC is
(A) 6-bit coding system
(B) 7-bit coding system
(C) 8-bit coding system
(D) 9-bit coding system

37. A data communication facility on which data
can be transmitted in two directions is
referred as
(A) Duplex (B) Simplex
(C) Triplex (D) None of these

38. Electronic Mail /Message System (EMMS)
best suits to
(A) Postal service
(B) Telephone service
(C) Telegraph service
(D) None of these

39. Digital Computer is a computer
(A) that works with discrete quantities
(B) that  works with analog quantities
(C) Both A & B
(D) None of these

40. The  subdivision of fields
(A) always done to give the programmer

greater flexibility
(B) dependent on  programming language

used
(C) never accomplished on fields containing

numeric data
(D) all the above

41. The checking operation performed on input
is called
(A) validation of data  (B) verification of data
(C) vilification of data (D) control of data

42. A device that attaches to both ends of an
electrical bus and prevents reflection of
echoes of signals that reach the end of the
bus is called
(A) Terminator (B) Connector
(C) Processor (D) None of these

43. A device mounted on a communication
satellite which receives, amplifies and
retransmits signals’ from earth stations is
called
(A) Terminator (B) Connector
(C) Processor (D) Transponder

44. Technique of using disk space to make
programs believe that the system contains
more random access memory (RAM) than
is actually available is called
(A) Virtual memory
(B) Secondary memory
(C) Primary memory
(D) None of these

45. A term means that the application software
is priced separately from the computer
hardware is called
(A) Unbundled (B) Bundled
(C) Utility (D) None of these

46. Following is not the operating system
(A) UNIX (B) DOS
(C) WINDOWS (D) BASIC

47. Which of the following is true concerning
personal computers?
(A) They have been most successful in the

home.
(B) They are user friendly
(C) No specific programming technique

required
(D) All the above.
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48. While buying a PC system, one should first
(A) identify hardware components
(B) define computing needs
(C) both A and B
(D) None of these

49. The  microcomputers  which  have  the  same
operating    characteristics    as    the   IBM
microcomputers are called
(A) IBM desk top
(B) IBM PC
(C) IBM advanced computers
(D) None of theses

50. The personal computers are also referred
as
(A) desk top micros
(B) advanced computers
(C) palmtop computers
(D) all the above

51. POS data-entry system is used  extensively
by
(A) banking industry
(B) grocery industry
(C) railroad industry
(D) word-processing industry

52. Primary advantage of key-to-tape data-entry
systems
(A) A large percentage of editing can be

performed at the time of data entry
(B) Key verification is easily performed
(C) The tape is reusable
(D) Keying errors can be detected as they

occur

53. Maximum character EBCDIC can code
(A) 8 (B) 16
(C) 64 (D) 256

54. The hexadecimal number system has a
base of
(A) 2 (B) 4
(C) 8 (D) 16

55. The use of parity bit is for
(A) coding (B) indexing
(C) error-detection (D) none of  these

56. The following are basic types of record-
access methods
(A) sequential and random
(B) direct and immediate
(C) sequential and indexed
(D) on-line and real-time

57. Which of the following is input/output device?
(A) monitors    (B) punched cards
(C) optical scanners  (D) all the above

58. The following magazine covers only the IBM
PC and its compatibles
(A) Byte    (B) PC Magazine
(C) Personal Computing  (D) Interface Age

59. The word size of a microprocessor refers to:
(A) the number of machine operations

performed/ second
(B) the amount of information that can be

stored / cycle
(C) the amount of information that can be

stored in  bytes
(D) none of these

60. The primary memory of a personal computer
consists
(A) ROM only
(B) RAM only
(C) Both ROM and RAM
(D) Memory module

61. Microsoft Excel is
(A) financial planning package
(B) electronic spreadsheet
(C) graphics package
(D) data-base management package

62. All the keys on the IBM PC keyboard repeat
as long as one holds them down. These
keys are known as
(A) typematic keys (B) functional keys
(C) automatic keys (D) alphabetic keys

63. Distributed   data   processing   configuration
where   all   activities    passes   through  a
centrally located computer is
(A) ring network
(B) spider network
(C) hierarchical network
(D) data control network

64. Communications device, combines
transmissions from several devices into on
line is
(A) concentrator (B) modifier
(C) multiplexer (D) full-duplex line

65. Data communications involving telegraph
lines uses
(A) simplex lines
(B) wideband channels
(C) narrowband channels
(D) dialed service

66. An advantage of the laser printer respect to
impact printer is
(A) it is quieter/ faster
(B) output is of a high quality
(C) support  wide range of type fonts
(D) all the above
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67. Data entry can be performed with all of the
following except
(A) OCR / OMR
(B) COM
(C) Voice-recognition systems
(D) MICR

68. Magnetic tape can serve as

(A) input media

(B) output media

(C) secondary-storage media

(D) all the above

69. The advantages of COM are its_____and__.

(A) compact size; readability

(B) compact size; speed

(C) readability; speed

(D) compact size; low cost

70. Elementary data item are

(A) data item which is not broken down into

smaller units

(B) data item that  can be broken down into

smaller units

(C) data item which is not decomposed   into

smaller units

(D) none of these

71. A semiconductor memory which allows the

eraser of the information stared in it so that

new information can be stared in it is referred

as

(A) EPROM (B) ROM

(C) RAM (D) None  of these

72. Extended ASCII uses

(A) 8 bits for coding     (B) 9 bits for coding

(C) 10 bits for coding   (D) 11 bits for coding

73. A device used for transmission of images

scanned at a transmitting point and

duplicated at a receiving point is

(A) Facsimile (FAX) (B) Telephone

(C) Photocopier (D) None of these

74. A data transmission medium made of tiny

threads of glass or plastic that can transmit

huge amount of information at the speed of

light is

(A) Fiber optic cable (B) Copper cable

(C) Twisted wire cable (D) None of these

75. A method of using a communication channel

in which signals can be transmitted between

a source and a destination in both directions

simultaneously is called

(A) Full duplex (B) Half duplex

(C) Quarter duplex (D) None of these

76. A sequential electronic circuit which can be
placed in one out of two stable states where
each state may be used to represent a binary
digit is stated as
(A) Integrated circuit (B) Firmware
(C) Flip-flop (D) None of these

77. A sequence of instruction (software) that is
substituted for hardware and stored in read-
only memory (ROM) is called
(A) Integrated circuit (B) Firmware
(C) Flip-flop (D) None of these

78. Anonymous FTP is the
(A) Internet file transfer protocol
(B) Protocol that requires password
(C) None access files
(D) None of these

79. EFF sites allows anonymous FTP that
(A) Do not require a password or access
(B) Requires password or access
(C) Is a none access file
(D) None of these

80. ANSI is
(A) American National Standards Institute
(B) A USA based national organization that

establishes     uniform     standards     in
several fields of computers.

(C) Both A & B are true
(D) None is true

81. APL is
(A) A high level language for specifying

complex algorithms.
(B) A real-time language primarily for

scientific applications.
(C) Only A is true
(D) Both A & B are true

82. The overall design, construction, organiza-
tion and interconnecting of the various
components of a computer system is
referred as
(A) Computer Architecture
(B) Computer Flow chart
(C) Computer Algorithm
(D) None of these

83. Asynchronous communication is
(A) Communication between independently

operating units
(B) Communication between dependent

operating units
(C) Communication between independent

and dependent operating units
(D) None of these
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84. Audio response is
(A) output medium
(B) produces verbal responses from the

computer system
(C) Both A & B true
(D) None is true

85. Automated Office refers to the merger of
___________ in an office environment.
(A) Computers  (B) office
(C) telecommunications (D) All the above

86. Auxiliary storage is
(A) Secondary storage (B) Primary storage
(C) Processing device (D) None of these

87. Archive is
(A) Backup storage (B)  Forward operation
(C) Primary storage (D) None of these

88. A branch of computer science that deals with
computers that possess reasoning,
learning and thinking capabilities that
resemble those of human beings is
recognized as?
(A) Software engineering
(B) Artificial intelligence
(C) Hardware engineering
(D) None of these

89. ASCII is
(A) A standard coding system for computers
(B) Hardware device
(C) Software
(D) None of these

90. Following is true for Bandwidth
(A) The wider the bandwidth of a

communications system the more data
it can transmit in a given period of time.

(B) The narrow the bandwidth of a
communications system the more data
it can transmit in a given period of time.

(C) The wider the bandwidth of a
communications system the less data
it can transmit in a given period of time.

(D) None is true

91. ASCII-8 is
(A) An extended version of ASCIl-7
(B) Is a 8-bit code
(C) Both A & B are true
(D) Both A & B are false

92. ASCII File is
(A) document    file    in    the   universally

recognized text format
(B) Word processor
(C) System file
(D) None of these

93. A program that translates mnemonic
statements into executable instructions is
referred as
(A) Software (B) Assembler
(C) Translator (D) None of these

94. An assembler is a
(A) Translator   (B) Hardware
(C) Assembly language (D) None of these

95. In a disk system time required for a read/
write head to move to the track where the
record to be read or written is stored is
(A) Access time  (B) Random time
(C) Response time (D) Seek time

96. Computer output which is displayed on the
screen of a terminal without a permanent
copy is called
(A) Soft copy (B) Hard copy
(C) Hardware (D) None of these

97. A storage device or medium where the
access time is dependent upon the location
of the data is called
(A) Serial access (B) Parallel access
(C) Null access (D) None of these

98. The set of computer programs, procedures,
and associated documentation related to
the effective operation of a computer system
is referred as
(A) Software (B) Hardware
(C) Hardcopy (D) Softcopy

99. An adder in which the bits of the operands
are added one after another is called
(A) Serial adder (B) Parallel adder
(C) Full adder (D) Half adder

100. A method of providing virtual memory
(A) Segmentation (B) De-fragmentation
(C) Paging (D) None of these

101. Transmission of data in one direction is
called
(A) Simplex (B) Duplex
(C) Triplex (D) None of  these

102. SNOBOL is
(A) string oriented symbolic language
(B) high-level language
(C) both A & B
(D) None of these

103. Speech recognition is
(A) Ability to input data directly into a

computer system by speaking to it
(B) Ability to output data directly from a

computer system by speaking.
(C) Processing of voice in computer systems
(D) None of these
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104. Speech synthesis is
(A) The ability to input data directly into a

computer system by speaking to it
(B) The ability to output data directly from a

computer system in spoken words
(C) Processing of  voice in computer

systems
(D) None of these.

105. A technique used to reduce the speed
mismatch between slow speed I/O devices
and fast CPU is called
(A) Spooling (B) Paging
(C) Segmentation (D) None of these

106. Storing programs on disk and then
transferring these programs into main
storage as and when they are needed. The
technique is used to process large
programs or several programs with limited
memory is called
(A) Swapping (B) Spooling
(C) Paging (D) Segmentation

107. Terminals is
(A) An input device which allows a user to

communicate directly with a computer
system.

(B) An output device which allows a user to
communicate directly with a computer
system.

(C) Both A & B
(D) None of these

108. A symbol to indicate beginning (START),
ending (STOP) and pauses (HALT) in
program logic flow are referred as
(A) Terminal symbol        (B) Decision symbol
(C) Processing symbol(D) None of these

109. Portability is program ability to run on
(A) dissimilar machines with minimum

modification
(B) similar   machines   with   maximum

modification
(C) dissimilar   machines   with   maximum

modification
(D) similar   machines   with   maximum

modification

110. A protocol that specifies how a personal
computer can connect to a mail server on
the Internet and download E-mail is known
as
(A) Post office protocol
(B) System protocol
(C) Network protocol
(D) None of these

111. A unit of a computer system that interprets
instructions and executes them is known as
(A) Processor (B) Storage
(C) Peripherals (D) None of these

112. A register in CPU  used to store the address
of the next instruction to be executed is
known as
(A) Program counter (B) Program library
(C) Programmer    (D) None of these

113. One who designs, writes, tests and
maintenance computer programs is called
(A) Programmer (B) Operator
(C) User (D) None of these

114. Which of the following terms applies to
communication between two computer
systems?
(A) computer literacy
(B) power supply
(C) applications software
(D) connectivity

115. A memory in CPU that holds program
instructions, input data, intermediate results
and the output information produced during
processing is
(A) Secondary memory
(B) Primary memory
(C) Auxiliary memory
(D) None of these

116. A collection of complete programs,
subroutines, and program modules that
have already been developed, tested and
documented to be used by programming
projects.
(A) Program counter (B) Program library
(C) Programmer    (D) None of these

117. The following typically happens in the output
phase of a computer based information
system
(A) Data   is   put   into   the   computer  for

processing
(B) Information is produced in hardcopy /

softcopy form
(C) Mathematical calculations are

performed
(D) All of the above.

118. Which of the following best describes a
computer-based information system?
(A) system where computer is used to turn

data into information
(B) inputting data
(C) processing data
(D) data   is   put   into   the   computer   for

processing
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119. The following piece of hardware is used as
input phase of a computer-based information
system
(A) Printer (B) Diskette
(C) Monitor (D) Keyboard

120. Software instructions intended to satisfy a
user specific processing needs are called
(A) systems software
(B) microcomputer
(C) documentation
(D) applications software

121. A term used for diskette is
(A) disk cartridge (B) disk pack
(C) floppy disk (D) none of these

122. Following is true for the digital computer
(A) Information is in form of a string of binary

digits
(B) It can be used as analog processor
(C) It is less accurate than the analog

computer
(D) None of these.

123. Comparing with secondary storage, primary
storage is
(A) slow and inexpensive
(B) fast and inexpensive
(C) fast and expensive
(D) slow and expensive

124. CPU performs read/write operations
at any point in time in
(A) ROM (B) PROM
(C) EPROM (D) RAM

125. Following is not the from of secondary
storage
(A) Magnetic tape (B) CD’s
(C) Disk (D) Hard disk

126. Technique of placing software/programs
in a ROM semiconductor chip is called
(A) PROM (B) EPROM
(C) firm ware (D) microprocessor

127. Following is not true for magnetic tape
(A) low cost
(B) direct-access storage medium
(C) compact and portable
(D) highly reliable

128. The following is an  nonvolatile memory
(A) ROM (B) RAM
(C) LSI (D) VLSI

129. The ________ can be programmed one
time by either the manufacturer or the
computer user. Once programmed, it cannot
be modified.
(A) RAM (B) ROM
(C) PROM (D) EPROM

130. Which of the following is not true of a
magnetic disk?
(A) Users can  update records by writing

over the old data
(B) It provides sequential access to stored

data
(C) It is slow relative to magnetic tape
(D) All of the above are true

131. Which of the following was (were) not used
in first-generation computers?
(A) vacuum tubes (B) punch cards
(C) magnetic core (D) all of the above

132. Following is not true for Backup files
(A) These are the files which are generated

automatically  in  when  one  saves  a
document.

(B) These files help in protecting the
document due to out of order of the
computer or power failure.

(C) These files delete as soon as computer
is turned off

(D) None of these

133. An algebra that deals with logical
propositions which are either true or false is
referred as
(A) Boolean algebra (B) Modern Algebra
(C) Abstract Algebra (D) None of these

134. Bandwidth is
(A) The range of frequencies available for

data transmission
(B) Data transmission rate
(C) Alternate for rubber band
(D) None is true

135. A coding structure in which characters are
represented by means of a series of parallel
bars is
(A) Bar Code (B) Menu bar
(C) Numeric bar (D) None of these

136. In Broadband system a network system
(A) Several analog signals share the same

physical network channel.
(B) Only digital signals share the same

physical network channel.
(C) Single analog signals share the same

physical network channel.
(D) None of these.

137. Bit stands for
(A) binary digit
(B) one binary piece of information
(C) Both A and B are true
(D) None is true
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138. Broadband channel is the
(A) The fastest carriers where data transfer

rates is of 1 million baud (bits/secon(D)
or more.

(B) The slower  carriers where  data transfer
rates is of 56k baud

(C) Musical channel
(D) None of these

139. BLOB is

(A) Binary Large Object
(B) A long bit string representing complex

data
(C) Object oriented language

(D) Only A & B are true

140. A group of related items / section of program

coding treated as a unit is referred as
(A) Block (B) Duplex

(C) Street (D) None of these

141. An operation in which data is moved to a

different location is referred as
(A) Block move (B) Street move

(C) Delete (D) None of these

142. The following is responsible for number of
logical records in a physical record

(A) Blocking factor (B) Block
(C) Boolean algebra (D) None of these

143. Boolean variable assumes
(A) Values that are true only

(B) Values that are false only
(C) Values that are either true or false

(D) None of these

144. Bubble Memory is

(A) nonvolatile (B) volatile
(C) permanent (D) None of these

145. In Nonvolatile memory device

(A) Data contained in them is not lost when
the power turned off

(B) Data contained in them is lost when the
power turned off.

(C) data contained in them is permanent
and not be rewrite

(D) None of these

146. Following is true for Bubble Memory

(A) A compact data storage device made of
thin wafers of garnet (a semiconductor

material) in a magnetic field.
(B) Nonvolatile memory

(C) Data contained in them is not lost when
the power turned off

(D) All are true

147. Buffer is device/ storage area
(A) Where data are temporarily stored
(B) Where data is permanently stored
(C) Where data error occurs
(D) None of these

148. A network geometric arrangement in which
a single connecting line is shared by a
number of nodes is called
(A) Car Topology (B) Bus Topology
(C) Truck Topology (D) None of these

149. An error in a computer program is referred
as
(A) Bug (B) Bit
(C) Virus (D) None of these

150. Circuits that provide a communication path
between two or more devices of a digital
computer system is
(A) Car (B) Bus
(C) Truck (D) None of these

151. A fixed number of adjacent bits that represent
a particular character or symbol are referred
as
(A) Byte (B) Octal
(C) Bubble (D) None of these

152. Cache memory is a
(A) Small buffer storage
(B) Permanent storage
(C) Main memory
(D) None of these

153. The total number of digits (symbols)
available to represent numbers in a
positional number system is referred as
(A) Number system (B) Base
(C) Power (D) None of these

154. Cache memory is
(A) Smaller and faster than main storage
(B) Bigger and slower then main storage
(C) Smaller but slower than main memory
(D) Bigger and faster than main memory

155. Cache memory
(A) Is a  Static RAM
(B) Increases the speed of processing by

making current programs and data
available to the CPU at a rapid rate

(C) Both A & B are true
(D) Both A & B are false

156. Following is false for BASIC
(A) Beginners All-Purpose Symbolic

Instruction Code
(B) High-level interactive programming

language

yoursmahboob.wordpress.com
        (shared by Sujoy)



12  |  M.C.Qs. on Computer

(C) Works in timesharing environment
(D) Low level object oriented language

157. A unit for measuring data transmission
speed that describes the capacity of a carrier
is referred as
(A) Baud (B) Bit
(C) Bond (D) Batch

158. A process of trying out a new product by
independent users before it is finally
manufactured/ developed
(A) Alpha test (B) Beta Test
(C) Gamma test (D) None of these

159. A selection, choice, or condition involving two
possibilities is referred as
(A) Unary (B) Binary
(C) Octal (D) None of these

160. Base band System is
(A) A networking system
(B) Where the channel support. a single

digital signal.
(C) Both A & B are true
(D) None is true

161. One of the early coding systems,  based on
the idea of converting each digit of a decimal
number into its binary equivalent rather than
converting the entire decimal value into a
pure binary form is
(A) ASCII code (B) BCD
(C) ASCIl-8 (D) None of these

162. In Batch processing
(A) Several computer programs runs one

after another without human interaction
to run each program individually.

(B) Several computer programs runs one
after another with human interaction to
run each program individually

(C) Selected  computer programs runs one
after another with human interaction to
run each program individually

(D) None is true

163. BISYNC is
(A) Binary synchronous
(B) A process of transmitting data
(C) A half-duplex, character-oriented,

synchronous data communications
transmission method

(D) All the above

164. A device that is used to transmit data from
one location to another is referred as
(A) Storage (B) Memory
(C) Carrier (D) None of these

165. Programs developed by an outside supplier
and provided to the user in a machine
readable form is known as
(A) Canned Programs
(B) Beta program
(C) Alpha program
(D) None of these

166. A binary numbers are represented by
(A) Digits 0 and 1 (B) Digits 0,1,….,8
(C) Digits A,B, C,… (D) None of these

167. BIOS is responsible for
(A) handling the particulars of input/output

operations
(B) output operations
(C) input operations
(D) None of these

168. BIOS is an abbreviation for
(A) Binary Input/Binary Output
(B) Binary synchronous
(C) Binary digit
(D) None of these

169. BISYNC is an abbreviation for
(A) Binary Input/Binary Output
(B) Binary synchronous
(C) Binary digit
(D) None of these

170. The overall design, construction, organization
and interconnecting of the various compo-
nents of a computer system is referred as
(A) Computer Architecture
(B) Computer Flow chart
(C) Computer Algorithm
(D) None of these

171. A number system with a base of two is
referred as
(A) Unary number system
(B) Binary number system
(C) Octal number system
(D) None of these

172. In the IBM PC’s, the CPU, the device drives,
memory, expansion slots and active
components are mounted on a single board
referred as
(A) Motherboard   (B) Breadboard
(C) Daughter board (D) Father board.

173. Instead of buying new computer, productivity
of old one can be economically enhanced
with the help of?
(A) Motherboard
(B) Breadboard
(C) Daughter board
(D) Grandmother board.
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174. Following communications lines, best suites
to interactive processing applications
(A) narrowband channels
(B) simplex lines
(C) full-duplex lines
(D) mixed-band channels

175. Advantage of a multiprogramming system
is
(A) simultaneous execution of program

instructions from two applications
(B) concurrent processing of two or more

programs
(C) single processing at a time
(D) none of these

176. A remote batch-processing operation where
data is solely input to a central computer
would require
(A) telegraph line
(B) simplex lines
(C) mixed-band channel
(D) none of these

Answer Sheet

1. (C) 2. (A) 3. (A) 4. (B) 5. (B)
6. (A) 7. (D) 8. (A) 9. (D) 10. (A)

11. (A) 12. (B) 13. (A) 14. (A) 15. (A)
16. (B) 17. (C) 18. (C) 19. (A) 20. (A)
21. (A) 22. (A) 23. (A) 24. (A) 25. (A)
26. (C) 27. (A) 28. (B) 29. (C) 30. (B)

31. (C) 32. (A) 33. (A) 34. (C) 35. (A)
36. (C) 37. (A) 38. (A) 39. (A) 40. (B)
41. (A) 42. (A) 43. (D) 44. (A) 45. (A)
46. (D) 47. (D) 48. (C) 49. (B) 50. (A)
51. (B) 52. (C) 53. (D) 54. (D) 55. (C)
56. (A) 57. (D) 58. (B) 59. (B) 60. (C)
61. (B) 62. (A) 63. (B) 64. (C) 65. (C)
66. (D) 67. (B) 68. (D) 69. (B) 70. (A)
71. (A) 72. (A) 73. (A) 74. (A) 75. (A)
76. (C) 77. (B) 78. (A) 79. (A) 80. (C)
81. (D) 82. (A) 83. (A) 84. (C) 85. (D)
86. (A) 87. (A) 88. (B) 89. (A) 90. (A)
91. (A) 92. (A) 93. (B) 94. (A) 95. (D)
96. (A) 97. (A) 98. (A) 99. (A) 100. (A)

101. (A) 102. (C) 103. (A) 104. (B) 105. (A)
106. (A) 107. (C) 108. (A) 109. (A) 110. (A)
111. (A) 112. (A) 113. (A) 114. (D) 115. (B)

116. (B) 117. (B) 118. (A) 119. (D) 120. (D)

121. (C) 122. (A) 123. (C) 124. (C) 125. (D)
126. (C) 127. (B) 128. (A) 129. (C) 130. (B)
131. (C) 132. (C) 133. (A) 134. (A) 135. (A)
136. (A) 137. (C) 138. (A) 139. (D) 140. (A)

141. (A) 142. (A) 143. (C) 144. (A) 145. (A)

146. (D) 147. (A) 148. (B) 149. (A) 150. (B)
151. (A) 152. (A) 153. (B) 154. (A) 155. (C)
156. (D) 157. (A) 158. (B) 159. (B) 160. (C)
161. (B) 162. (A) 163. (D) 164. (A) 165. (A)
166. (A) 167. (A) 168. (A) 169. (A) 170. (A)
171. (B) 172. (A) 173. (C) 174. (C) 175. (B)
176. (B)
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COMPUTER SECURITY
1. A vulnerability scanner is

(A) a   prepared   application   that  takes
advantage of a known weakness.

(B) a tool used to quickly check computers
on a network for known weaknesses.

(C) an application that captures TCP/IP data
packets, which can maliciously be used
to capture passwords and other data
while it is in transit either within the
computer or over the network.

(D) a  situation  in  which  one  person  or
program successfully masquerades as
another by falsifying data and thereby
gaining illegitimate access.

2. A packet sniffer is
(A) a   prepared   application   that   takes

advantage of a known weakness.
(B) a tool used to quickly check computers

on a network for known weaknesses.
(C) an application that captures TCP/IP data

packets, which can maliciously be used
to capture passwords and other data
while it is in transit either within the
computer or over the network.

(D) a   situation   in   which   one   person  or
program successfully masquerades as
another by falsifying data and thereby
gaining illegitimate access.

3. These hacker breaks security for altruistic
or at least non-malicious reasons.
(A) White hat (B) Grey hat
(C) Blue hat (D) None of these

4. This hacker is a hacker of ambiguous ethics
and/or borderline legality, often frankly
admitted.
(A) White hat (B) Grey hat
(C) Blue hat (D) None of these

5. This hacker is someone outside computer
security consulting firms that are used to bug
test a system prior to its launch, looking for
exploits so they can be closed.
(A) White hat (B) Grey hat
(C) Blue hat (D) None of these

6. It is a software program designed to record

(‘log’) every keystroke on the machine on

which it runs

(A) Keylogger (B) Worm

(C) Virus (D) Cracker

7. It is a self-replicating program that infects

computer and  spreads by inserting copies

of   itself   into   other   executable   code  or

documents.

(A) Keylogger (B) Worm

(C) Virus (D) Cracker

8. Like  a  virus,  it  is  also  a  self-replicating

program. The difference between a virus and

it  is that a worm does not create copies of

itself on one system: it propagates through

computer networks.

(A) Keylogger (B) Worm

(C) Cracker (D) None of these

9. Viruses that fool a user into downloading

and/or executing them by pretending to be

useful applications are also sometimes

called?

(A) Trojan horses (B) Keylogger

(C) Worm (D) Cracker

10. These are program designed as to seem to

being or be doing one thing, but actually

being or doing another.

(A) Trojan horses (B) Keylogger

(C) Worm (D) Cracker

11. It is a toolkit for hiding the fact that a computer’s

security has been compromised, is a general

description of a set of programs which work

to subvert control of an operating system from

its legitimate (in accordance with established

rules) operators.

(A) Rootkit (B) Keylogger

(C) Worm (D) Cracker
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12. Packet Sniffer is
(A) an application that captures TCP/IP data

packets, which can maliciously be used
to capture passwords and other data
while it is in transit either within the
computer or over the network.

(B) a situation in which one person or
program successfully masquerades as
another by falsifying data and thereby
gaining illegitimate access.

(C) a toolkit for hiding the fact that a
computer’s security has been
compromised, is a general description
of a set of programs which work to
subvert control of an operating system
from its legitimate (in accordance with
established rules) operators.

(D) None of these

13. Rootkit is
(A) an application that captures TCP/IP data

packets, which can maliciously be used
to capture passwords and other data
while it is in transit either within the
computer or over the network.

(B) a situation in which one person or
program successfully masquerades as
another by falsifying data and thereby
gaining illegitimate access.

(C) a toolkit for hiding the fact that a
computer’s security has been
compromised, is a general description
of a set of programs which work to
subvert control of an operating system
from its legitimate (in accordance with
established rules) operators.

(D) None of these

14.  Spoofing attack is
(A) an application that captures TCP/IP data

packets, which can maliciously be used
to capture passwords and other data
while it is in transit either within the
computer or over the network.

(B) a situation in which one person or
program successfully masquerades as
another by falsifying data and thereby
gaining illegitimate access.

(C) a toolkit for hiding the fact that a
computer’s security has been
compromised, is a general description
of a set of programs which work to
subvert control of an operating system
from its legitimate (in accordance with
established rules) operators.

(D) None of these

15. Security exploit  is

(A) a prepared application that takes

advantage of a known weakness.

(B) a tool used to quickly check computers

on a network for known weaknesses.

(C) an application that captures TCP/IP data

packets, which can maliciously be used

to capture passwords and other data

while it is in transit either within the

computer or over the network.

(D) a situation in which one person or

program successfully masquerades as

another by falsifying data and thereby

gaining illegitimate access.

16. A spoofing attack is

(A) a prepared application that takes

advantage of a known weakness.

(B) a tool used to quickly check computers

on a network for known weaknesses.

(C) an application that captures TCP/IP data

packets, which can maliciously be used

to capture passwords and other data

while it is in transit either within the

computer or over the network.

(D) a situation in which one person or

program successfully masquerades as

another by falsifying data and thereby

gaining illegitimate access.

17. White hat is

(A) hacker breaks security for altruistic or at

least non-malicious reasons.

(B) hacker of ambiguous ethics and/or

borderline legality, often frankly admitted.

(C) someone outside computer security

consulting firms that are used to bug

test a system prior to its launch, looking

for exploits so they can be closed.

(D) None of these

18. Grey hat is

(A) hacker breaks security for altruistic or at

least non-malicious reasons.

(B) hacker of ambiguous ethics and/or

borderline legality, often frankly admitted.

(C) someone outside computer security

consulting firms that are used to bug

test a system prior to its launch, looking

for exploits so they can be closed.

(D) None of these
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19. Blue hat is

(A) hacker breaks security for altruistic or at

least non-malicious reasons.

(B) hacker of ambiguous ethics and/or

borderline legality, often frankly admitted.

(C) someone outside computer security

consulting firms that are used to bug

test a system prior to its launch, looking

for exploits so they can be closed.

(D) None of these

20. Black hat is

(A) someone who subverts computer

security without authorization or who

uses technology (usually a computer or

the Internet) for terrorism, vandalism

(malicious destruction), credit card

fraud, identity theft, intellectual property

theft, or many other types of crime.

(B) a person, usually not an expert in

computer security, who breaks into

computer systems by using pre-

packaged automated tools written by

others.

(C) hacker who utilizes technology to

announce a political message.

(D) None of these

21. Script kiddie is

(A) someone who subverts computer

security without authorization or who

uses technology (usually a computer or

the Internet) for terrorism, vandalism

(malicious destruction), credit card

fraud, identity theft, intellectual property

theft, or many other types of crime.

(B) a person, usually not an expert in

computer security, who breaks into

computer systems by using pre-

packaged automated tools written by

others.

(C) hacker who utilizes technology to

announce a political message.

(D) None of these

22.   Hacktivism is

(A) someone who subverts computer

security without authorization or who

uses technology (usually a computer or

the Internet) for terrorism, vandalism

(malicious destruction), credit card

fraud, identity theft, intellectual property

theft, or many other types of crime.

(B) a person, usually not an expert in

computer security, who breaks into

computer systems by using pre-

packaged automated tools written by

others.

(C) hacker who utilizes technology to

announce a political message.

(D) None of these

23. It is a prepared application that takes

advantage of a known weakness.

(A) security exploit

(B) vulnerability scanner

(C) packet sniffer

(D) rootkit

24. It is a tool used to quickly check computers

on a network for known weaknesses.

(A) security exploit

(B) vulnerability scanner

(C) packet sniffer

(D) rootkit

25. It is an application that captures TCP/IP data

packets, which can maliciously be used to

capture passwords and other data while it

is in transit either within the computer or over

the network.

(A) security exploit

(B) vulnerability scanner

(C) packet sniffer

(D) rootkit

26. It is a situation in which one person or

program successfully masquerades as

another by falsifying data and thereby gaining

illegitimate access.

(A) security exploit

(B) vulnerability scanner

(C) packet sniffer

(D) rootkit

Answer Sheet

1. (B) 2. (C) 3. (A) 4. (B) 5. (C)
6. (A) 7. (C) 8. (B) 9. (A) 10. (A)

11. (A) 12. (A) 13. (B) 14. (C) 15. (A)
16. (D) 17. (A) 18. (B) 19. (C) 20. (A)
21. (B) 22. (C) 23. (A) 24. (B) 25. (C)
26. (A)
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MICROSOFT WINDOWS

OPERATING SYSTEM
1. In Windows operating system the ————

——— is the main screen area that one sees
after he turn on a computer and log on to
Windows.
(A) Desktop (B) Icons
(C) Taskbar (D) None of these

2. In Windows operating system it sits at the
bottom of windows desktop screen. It shows
you which programs are running and allows
you to switch between them. It also contains
the Start button which one can use to access
programs, folders, and computer settings.
(A) Sidebar (B) Icons
(C) Taskbar (D) None of these

3. In Windows operating system these are
small pictures that represent files, folders,
programs, and other items. Each one is
used to make the computer do something.
(A) Sidebar (B) Icons
(C) Taskbar (D) None of these

4. In Windows operating system it is the long
horizontal bar at the bottom of a screen.
Unlike the desktop, which can get obscured
by the windows on top of it, it is visible almost
all the time.
(A) Sidebar (B) Icons
(C) Taskbar (D) None of these

5. In Windows operating system it is  a very
important part of Windows, clicking on it
opens up what is called the start menu
(A) Start button (B) Sidebar
(C) Icons (D) None of these

6. In Windows operating system when you
delete a file or folder, it doesn’t actually get
deleted right away, it goes to the ————.
(A) Recycle Bin (B) Dust Bin
(C) Cycle Bin (D) None of these

7. In Windows operating system the clock in
windows xp sits on the ————— and
displays the system time.
(A) Taskbar (B) Start menu
(C) Desktop (D) None of these

8. Word Processors that is the part of Windows

operating system

(A) Wordpad

(B) Notepad

(C) Adobe Photoshop

(D) Jasc Paint Shop

9. Microsoft   Windows   provides   a  graphics

application named

(A) Paint   (B) Adobe Photoshop

(C) Jasc Paint Shop(D) None of these

10. Text  Editor  that  is  the  part  of  Windows

operating system

(A) Wordpad

(B) Notepad

(C) Adobe Photoshop

(D) Jasc Paint Shop

11. It is  a visual aspect that indicates that a

control is ready to receive input from you in

Windows operating system

(A) Control’s Focus

(B) Dialog Boxes

(C) Command Buttons

(D) Text Boxes

12. In Windows operating system it is a window

that is used to display text or to receive text

from you. The type of text it displays or the

type of text you are asked to provide depends

on the application or the situation.

(A) Control’s Focus (B) Dialog Boxes

(C) Command Buttons (D) Text Boxes

Answer Sheet

1. (A) 2. (C) 3. (B) 4. (C) 5. (A)

6. (A) 7. (A) 8. (A) 9. (A) 10. (B)

11. (A) 12. (D)
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MICROSOFT WINDOWS

KEYBOARD SHORTCUTS
1. In Windows operating system to display or

hide the Start menu
(A) Windows Logo
(B) Windows Logo + BREAK
(C) Windows Logo + D
(D) Windows Logo + M

2. In Windows operating system the shortcut
key Windows Logo+SHIFT+M is used for
(A) Restore the minimized windows
(B) Open My Computer
(C) Search for a file or a folder
(D) Search for computers

3. In Windows operating system the shortcut
key Windows Logo+E is used for
(A) Restore the minimized windows
(B) Open My Computer
(C) Search for a file or a folder
(D) Search for computers

4. In Windows operating system the shortcut
key Windows Logo+F
(A) Restore the minimized windows
(B) Open My Computer
(C) Search for a file or a folder
(D) Search for computers

5. In Windows operating system shortcut key
CTRL+Windows Logo+F
(A) Restore the minimized windows
(B) Open My Computer
(C) Search for a file or a folder
(D) Search for computers

6. In Windows operating system  shortcut key
Windows Logo+F1
(A) Display Windows Help
(B) Lock the keyboard
(C) Open the Run dialog box
(D) Open Utility Manager

7. In Windows operating system shortcut key
Windows Logo+ L
(A) Display Windows Help
(B) Lock the keyboard
(C) Open the Run dialog box
(D) Open Utility Manager

8. In Windows operating system shortcut key
Windows Logo+R
(A) Display Windows Help
(B) Lock the keyboard
(C) Open the Run dialog box
(D) Open Utility Manager

9. In Windows operating system to Display the
System Properties dialog box
(A) Windows Logo
(B) Windows Logo + BREAK
(C) Windows Logo + D
(D) Windows Logo + M

10. In Windows operating system to Display the
desktop
(A) Windows Logo
(B) Windows Logo + BREAK
(C) Windows Logo + D
(D) Windows Logo + M

11. In Windows operating system to minimize
all of the windows
(A) Windows Logo
(B) Windows Logo + BREAK
(C) Windows Logo + D
(D) Windows Logo + M

12. In Windows operating system to move for-
ward through the tabs
(A) CTRL+TAB (B) CTRL+SHIFT+TAB
(C) SHIFT+TAB (D) None of these

13. In Windows operating system to move back-
ward through the tabs
(A) CTRL+TAB (B)  CTRL+SHIFT+TAB
(C) SHIFT+TAB (D) None of these

14. In Windows operating system to move back-
ward through the options
(A) CTRL+TAB (B) CTRL+SHIFT+TAB
(C) SHIFT+TAB (D) None of these

15. In Windows operating system one press F1
key to
(A) Display help (B) Cut
(C) Paste (D) None of these
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16. In Windows operating system after you

double-click a character on the grid of char-

acters, keyboard shortcut DOWN ARROW is

used for

(A) Move to the right or to the beginning of

the next line

(B) Move to the left or to the end of the previ-

ous line

(C) Move up one row

(D) Move down one row

17. In Windows operating system after you

double-click a character on the grid of char-

acters, keyboard shortcut PAGE UP  is used

for

(A) Move up one screen at a time

(B) Move down one screen at a time

(C) Move to the beginning of the line

(D) Move to the end of the line

18. In Windows operating system after you

double-click a character on the grid of char-

acters, keyboard shortcut PAGE DOWN is

used for

(A) Move up one screen at a time

(B) Move down one screen at a time

(C) Move to the beginning of the line

(D) Move to the end of the line

19. In Windows operating system after you

double-click a character on the grid of char-

acters, keyboard shortcut HOME is used for

(A) Move up one screen at a time

(B) Move down one screen at a time

(C) Move to the beginning of the line

(D) Move to the end of the line

20. In Windows operating system after you

double-click a character on the grid of char-

acters, keyboard shortcut END is used for

(A) Move up one screen at a time

(B) Move down one screen at a time

(C) Move to the beginning of the line

(D) Move to the end of the line

21. In Windows operating system after you

double-click a character on the grid of char-

acters, keyboard shortcut CTRL+HOME is

used for

(A) Move to the first character

(B) Move to the last character

(C) Switch between Enlarged and Normal

mode when a character is selected

(D) None of these

22. In  Windows  operating  system  after  you

double-click a character on the grid of char-
acters, keyboard shortcut CTRL+END is
used for
(A) Move to the first character
(B) Move to the last character
(C) Switch between Enlarged and Normal

mode when a character is selected
(D) None of these

23. In  Windows  operating  system  after  you
double-click a character on the grid of charac-
ters, keyboard shortcut SPACEBAR is used
for
(A) Move to the first character
(B) Move to the last character
(C) Switch between Enlarged and Normal

mode when a character is selected*
(D) None of these

24. In Windows operating system to copy some-
thing the following shortcut  is used
(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

25. In Windows operating system to cut some-
thing the following shortcut is used-
(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

26. In Windows operating system Shortcut
CTRL+Z  is for
(A) Undo something
(B) Delete something
(C) Paste something
(D) None of these

27. In Windows operating system shortcut DE-
LETE is for
(A) Undo something
(B) Delete something
(C) Paste something
(D) None of these

28. In   Windows   operating   system   shortcut
SHIFT+DELETE is used for
(A) Delete the selected item permanently with-

out placing the item in the Recycle Bin
(B) Copy the selected item
(C) Rename the selected item
(D) Create a shortcut to the selected item

29. In Windows operating system shortcut CTRL
while dragging an item
(A) Delete the selected item permanently with-

out placing the item in the Recycle Bin
(B) Copy the selected item
(C) Rename the selected item
(D) Create a shortcut to the selected item
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30. In   Windows   operating   system   shortcut

CTRL+SHIFT while dragging an item

(A) Delete the selected item permanently

without placing the item in the Recycle

Bin

(B) Copy the selected item

(C) Rename the selected item

(D) Create a shortcut to the selected item

31. In Windows operating system to delete the

selected item permanently without placing

the item in the Recycle Bin

(A) Shortcut SHIFT+DELETE

(B) Shortcut CTRL while dragging an item

(C) Shortcut CTRL+SHIFT while dragging

an item

(D) None of these

32. In Windows operating system move the in-

sertion point to the beginning of the next word.

(A) Shortcut CTRL+RIGHT ARROW

(B) Shortcut CTRL+LEFT ARROW

(C) Shortcut CTRL+DOWN ARROW

(D) None of these

33. In Windows operating system move the in-

sertion point to the beginning of the previ-

ous word

(A) Shortcut CTRL+RIGHT ARROW

(B) Shortcut CTRL+LEFT ARROW

(C) Shortcut CTRL+DOWN ARROW

(D) None of these

34. In Windows operating system move the in-

sertion point to the beginning of the next para-

graph

(A) Shortcut CTRL+RIGHT ARROW

(B) Shortcut CTRL+LEFT ARROW

(C) Shortcut CTRL+DOWN ARROW

(D) None of these

35. In Windows operating system move the in-

sertion point to the beginning of the previ-

ous paragraph

(A) CTRL+RIGHT ARROW

(B) CTRL+LEFT ARROW

(C) CTRL+DOWN ARROW

(D) None of these

36. In Windows operating system move the in-

sertion point to the beginning of the previ-

ous paragraph

(A) CTRL+RIGHT ARROW

(B) CTRL+LEFT ARROW
(C) CTRL+DOWN ARROW
(D) CTRL+UP ARROW

37. In Windows operating system CTRL+SHIFT

with any of the arrow keys

(A) Highlight a block of text

(B) Delete something

(C) Paste something

(D) None of these

38. In Windows operating system SHIFT with any

of the arrow keys

(A) Highlight a block of text

(B) Delete something

(C) Paste something

(D) Select more than one item in a window

or on the desktop, or select text in a

document

39. In Windows  operating  system  shortcut

CTRL+A is to

(A) Select all

(B) Highlight a block of text

(C) Delete something

(D) Paste something

40. In Windows operating system shortcut for

paste is

(A) CTRL+C (B) CTRL+X

(C) CTRL+V (D) None of these

41. In Windows operating system Shortcut for

copy is

(A) CTRL+C (B) CTRL+X

(C) CTRL+V (D) None of these

42. In Windows operating system to paste some-

thing after cutting the following shortcut is

used

(A) CTRL+C (B) CTRL+X

(C) CTRL+V (D) None of these

43. In   Windows   operating   system  shortcut

CTRL+C  is used for

(A) Cut (B) Paste

(C) Copy (D) None of these

44. In Windows operating system the shortcut

key CTRL+B is used for

(A) Open the Organize Favorites dialog box

(B) Open the Search bar

(C) Start the Find utility

(D) Open the History bar

45. In Windows operating system the shortcut

key CTRL+E is used for

(A) Open the Organize Favorites dialog box

(B) Open the Search bar

(C) Start the Find utility

(D) Open the History bar
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46. In Windows operating system the shortcut

key CTRL+F is used for

(A) Open the Organize Favorites dialog box

(B) Open the Search bar

(C) Start the Find utility

(D) Open the History bar

47. In Windows operating system the shortcut

key CTRL+H is used for

(A) Open the Organize Favorites dialog box

(B) Open the Search bar

(C) Start the Find utility

(D) Open the History bar

48. In Windows operating system the shortcut

key CTRL+I is used for

(A) Open the Favorites bar

(B) Open the Open dialog box

(C) Start another instance of the browser

with the same Web address

(D) Open the Open dialog box, the same as

CTRL+L

49. In Windows operating system the shortcut

key CTRL+L is used for

(A) Open the Favorites bar

(B) Open the Open dialog box

(C) Start another instance of the browser

with the same Web address

(D) Open the Open dialog box, the same as

CTRL+L

50. In Windows operating system the shortcut

key CTRL+N is used for

(A) Open the Favorites bar

(B) Open the Open dialog box

(C) Start another instance of the browser

with the same Web address

(D) Open the Open dialog box, the same as

CTRL+L

51. In Windows operating system the shortcut
key CTRL+O is used for
(A) Open the Favorites bar
(B) Open the Open dialog box
(C) Start another instance of the browser

with the same Web address
(D) Open the Open dialog box, the same as

CTRL+L

52. In Windows operating system the shortcut
key CTRL+P is used for
(A) Open the Print dialog box
(B) Update the current Web page
(C) Close the current window
(D) None of these

53. In Windows operating system the shortcut
key CTRL+R is used for
(A) Open the Print dialog box
(B) Update the current Web page
(C) Close the current window
(D) None of these

54. In Windows operating system the shortcut
key CTRL+W is used for
(A) Open the Print dialog box
(B) Update the current Web page
(C) Close the current window
(D) None of these

Answer Sheet

1. (A) 2. (A) 3. (B) 4. (C) 5. (D)
6. (A) 7. (B) 8. (C) 9. (B) 10. (C)

11. (D) 12. (A) 13. (B) 14. (C) 15. (A)
16. (D) 17. (A) 18. (B) 19. (C) 20. (D)
21. (A) 22. (B) 23. (C) 24. (A) 25. (B)
26. (A) 27. (B) 28. (A) 29. (B) 30. (D)
31. (A) 32. (A) 33. (B) 34. (A) 35. (D)
36. (D) 37. (A) 38. (D) 39. (A) 40. (C)
41. (C) 42. (C) 43. (A) 44. (A) 45. (B)
46. (C) 47. (D) 48. (A) 49. (B) 50. (C)
51. (D) 52. (A) 53. (B) 54. (C)
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MICROSOFT OFFICE

1. Microsoft Office is

(A) Desktop applications

(B) Operating system

(C) Command window

(D) None of these

2. Microsoft Office is  an office suite, for the

(A) Microsoft Windows operating systems

(B) Mac OS X operating systems

(C) Both A and B are true

(D) None is true

3. Microsoft Word, Microsoft Excel, and

Microsoft PowerPoint are the part of

(A) Microsoft  Office  Suite

(B) Microsoft Windows

(C) Mac OS X

(D) None of these

4. The very first version of Microsoft Office was

released for

(A) Windows operating system

(B) Apple Macintosh OS

(C) Unix

(D) None of these

5. The first version of  MS Office to be released

for the Microsoft Windows operating system

is

(A) Microsoft Office 3.0

(B) Microsoft Office 2003

(C) Microsoft Office 2007

(D) Microsoft Office XP

6. The word processor in MS office suite is

(A) Microsoft Word

(B) Microsoft Excel

(C) Microsoft PowerPoint

(D) None of these

7. Microsoft Word is a word processor  that

saves in its proprietary————format.

(A) .doc (B) .pdf

(C) .txt (D) None of these

8. Microsoft Office Suite  spreadsheet program

is

(A) Microsoft Excel

(B) Microsoft  Word

(C) Microsoft  Powerpoint

(D) None of these

9. A competitor to the dominant Lotus 1-2-3 is

(A) Microsoft Excel

(B) Microsoft  Word

(C) Microsoft  PowerPoint

(D) None of these

10. A personal information manager and e-mail

communication software in MS Office is

(A) Microsoft Outlook

(B)  Microsoft  Word

(C) Microsoft  PowerPoint

(D) None of these

11. A popular presentation program for Windows

and Mac in Microsoft  Office is

(A) Microsoft  Word

(B) Microsoft  PowerPoint

(C) Microsoft Access

(D) None of these

12. To create slideshows, composed of text,

graphics, movies and other objects, which

can be displayed on-screen and navigated

through by the presenter or printed out on

transparencies or slides one uses

(A) Microsoft  Word

(B) Microsoft  PowerPoint

(C) Microsoft Access

(D) None of these

13. For Database management one uses

(A) Microsoft Access

(B) Microsoft  PowerPoint

(C) Microsoft Access

(D) None of these
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14. It is software for creating newsletters, busi-

ness cards, flyers, greeting cards or post-
cards.
(A) Microsoft Publisher
(B) Microsoft  PowerPoint
(C) Microsoft Access
(D) None of these

15. It is a  Note-taking software for use with tab-
let PCs or regular PCs.
(A) Microsoft OneNote
(B) Microsoft  PowerPoint
(C) Microsoft Access
(D) None of these

16. Microsoft Office SharePoint Designer is
used for
(A) A WYSIWYG HTML editor and web de-

sign program for customizing
SharePoint applications, it replaces
Microsoft Office FrontPage

(B) Project management software to keep
track of events and to create network

charts and Gantt charts
(C) Diagram and flowcharting software

(D) None of these

17. Microsoft Project is

(A) A WYSIWYG HTML editor and web de-
sign program for customizing Share

Point applications, it replaces Microsoft
Office FrontPage

(B) Project management software to keep
track of events and to create network

charts and Gantt charts
(C) Diagram and flowcharting software

(D) None of these

18. Microsoft Visio is a

(A) A WYSIWYG HTML editor and web de-
sign program for customizing

SharePoint applications, it replaces
Microsoft Office FrontPage

(B) Project management software to keep
track of events and to create network

charts and Gantt charts
(C) Diagram and flowcharting software

(D) None of these

19. Microsoft Office Accounting is
(A) A tool for managing business finances

(B) Project management software to keep
track of events and to create network

charts and Gantt charts
(C) Diagram and flowcharting software

(D) None of these

20. Microsoft Office Communicator is

(A) Integrated communications client for
conferences and meetings in real time

(B) Project management software to keep
track of events and to create network
charts and Gantt charts

(C) Diagram and flowcharting software

(D) None of these

21. Microsoft Office Document Imaging  is

(A) An application that supports editing
scanned documents

(B) A scanning and OCR application

(C) Diagram and flowcharting software

(D) None of these

22. Microsoft Office Document Scanning is

(A) An application that supports editing
scanned documents

(B) A scanning and OCR application

(C) Diagram and flowcharting software

(D) None of these

23. Microsoft Office Groove is

(A) A proprietary peer-to-peer software pack-
age aimed at businesses

(B) An   application   that   supports   editing
scanned documents

(C) A scanning and OCR application

(D) Diagram and flowcharting software

24. Microsoft Office InterConnect is

(A) Business-relationship database

(B) An application that supports editing
scanned documents

(C) A scanning and OCR application

(D) None of these

25. Microsoft Office Picture Manager is

(A) Basic photo management software

(B) An application that supports editing
scanned documents

(C) A scanning and OCR application

(D) None of these

Answer Sheet

1. (A) 2. (C) 3. (A) 4. (B) 5. (A)
6. (A) 7. (A) 8. (A) 9. (A) 10. (A)

11. (B) 12. (B) 13. (A) 14. (A) 15. (A)
16. (A) 17. (B) 18. (C) 19. (A) 20. (A)
21. (A) 22. (B) 23. (B) 24. (A) 25. (A)
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MICROSOFT WORD

1. In Microsoft Word to cut something the
following shortcut is used
(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

2. In Microsoft Word shortcut CTRL+Z  is for
(A) Undo something
(B) Delete something
(C) Paste something
(D) None of these

3. In Microsoft Word shortcut DELETE is for
(A) Undo something
(B) Delete something
(C) Paste something
(D) None of these

4. A program which helps to create written
document and lets you go back and make
corrections as necessary
(A)  Home row keys  (B) Tool bar
(C)  Spreadsheet    (D) Word processor

5. Graphics for word processor
(A) Peripheral (B) Clip art
(C) Highlight (D) Execute

6. What type of software is used for creating
letters papers and other documents?
(A) Database
(B) Word Processor
(C) Spreadsheet
(D) Operating Program

7. What   does   the   Ctrl + I   shortcut  key
accomplish in Ms-Word?
(A) It converts selected text into the next

larger size of the same font
(B) It adds a line break to the document
(C) It makes the selected text bold
(D) It applies Italic formatting t the selected

text.

8. What is the file extension of Ms-Word97-
2003 document?
(A) Dot (B) Doc
(C) Dom (D) Txt

9. Why   are   headers    and   footers   used  in
document?

(A) To enhance the overall appearance of

the document

(B) To mark the starting and ending of a

page

(C) To make large document more readable

(D) To allow page headers and footers to

appear on document when it is printed

10. Which of the following shortcut key is used

to check spelling?

(A)  F1 (B)  F2

(C)  F7 (D)  F9

11. What does Ctrl + B shortcut accomplish in

Ms-Word?

(A) It converts selected text into the next

larger size of the same font

(B) It adds a line break to the document

(C) It makes the selected text bold

(D) It applies Italic formatting t the selected

text.

12. What is the minimum number of rows and

columns that a word table can have?

(A) Zero

(B) 2 rows and 1 column

(C) 2 rows and 2 column

(D) 1 row and 1 column

13. In Microsoft Word shortcut key CTRL+R is

used for

(A) Open the Print dialog box

(B) Update the current Web page

(C) Close the current window

(D) None of these

14. In Microsoft Word shortcut key CTRL+W is

used for

(A) Open the Print dialog box

(B) Update the current Web page

(C) Close the current window

(D) None of these
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15. In Microsoft Word system to copy something
the following shortcut  is used
(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

16. In Microsoft Word shortcut SHIFT+DELETE
is used for
(A) Delete the selected item permanently

without placing the item in the Recycle
Bin

(B) Copy the selected item
(C) Rename the selected item
(D) Create a shortcut to the selected item

17. In   Microsoft   Word   shortcut   CTRL   while
dragging an item
(A) Delete the selected item permanently

without placing the item in the Recycle
Bin

(B) Copy the selected item
(C) Rename the selected item
(D) Create a shortcut to the selected item

18. In   Microsoft   Word   shortcut  CTRL+SHIFT
while dragging an item
(A) Delete the selected item permanently

without placing the item in the Recycle
Bin

(B) Copy the selected item
(C) Rename the selected item
(D) Create a shortcut to the selected item

19. In Microsoft Word to delete the selected item
permanently without placing the item in the
Recycle Bin
(A) Shortcut SHIFT+DELETE
(B) Shortcut CTRL while dragging an item
(C) Shortcut CTRL+SHIFT while dragging

an item
(D) None of these

20. In Microsoft Word move the insertion point to
the beginning of the next word
(A) Shortcut CTRL+RIGHT ARROW
(B) Shortcut CTRL+LEFT ARROW
(C) Shortcut CTRL+DOWN ARROW
(D) None of these

21. In Microsoft Word move the insertion point to
the beginning of the previous word
(A) Shortcut CTRL+RIGHT ARROW
(B) Shortcut CTRL+LEFT ARROW
(C) Shortcut CTRL+DOWN ARROW
(D) None of these

22. In Microsoft Word move the insertion point to
the beginning of the next paragraph
(A) Shortcut CTRL+RIGHT ARROW
(B) Shortcut CTRL+LEFT ARROW
(C) Shortcut CTRL+DOWN ARROW
(D) None of these

23. In Microsoft Word move the insertion point to
the beginning of the previous paragraph
(A) CTRL+RIGHT ARROW
(B) CTRL+LEFT ARROW
(C) CTRL+DOWN ARROW
(D) None of these

24. In Microsoft Word move the insertion point to
the beginning of the previous paragraph
(A) CTRL+RIGHT ARROW
(B) CTRL+LEFT ARROW
(C) CTRL+DOWN ARROW
(D) CTRL+UP ARROW

25. In Microsoft Word using CTRL+SHIFT with
any of the arrow keys
(A) Highlight a block of text
(B) Delete something
(C) Paste something
(D) None of these

26. In Microsoft Word using SHIFT with any of
the arrow keys
(A) Highlight a block of text
(B) Delete something
(C) Paste something
(D) Select more than one item in a window

or on the desktop, or select text in a
document

27. In Microsoft Word shortcut CTRL+A is to
(A) Select all
(B) Highlight a block of text
(C) Delete something
(D) Paste something

28. In Microsoft Word shortcut for paste is
(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

29. In Microsoft Word shortcut for copy is
(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

30. In Microsoft Word to paste something after
cutting the following shortcut is used
(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

31. In Microsoft Word shortcut CTRL+C  is used
for
(A) Cut (B) Paste
(C) Copy (D) None of these

32. In Microsoft Word shortcut key CTRL+B is
used for
(A) Open the Organize Favorites dialog box
(B) Open the Search bar
(C) Start the Find utility
(D) Open the History bar
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33. In Microsoft Word shortcut key CTRL+E is
used for
(A) Open the Organize Favorites dialog box
(B) Open the Search bar
(C) Start the Find utility
(D) Open the History bar

34. In Microsoft Word shortcut key CTRL+F is
used for
(A) Open the Organize Favorites dialog box
(B) Open the Search bar
(C) Start the Find utility
(D) Open the History bar

35. In Microsoft Word shortcut key CTRL+H is
used for
(A) Open the Organize Favorites dialog box
(B) Open the Search bar
(C) Start the Find utility
(D) Open the History bar

36. In Microsoft Word shortcut key CTRL+I is used
for
(A) Open the Favorites bar
(B) Open the Open dialog box
(C) Start another instance of the browser

with the same Web address
(D) Open the Open dialog box, the same as

CTRL+L

37. In Microsoft Word shortcut key CTRL+L is
used for
(A) Open the Favorites bar
(B) Open the Open dialog box
(C) Start another instance of the browser

with the same Web address
(D) Open the Open dialog box, the same as

CTRL+L

38. In Microsoft Word shortcut key CTRL+N is
used for

(A) Open the Favorites bar

(B) Open the Open dialog box

(C) Start another instance of the browser
with the same Web address

(D) Open the Open dialog box, the same as
CTRL+L

39. In Microsoft Word shortcut key CTRL+O is
used for

(A) Open the Favorites bar

(B) Open the Open dialog box

(C) Start another instance of the browser
with the same Web address

(D) Open the Open dialog box, the same as
CTRL+L

40. In Microsoft Word shortcut key CTRL+P is
used for

(A) Open the Print dialog box

(B) Update the current Web page

(C) Close the current window

(D) None of these

Answer Sheet

1. (B) 2. (A) 3. (B) 4. (D) 5. (B)
6. (B) 7. (D) 8. (B) 9. (D) 10. (C)

11. (B) 12. (D) 13. (B) 14. (C) 15. (A)
16. (A) 17. (B) 18. (D) 19. (A) 20. (A)
21. (B) 22. (A) 23. (D) 24. (D) 25. (A)
26. (D) 27. (A) 28. (C) 29. (C) 30. (C)
31. (A) 32. (A) 33. (B) 34. (C) 35. (D)
36. (A) 37. (B) 38. (C) 39. (D) 40. (A)
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MICROSOFT EXCEL

1. In Excel default header for a worksheet is
(A) Your name
(B) The date and time
(C) None
(D) The sheet tab name

2. In Excel which of the following is not an option
in the spelling dialog box
(A) Edit (B) Ignore
(C) Ignore all (D) Change

3. Excel uses the …. Function when creating a
data table
(A) Average (B) Count
(C) Sum (D) Table

4. In Excel you can copy cell formats from one
cell to another by using the
(A) Backspace key  (B) Default font
(C) Format painter  (D) Formatting toolbar

5. In Excel accounting style shows negative
numbers in
(A) Bold (B) Brackets
(C) Parentheses (D) Quotes

6. In Excel you can use drag and drop to embed
excel worksheet data in a word document
(A) By dragging a range of excel data to the

word button on the taskbar while
pressing the Ctrl key

(B) By dragging a range of excel data to the
Word   button   on  the  taskbar  while
pressing Shift key

(C) By displaying both applications side-by-
side and dragging a selected range of
Excel  data  into  the  word  application
window while pressing the Ctrl key

(D) (A) and (C)

7. In Excel the chart wizard
(A) Can place a chart on a new chart sheet

or on any sheet in the workbook
(B) Can only place a chart on new chart sheet
(C) Can only place a chart on a new blank

worksheet
(D) Can only be used to create embedded

charts

8. In Excel which functions will calculate the

number of workdays between 6/9/2004 and

8/12/2004

(A) Workday (B) Date

(C) Networkdays (D) All of the above

9. In Excel data marker on a chart are linked to

data points in a worksheet, therefore,

(A) You can automatically apply formatting

to a data series

(B) You can change the position of a data

marker and automatically change the

data point value in the worksheet

(C) You can change a data print value and

automatically are draw the chart

(D) (A) and (B)

10. In Excel when you group worksheets

(A) You can enter variable data on multiple

worksheets at one time

(B) You can print more than one worksheet

at a time

(C) You can enter common data, formats,

and formulas on multiple worksheets

at one time

(D) (B) and (C)

11. In Excel you can zoom a worksheet

(A) With the mouse pointer in Print Preview

(B) With the zoom button on the Print

Preview toolbar

(C) With the Zoom command on the view

menu

(D) All of the above

12. You cannot link Excel worksheet data to a

Word document

(A) With the right drag method

(B) With a hyperlink

(C) With   the   copy   and   paste  special

commands

(D) With the copy and paste buttons on the

standard toolbar

yoursmahboob.wordpress.com
        (shared by Sujoy)



30  |  M.C.Qs. on Computer

13. In Excel this type of software is similar to an
accountant’s worksheet
(A) Word processing (B) Database
(C) Spreadsheets (D) Graphics

14. In Excel you can use the format painter
multiple times before you turn it off by
(A) You can use the format painter button

only one time when you click it
(B) Double clicking the format painter button
(C) Pressing the Ctrl key and clicking the

format painter button
(D) Pressing Alt key and clicking the format

painter button

15. In Excel default header for a worksheet is
(A) Your name (B) The date and time
(C) None (D) The sheet tab name

16. In Excel which of the following is not an option
in the spelling dialog box
(A) Edit (B) Ignore
(C) Ignore all (D) Change

17. In Excel you can quickly change the
appearance of your work by choosing Auto
Format from the ……….. Menu
(A) Edit (B) View
(C) Format (D) Tools

18. In Excel….. is a group of cells that form a
rectangle on the screen.
(A) Calculation (B) Formula

(C) Range (D) Range address

19. In Excel following term describes explanatory
text attached to a cell

(A) Callout (B) Comment
(C) Dialog (D) Extension

20. In Excel the drag and drop method of copying
or moving
(A) Can be used between worksheets but

not workbooks
(B) Can be used between workbooks but

not worksheets
(C) Can be used between workbooks but

not worksheets

(D) None

21. In Excel 3-D reference in a formula

(A) Cannot be modified
(B) Only appears on summary worksheets

(C) Limits the formatting options
(D) Spans worksheets

22. In Excel the auto calculate feature
(A) Can only add values in a range of cells

(B) Provides a quick way to view the results
of an arithmetic operation on a range of
cells

(C) Automatically creates formulas and

adds them to a worksheet

(D) None of the above

23. In Excel to protect a worksheet, you can

choose Protection and the Protect Sheet from

the ….. ……menu

(A) Edit (B) Format

(C) Tools (D) Data

24. In Excel you can open the Highlight Changes

dialog box by choosing Track Changes from

the …. Menu.

(A) Edit (B) Insert

(C) Format (D) Tools

25. In Excel which of the following is not a

worksheet design criterion

(A) Efficiency

(B) Auditability

(C) Description

(D) Clarity Correct Answer:  

26. In Excel to copy cell contents using drag and

drop, press the

(A) End key (B) Shift key

(C) Esc key (D) None of above

27. In Excel if you press …….., the cell accepts

your typing as its contents.

(A) Enter (B) Ctrl + Enter

(C) TAB (D) Insert

28. In Excel  the auto fill feature

(A) Extends a sequential series of data

(B) Automatically adds a range of cell

values

(C) Applies a boarder around selected cells

(D) None of above

29. In Excel  the keyboard shortcut (button or

buttons to be presse(D) for creating a chart

from the selected cells

(A) F3 (B) F5

(C) F7 (D) F11

30. In Excel you can use the formula palette to

(A) Format cells containing numbers

(B) Create and edit formulas containing

functions

(C) Entered assumptions data

(D) Copy a range of cells

31. What excel feature can you use if you want to

work with one record at a time?

(A) Auto Complete (B) Auto Filter

(C) Data Form (D) Sub Totals
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32. In Excel what chart object is horizontal or

vertical line that extends across the plot area

to make it easier to read and follow the

values?

(A) Category axis (B) Data marker

(C) Data point (D) Gridline

33. In Excel value used in a formula that does

not change is called a

(A) Cell address (B) Constant

(C) Function (D) Range

34. In Excel which elements of worksheet can

be protected from accidental modification ?

(A) Contents (B) Objects

(C) Scenarios (D) All of above

35. In Excel  you  can  use  the  drag  and  drop

method to

(A) Copy cell contents

(B) Move cell contents

(C) Add cell contents

(D) (A) and (B)

36. In Excel it is acceptable ot let long text flow

into adjacent cells on a worksheet when

(A) Data will be entered in the adjacent cells

(B) No data will be entered in the adjacent

cells

(C) There is nt suitable abbreviation of the

text

(D) There is not time to format the next

37. In Excel how can you delete a record?

(A) Delete the column from the worksheet

(B) Select Data > Form from the menu to

open the Data Form dialog box, find the

record and Click the Delete button

(C) Select Data > Delete Record from the

menu

(D) Click the Delete button on the Standard

toolbar

38. Right clicking something in Excel

(A) Deletes the object

(B) Nothing the right mouse button is there

for left handed people

(C) Opens   a   shortcut   menu   listing

everything you can do to the object

(D) Selects the object

39. In Excel Documentation should include

(A) Destination and users of the output data

(B) Source of input data

(C) Information   on   the   purpose   of   the

workbook
(D) All of the above

40. Files   created   with   Lotus   1-2-3    have   an
extension

(A) DOC (B) XLS

(C) 123 (D) WK1

41. In Excel to delete an embedded objects, first

(A) Double click the object

(B) Select the object by clicking it

(C) Press the Shift + Delete keys

(D) Select it and then press the delete key

42. In Excel comments can be added to cells

using

(A) Edit > Comments

(B) Insert > Comments

(C) File > Comments

(D) View > Comments

43. In   Excel   which   of   the  following   is   not  a

worksheet design criterion?

(A) Efficiency (B) Aditibility

(C) Description (D) Clarity

44. In Excel suppose you have columns of data

that span more than one printed page. How

can you automatically print the column

headings on each page?

(A) Click page setup on the file menu, click

the sheet tab, and enter the row that

contains these column headings under

print titles.

(B) Click page setup on the file menu, click

the page tab, click the options button,

then enter your choices.

(C) Click page setup on the finle menu, click

the sheet tab, and make a selection

under the print heading.

(D) All of above

45. In Excel  a fast way to add up this column of

number is to click in the cell below  the

numbers and then

(A) Click subtotals on the data menu

(B) View the sum in the formula bar

(C) Click the autosum button on the

standard toolbar, then press enter

(D) All of above

46. In Excel which of the following is an absolute

cell reference?

(A) !A!1 (B) $A$1

(C) #a#1 (D) A1

47. In Excel what symbol is used before a

number to make it a label?

(A) “ (quote) (B) = (equal)

(C) _ (underscore) (D) ‘ (apostrophe)
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48. In Excel which symbol must all formula begin

with?

(A) = (B) +

(C) ( (D) @

49. In Excel which of the following formulas is

not entered correctly?

(A) =10+50 (B) =B7*B1

(C) =B7+14 (D) 10+50

50. In Excel which of the following formulas will

Excel not be able to calculate?

(A) =SUM(Sales)-A3

(B) =SUM(A1:A5)*.5

(C) =SUM(A1:A5)/(10-10)

(D) =SUM(A1:A5)-10

51. In Excel typical worksheet has …. Number

of columns

(A) 128 (B) 256

(C) 512 (D) 1024

52. In Excel how many characters can be typed

in a single cell?

(A) 256 (B) 1024

(C) 32,000 (D) 65,535

53. In Excel worksheet can have a maximum of

…. Number of rows

(A) 256 (B) 1024

(C) 32,000 (D) 65,535

54. In Excel  the following is not an example of a

value

(A) 350                (B)  May 10, 2001

(C) 57&per cent;(D) Serial Number 50771

55. In Excel chart wizard term data series refers

to

(A) A chart legend

(B) A collection of chart data markers

(C) A set of values you plot in a chart

(D) A data label

56. In Excel  Chart wizard term data categories

refers to

(A) A chart plot area

(B) A horizontal axis

(C) The organization of individual values

with a chart’s data series

(D) The data range that supply chart data

57. In Excel worksheet range is a

(A) A command used for data modeling

(B) A range of values such as from 23 to

234
(C) A group of cells
(D) A group of worksheets

58. In Excel getting data from a cell located in a
different sheet is called
(A) Accessing (B) Referencing
(C) Updating (D) Functioning

59. In Excel Tab scrolling button
(A) Allow you to view a different worksheet
(B) Allow you to view additional worksheet

rows down
(C) Allow you to view additional worksheet

columns to the right
(D) Allow you to view additional sheets tabs

60. In Excel  numeric value can be treated as a
label value if it precedes with
(A) Apostrophe (‘) (B) Exclamation (!)
(C) Hash (#) (D) Ampersand (&)

61. In Excel concatenation of text can be done
using
(A) Apostrophe (‘) (B) Exclamation (!)
(C) Hash (#) (D) Ampersand (&)

62. In Excel data can be arranged in a worksheet
in a easy to understand manner using
(A) Auto formatting  (B) Applying styles
(C) Changing fonts (D) All of above

63. In Excel you can use drag-and-drop to
embed excel worksheet data in a word
document
(A) By dragging a range of excel data to the

word button on the taskbar while
pressing the Ctrl key

(B) By dragging a range of excel data to the
word button on the taskbar while
pressing Shift key

(C) By dragging a range of excel data to the
word button on the taskbar while
pressing Alt key

(D) None of above

64. In Excel  the auto calculate feature
(A) Can only add values in a range of cells
(B) Provides a quick way to view the result

of an arithmetic operation on a range of
cells

(C) Automatically creates formulas and
adds them to a worksheet

(D) (A) and (C)

65. In Excel to view a cell comment
(A) Click the edit comment commands on

the Insert menu
(B) Click the Display comment command

on the window menu
(C) Position the mouse pointer over the cell
(D) Click the comment command on the

view menu
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66. In Excel  say that you want to paste a formula

result – but not the underlying formula – to

another cell. In excel 2002, you would copy

the cell with the formula, then place the

insertion point in the cell you want to copy to

what next?

(A) Click the Paste button on the standard

toolbar

(B) Click the arrow on the paste button on

the standard toolbar, then click formulas

(C) Click the arrow on the paste button on

the standard toolbar, then click values.

(D) All of above

67. In Excel you can select a single range of cells

by

(A) Clicking the upper-left cell in a group of

cells and then pressing the Shift key

while clicking the lower right cell in a

group of cells

(B) Pressing the Ctrl key while dragging

over the desired cells

(C) Pressing the Shift key and an arrow key

(D) Dragging over the desired cells

68. All formula in Excel start with

(A) &percent; (B) +

(C) = (D) -

69. In Excel you can use a function to combine

text from two cells into one cell. But you can

use an operator to do the same thing. Which

operator is that?

(A) & (ampersan(D) (B) = (equal sign)

(C) (space) (D) All of the above

70. In Excel two common wildcard characters

that Excel recognizes are

(A) * and ? (B) < and >

(C) ^ and / (D) + and -

71. In Excel divide symbol is

(A) / (B) D

(C) \ (D) )

72. In Excel to add two cells (A1 and A2) together

you use the following formula

(A) =A1 + A2 (B) =Add(A1+A2)

(C) =together(A1:A2) (D) A1 plus A2

73. In Excel on an excel sheet the active cell in

indicated by

(A) A dark wide boarder

(B) A dotted border

(C) A blinking border
(D) None of above

74. In Excel on an Excel sheet the active cell in
indicated by
(A) A dark wide border
(B) A dotted border
(C) A blinking border
(D) None of above

75. In Excel using the F11 shortcut key to create
a chart on chart sheet creates
(A) A default chart
(B) A 2-dimensional column chart
(C) A 2-dimensional bar chart
(D) A 3-dimensional  line chart

76. In Excel you can print
(A) A range of cells by range name
(B) An entire worksheet
(C) A single worksheet
(D) All of the above

77. In Excel you can create only a horizontal page
break by first selecting
(A) A row below the row where you want the

page break to occure
(B) A cell in row 1
(C) A cell in column A
(D) (A) and (C)

78. In Excel you can create hyperlinks from the
Excel workbook to
(A) A webpage on company internet
(B) A web page on the internet
(C) Other Office application documents
(D) All

79. In Excel cell reference for a range of cells
that starts in cell B1 and goes over to column
G and down to row 10 is
(A) B1-G10 (B) B1.G10
(C) B1;G10 (D) B1:G10*

80. In Excel advantage of using a spreadsheet
is
(A) calculations can be done automatically.
(B) changing data automatically updates

calculations
(C) more flexibility
(D) all of the above

81. In Excel intersection of a row and column is
called :
(A) Cata (B) A field.
(C) A cell (D) An equation.

82. There are three types of data found in a
spreadsheet
(A) data, words, numbers
(B) equations, data, numbers
(C) words, numbers, labels
(D) numbers formulas, labels
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83. In Excel to select a column the easiest
method is to
(A) Double click any cell in the column
(B) Drag from the top cell in the column to

the last cell in the column
(C) Click the column heading
(D) Click the column label

84. In Excel if you press ……, the cell accepts
your typing as its contents.
(A) Enter (B) Ctrl+Enter
(C) Tab (D) Insert

85. In Excel to view a cell comment
(A) Click the edit comment command on

the insert menu
(B) Click the display comment command

on the window menu
(C) Position the mouse pointer over the cell
(D) Click the comment command on the

view menu

86. In Excel when you want to insert a blank
imbedded excel object in a word document
you can
(A) Click the object command on the insert

menu
(B) Click the office links button on the

standard toolbar
(C) Click the create worksheet button on the

formatting toolbar
(D) Click the import excel command on the

file menu

87. In Excel to save a workbook, you
(A) Click the save button on the standard

toolbar from the menu
(B) Press Ctrl+F5
(C) Click Save on the Windows Start button
(D) Select Edit>Save

88. In Excel you can edit a cell by
(A) Clicking the formula button
(B) Double clicking the cell to edit it in-place
(C) Selecting Edit>Edit Cell from the menu
(D) None of above

89. In Excel you can select a single range of cells
by
(A) Clicking the upper-left cell in a group of

cells and then pressing the Shift key
while clicking the lower right cell in a
group of cells

(B) Pressing the Ctrl key while dragging
over the desired cells

(C) Pressing the Shift key and an arrow key
(D) Dragging over the desired cells

90. In Excel to copy cell contents using drag and
drop press the
(A) End key (B) Shift key
(C) Ctrl key (D) Esc key

91. In Excel when you copy a formula
(A) Excel erases the original copy of the

formula
(B) Excel edits cell references in the newly

copied formula
(C) Excel adjusts absolute cell references
(D) Excel doesn’t adjust relative cell

references

92. In Excel  autofill feature
(A) Extends a sequential series of data
(B) Automatically adds range of cell values
(C) Applies a boarder around the selected

cells
(D) None of the above

93. In Excel which menu option can be sued to
split windows into two
(A) Format > window
(B) View > window > split
(C) Window > split
(D) View > split

94. In Excel which of the following special
function keys allow the content in cell
(A) Esc (B) Shift
(C) Return (D) Tab

95. In Excel which is not an advantage of using
computerized spreadsheets?
(A) Flexibility of moving entries
(B) Speed of calculation
(C) Ability of generate tables
(D) Cost of initial setup

96. In Excel To hold row and column titles in
place so that they do not scroll when you
scroll a worksheet click the
(A) Unfreeze panes command on the

window menu
(B) Freeze panes command on the window

menu
(C) Hold titles command on the edit menu
(D) Split command on the window menu

97. In Excel  the following will not cut information
(A) Pressing Ctrl + C
(B) Selecting Edit>Cut from the menu
(C) Clicking the Cut button on the standard
(D) Pressing Ctrl+X

98. In Excel which of the following is not a way to
complete a cell entry?
(A) Pressing enter
(B) Pressing any arrow key on the keyboard
(C) Clicking the Enter button on the Formula

bar
(D) Pressing spacebar

yoursmahboob.wordpress.com
        (shared by Sujoy)



M.C.Qs. on Computer  |  35

99. In Excel you can activate a cell by
(A) Pressing the Tab key
(B) Clicking the cell
(C) Pressing an arrow key
(D) All of the above

100. In Excel Text formulas
(A) Replace cell references
(B) Return ASCII values of characters
(C) Concatenate and manipulate text
(D) Show formula error value

101. In Excel  how do you insert a row?
(A) Right-click the row heading where you

want to insert the new row and select
Insert from the shortcut menu

(B) Select the row heading where you want
to insert the new row and select Edit
>Row from the menu

(C) Select the row heading where you want
to insert the new row and click the Insert
Row button on the standard toolbar

(D) All of the above

102. In Excel  the following is not a basic step in
creating a worksheet
(A) Save workbook
(B) Modifiy the worksheet
(C) Enter text and data
(D) Copy the worksheet

103. In Excel  how do you select an entire column?
(A) Select Edit > Select > Column from the

menu
(B) Click the column heading letter
(C) Hold down the shift key as you click

anywhere in the column.
(D) Hold down the Ctrl key as you click

anywhere in the column

104. In Excel  how can you print three copies of a
workbook?
(A) Select File>Properties form the menu

and type 3 in the Copies to print text box.
(B) Select File >Print from the menu and

type 3 in the Number of copies text box.
(C) Click the Print button on the standard

toolbar to print the document then take
it to Kinko’s and have 2 more copies
made

(D) Press Ctrl+P+3

105. In Excel  to create a formula, you first
(A) Select the cell you want to place the

formula into
(B) Type the equals sign (=) to tell Excel that

you’re about to enter a formula

(C) Enter the formula using any input values
and the appropriate mathematical
operators that make up your formula

(D) Choose the new command from the file
menu

106. In Excel  to center worksheet titles across a
range of cells, you must

(A) Select the cells containing the title text
plus the range over which the title text is
to be centered

(B) Widen the columns
(C) Select the cells containing the title text

plus the range over which the title text is
to be enfettered

(D) Format the cells with the comma style

107. In Excel how do you delete a column?
(A) Select the column heading you want to

delete and select the Delete Row button
on the standard toolbar

(B) Select the column heading you want to
delete and select Insert Delete from the
menu

(C) Select the row heading you want to
delete and select Edit>Delete from the
menu

(D) Right click the column heading you want
to delet and select delete from the
shortcut menu

108. In Excel  how can you find specific information
in a list?
(A) Select Tools > Finder from the menu
(B) Click the Find button on the standard

toolbar
(C) Select Insert > Find from the menu
(D) Select Data > Form from the menu to

open the Data Form dialog box and click
the Criteria button

109. In Excel when integrating word and excel,
word is usually the
(A) Server (B) Destination
(C) Client (D) Both (A) and (C)

110. In Excel  when a label is too long to fit within
a worksheet cell, you typically must
(A) Shorten the label
(B) Increase the column width
(C) Decrease the column width
(D) Adjust the row height

111. In Excel  name box
(A) Shows the location of the previously

active cell
(B) Appears to the left of the formula bar
(C) Appears below the status bar
(D) Appears below the menu bar
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112. In Excel  Comments put in cells are called
(A) Smart tip (B) Cell tip
(C) Web tip (D) Soft tip

113. In Excel  which is used to perform what if
analysis?
(A) Solver (B) Goal seek
(C) Scenario Manager (D) All of above

114. In Excel  you can use the horizontal and
vertical scroll bars to
(A) Split a worksheet into two panes
(B) View different rows and columns edit

the contents of a cell
(C) Edit the contents of a cell
(D) View different worksheets

115. In Excel  Multiple calculations can be made
in a single formula using
(A) standard formulas
(B) array formula
(C) complex formulas
(D) smart formula

116. In Excel To select several cells or ranges
that are not touching each other, you would
… while selecting
(A) hold down the Ctrl key
(B) hold down the Shift key
(C) hold down the Alt key
(D) hold down Ctrl + Shift key

117. In Excel A certain spreadsheet shows in Page
Break Preview that cells in Rows 1-25 have
white background. The cells in row 26 that
contain data have a dark grey background,
when you click the Print button
(A) nothing will print because some cells

with data have been omitted
(B) only the cells with gray background will

print
(C) the whole sheet will print
(D) only the cells with white background will

print

118. In Excel  constant is another name for this
type of data
(A) number (B) equation
(C) formula (D) description

119. In Excel the view that puts a blue a blue line
around each page that would be printed is
the
(A) Print Preview    (B) Normal View
(C) Page Break Preview   (D) Split View

120. In Excel AutoCalculate will quickly add
selected cells if you
(A) right click on the status bar and select Sum
(B) click the AutoCalculate button on the

toolbar

(C) use the key combination Ctrl+$
(D) double click the selection

121. In Excel the cell labeled F5 refers to
(A) row F column 5
(B) column F row 5
(C) function available in cells
(D) function key F4

122. In Excel when you are typing an equation
into a cell the first thing that must be entered
is
(A) the first cell referenced
(B) parenthesis
(C) quotation marks
(D) an equal sign

123. In Excel using the AutoSum button will
replace in the selected cell
(A) the sum of values  in the cell’s column
(B) nothing until you select a range of cells
(C) the sum of the cell’s row unless you

change the range
(D) a formula which will add values in the

range Excel guesses you want to add

124. In Excel Book1 is an example of how … are
numbered and named during each work
session
(A) Active cell (B) Formula bar
(C) Menu bar (D) Name box

125. In Excel the following displays the contents
of the active cell
(A) Active cell (B) Formula bar
(C) Menu bar (D) Name box

126. In Excel Graphics objects on a chart are used
to
(A) Add emphasis to chart data
(B) Add interest to a chart
(C) Help explain the chart data
(D) All the above

127. In Excel to select a column the easiest
method is to
(A) Double click any cell in the column
(B) Drag from the top cell in the column to

the last cell in the column
(C) Click the column heading
(D) Click the column label

128. In Excel to select an individual data marker
or data label, you must
(A) Double click the data series
(B) Right click selected marker
(C) Click once to select the series markers

or labels and click the desired marker
or label again

(D) Double click the marker or label
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129. In Excel to delete and embedded object, first
(A) Double click the object
(B) Select the object by clicking it
(C) Press the Shift + Delete keys
(D) Select it and then press Delete key

130. This type of software contains rows and
columns.
(A) Drawing (B) Spreadsheet
(C) Database (D) Word processing

131. In Excel to open an existing workbook, you
can click the Open button on the …… toolbar.
(A) Drawing (B) Formatting
(C) Forms (D) Standard

132. In Excel you can activate a cell by
(A) Pressing the Tab key
(B) Clicking the cell
(C) Pressing an arrow key
(D) All of above

133. In Excel the following setup options cannot
be set in the page setup dialog box?
(A) Printer selection
(B) Vertical or horizontal placement
(C) Orientation
(D) Row and column titles

134. In Excel  term refers to a specific set of values
saved with the workbook
(A) Range (B) Scenario
(C) Trend line (D) What-if analysis

135. In Excel got functions? No? You need the
insert function dialog box. How do you get it?
(A) Right click a cell and then click insert
(B) Click the insert menu and then click

function
(C) Type = in a cell
(D) All of the above

136. In Excel the following describes how to select
all the cells in a single column?
(A) Right click on column and select Pick

from list
(B) Use data – text to columns menu item
(C) Left click on the gray column title button
(D) Pressing Ctrl + A on the keyboard

137. In Excel when you use the fill effects in the
format data series dialog box, you cannot
(A) Rotate text on the chart
(B) Select a fore ground color
(C) Select a pattern
(D) Select a background color

138. In Excel Paper spreadsheets can have all
the same advantages as an electronic
spreadsheet except which of the following?
(A) Rows and columns  (B) Headings
(C) Speed  (D) None

139. In Excel the following is not a basic step in

creating a worksheet

(A) Save the workbook

(B) Modify the worksheet

(C) Enter text and data

(D) Copy the worksheet

140. In Excel what does SUMIF function do?

(A) Adds up cell values based on a condition

(B) Adds all the numbers in a range of cells

(C) Returns a subtotal in a list or database

(D) All of above

141. In Excel you can insert labels for

(A) All the data markers on a chart

(B) A data series

(C) A selected data marker

(D) All of the above

142. In Excel Tab scrolling buttons

(A) Allow you to view a different worksheet

(B) Allow you to view additional worksheet

row down

(C) Allow you to view additional worksheet

columns to the right

(D) Allow you to view additional sheet tabs

143. In Excel All macro keyboard shortcuts include

the ….. key

(A) Alt (B) Ctrl

(C) F11 (D) Shift

144. In Excel to open the Format Cells dialog box,

press

(A) Alt + 1 (B) Ctrl + 1

(C) Ctrl + Shift + 1 (D) F1

145. In Excel you can add a hyperlink to your

worksheet by pressing

(A) Alt + K (B) Ctrl + H

(C) Ctrl + K (D) Ctrl + Shift + K

146. In Excel to move to the previous worksheet,

press

(A) Alt + PgUp (B) Ctrl + PgUp

(C) Ctrl + PgDn (D) Shift + Tab

147. In Excel you can select a single range of cells

by

(A) Clicking the upper-left cell in a group of

cells and then pressing the Shift key

while clicking the lower right cell in a

group of cells

(B) Pressing the Ctrl key while dragging

over the desired cells

(C) Pressing the Shift key and an arrow key

(D) Dragging over the desired cells
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148. In Excel which of these will not select all the

cells in a document?

(A) Clicking three times with the right

mouse button in the spreadsheet

(B) Using the Edit – Select All menu

(C) Pressing Ctrl + A on the keyboard

(D) Pressing Ctrl + A on the keyboard

149. In Excel you can use the formula palette to

(A) Format cells containing numbers

(B) Create and edit formulas containing

functions

(C) Enter assumptions data

(D) Copy a range of cells

150. In Excel you can convert existing excel

worksheet data an charts to an HTML

document by using

(A) FTP wizard

(B) Internet assistant wizard

(C) Intranet wizard

(D) Import wizard

151. In Excel circular reference is

(A) Geometric modeling tool

(B) A cell that points to a drawing object

(C) A formula that either directly or indirectly

depends on itself

(D) Always erroneous

152. In Excel when you insert an excel file into a

word document. The data are

(A) Hyperlinked placed in a word table

(B) Linked

(C) Embedded

(D) Use the word menu bar and toolbars

153. In Excel the following is not information you

can specify using the solver

(A) Input cells (B) Constraints

(C) Target cell (D) Changing cells

154. In Excel each excel file is called a workbook

because

(A) It can contain text and data

(B) It can be modified

(C) It can contain many sheets including

worksheets and chart sheets

(D) You have to work hard to create it

155. In Excel you can enter which types of data

into worksheet cells?

(A) Labels, values, and formulas

(B) Labels and values but not formulas

(C) Values and formulas but not labels

(D) Formulas only

156. In Excel all worksheet formula
(A) Manipulate values
(B) Manipulate labels
(C) Return a formula result
(D) Use the addition operator

157. In Excel which of the following is a correct
order of precedence in formula calculation?
(A) Multiplication and division exponentia-

tion positive and negative values
(B) Multiplication and division, positive and

negative values, addition and subtraction
(C) Addition and subtraction, positive and

negative values, exponentiation
(D) All of above

158. In Excel the Paste Special command lets you
copy and paste
(A) Multiply the selection by a copied value
(B) Cell comments
(C) Formatting options
(D) The   resulting   values   of   a   formula

instead of the actual formula

159. In Excel the numbers in our worksheet look
like this: 1000. You want them to look like
this: $1,000.00. How can you accomplish
this?
(A) None of these
(B) Select Format > Money from the menu
(C) Click the Currency Style button on the

formatting toolbar
(D) You have to retype everything and

manually add the dollar signs, commas,
and decimals.

160. In Excel which of the following is not a valid
data type in excel
(A) Number (B) Character
(C) Label (D) Date/time

161. Excel worksheet cells work very similarly to
what common element of the windows
graphical user interface
(A) Option buttons (B) List boxes
(C) Text boxes (D) Combo boxes

162. In Excel which of the following options is not
located in the Page Setup dialog box?
(A) Page Break Preview.
(B) Page Orientation
(C) Margins
(D) Headers and Footers

163. In Excel one want to track the progress of the
stock market on a daily basis. Which type of
chart should one use?
(A) Pie chart (B) Row chart
(C) Line chart (D) Column chart
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164. In Excel without using the mouse or the arrow
keys, what is the fastest way of getting to cell
A1 in a spreadsheet?
(A) Press Ctrl +Home
(B) Press Home
(C) Press Shift + Home
(D) Press Alt + Home

165. Which of the following methods cannot be
used to edit the contents of a cell In Excel?

(A) Press the Alt key

(B) Clicking the formula bar

(C) Pressing the F2 key

(D) Double clicking the cell

166. In Excel if you begin typing an entry into a cell

and then realize that you don’t want your entry

placed into a cell, you

(A) Press the Erase key

(B) Press Esc

(C) Press the Enter button

(D) Press the Edit Formula button

167. In Excel  default style for new data keyed in a

new workbook is

(A) Comma (B) Currency

(C) Normal (D) Per cent

168. In Excel LEN function does what?

(A) Compares the content in two cells

(B) Counts the numbers of characters in a

cell

(C) Deletes extra space in text

(D) All of above

169. In Excel this function converts miles to

kilometers, kilograms to pounds, and so on

(A) Convert (B) Product

(C) Change (D) All of above

170. In Excel you can use the drag and drop

method to

(A) Copy cell contents

(B) Delete cells contents

(C) Add cell contents

(D) All of above

171. In Excel to balance your checkbook, your best

method is

(A) Copy your check amounts into Excel so

that you’ll have a neat printout to work

on

(B) Use Excel to check your arithmetic

(C) Download     the    Checkbook    register

templates from Templates on Microsoft

Office Online

(D) All of above

172. In Excel which formula can add the all the
numeric values in a range of cells, ignoring
those which are not numeric, and place the
resulting a difference cell
(A) Count (B) Average
(C) Sum (D) None of above

173. In Excel to name a constant, you use the
…… dialog box
(A) Create names (B) Define name
(C) Paste name (D) Format cells

174. In Excel to cancel the marquee, press
(A) Ctrl + End (B) End
(C) Esc (D) Shift + Esc

175. In Excel the function calculates depreciation
at the same amount each year over an
asset’s useful life
(A) DB (fixed-declining balance)
(B) SLN (straight line)
(C) DDB (double-declining)
(D) All of above

176. In Excel the following is not an underline
option in the format cells dialog box
(A) Double
(B) Single Engineering
(C) Single Accounting
(D) Double Accounting

177. In Excel to center worksheet titles across a
range of cell, you must
(A) Select the cells containing the title text

and use the fill handle to center the text
across a range of cells

(B) Widen the columns
(C) Select the cells containing the title text

and use the fill handle to center the text
across a range of cells

(D) Widen the column

178. In Excel when integrating Ms-Word and Excel,
Word is usually the
(A) Server (B) Source
(C) Client (D) None

179. In Excel Charts tips can
(A) Show the formatting of a data label
(B) Show the name of a data series
(C) Show the value of data point
(D) Both (B) and (C)

180. In Excel the Name box
(A) Shows the location of the previously

active cell
(B) Appears t the left of the formula bar
(C) Appears below the status bar
(D) Appears below the menu bar
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181. In Excel how do you change column width to
fit the contents?
(A) Single-click the boundary to the left to

the column heading
(B) Double click the boundary to the right of

the column heading
(C) Press Alt and single click anywhere in

the column
(D) All of above

182. In Excel when you work with large
worksheets, you may need to
(A) Size the worksheet to fit on the specific

number of pages
(B) Add and remove page breaks
(C) Specify only certain print areas
(D) All of above

183. In Excel Hyperlinks cannot be
(A) Special shapes like stars and banners 
(B) Drawing objects like rectangles ovals
(C) Pictures
(D) All can be hyperlinks

184. In Excel you can use the horizontal and
vertical scroll bars to
(A) Split a worksheet into two panes
(B) View different rows and columns
(C) Edit the contents of a cell
(D) View different worksheets

185. What do we call a computer program that
organizes data in rows and columns of cells?
You might use this type of program to keep a
record of the money you earned moving
lawns over the summer.
(A) Spreadsheet program
(B) Database program
(C) Word processor program
(D) Desktop publisher program

186. In Excel you can add an image to a template
by clicking the Insert Picture From File button
on the …. Toolbar.
(A) Standard (B) Formatting
(C) Drawing (D) Picture

187. In Excel to drag a selected range of data to
another worksheet in the same workbook,
use the
(A) Tab key (B) Alt key
(C) Shift key (D) Ctrl key

188. In Excel when creating a vertical page break
(A) The active cell must be A1
(B) The active cell can be anywhere in the

worksheet
(C) The active cell must be in row 1
(D) The active cell must be in column A

189. In Excel to activate the previous cell in a pre-
selected range, press
(A) The Alt key (B) The Tab key
(C) The Enter key (D) None of above

190. In Excel when the formula bar is activated,
you can see
(A) The Edit Formula button
(B) The Cancel button
(C) The Enter button (D) All of above

191. In a worksheet you can select
(A) Etire worksheet (B) Rows
(C) Columns (D) All of the above

192. When you print preview a worksheet
(A) the entire worksheet is displayed
(B) the selected range is displayed
(C) the active portion of the worksheet is

displayed
(D) All of the above

193. In Excel to access the Go To Special feature,
you can press
(A) Ctrl + G (B) Ctrl + O
(C) Ctrl + Shift + G (D) Ctrl + 1

194. In Excel which do you press to enter the
current date in a cell?
(A) Ctrl + Shift + : (B) Ctrl + ;
(C) Ctrl + F10 (D) All of above

195. In Excel it is acceptable to let long text flow
into adjacent cells on a worksheet when
(A) Data will be entered in the adjacent cells
(B) No data will be entered in the adjacent cells
(C) There is no suitable abbreviation for the

text
(D) There is not time to format the text

196. In Excel you can group noncontiguous
worksheets with
(A) The group button on the standard

toolbar
(B) The shift key and the mouse
(C) The ctrl key and mouse
(D) The alt+enter key

197. In Excel  Weight refers to
(A) The print density of characters
(B) The height of the printed character
(C) Upright or slanted shape
(D) The design and appearance of

characters

198. When you link data maintained in Excel
workbook to a Word document
(A) The Word document cannot be edited
(B) The Word document contains a refe-

rence to the original source application
(C) The word document must contain a

hyperlink
(D) The word document contains a copy of

the actual data

199. In Excel when you see a cell with a red
triangle in the top right corner, what does
this signify?
(A) There is an error in the cell
(B) There is a comment associated with the cell
(C) The font color for text in the cell is red
(D) A formula cannot be entered into the cell
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200. In Excel to hold row and column titles in
places so that they do not scroll when you
scroll a worksheet, click the
(A) Unfreeze panes command on the

window menu
(B) Freeze panes command on the window

menu
(C) Hold titles command on the edit menu
(D) Split command on the window menu

201. In Excel which of these is a quick way to copy
formatting from a selected cell to two other
cells on the same worksheet?
(A) Use Ctrl to select all three cells, then

click the paste button on the standard
toolbar

(B) Copy the selected cell, then select the
other two cells, click style on the Format
menu, then click Modify

(C) Click format painter on the Formatting
toolbar twice then click in each cell you
want to copy the formatting to

(D) All of above

202. To edit data in an embedded Excel
worksheet object in a Word document
(A) Use the Excel menu bar and toolbars

inside the word application
(B) Edit the hyperlink
(C) Edit the data in a Excel source

application
(D) Use the Word menu bar and toolbars

203. In Excel Status indicators are located on the
(A) Vertical scroll bar
(B) Horizontal scroll bar
(C) Formula bar
(D) Standard toolbar

204. In Excel Rounding errors can occur
(A) When you use multiplication, division,

or exponentiation in a formula
(B) When you use addition and subtraction

in a formula
(C) Because excel uses hidden decimal

places in computation
(D) When you show the results of formulas

with different decimal places that the
calculated results

205. In Excel one can copy data or formulas
(A) With the copy, paste and cut commands

on the edit menu
(B) With commands on ta shortcut menu
(C) With buttons on the standard toolbars
(D) All of the above

206. In Excel you cannot link excel worksheet data
to a word document
(A) With the right drag method
(B) With a hyperlink
(C) With the copy and paste special

commands
(D) With the copy and paste buttons on the

standard toolbar

207. An excel workbook is a collection of
(A) Workbooks
(B) Worksheets
(C) Charts
(D) Worksheets and charts

208. Excel files have a default extension of
(A) Xls (B) Xlw
(C) Wk1 (D) 123

209. In Excel one can use the format painter
multiple times before one turn it off by
(A) You can use the format painter button

on ly one time when you click it
(B) Double clicking the format painter button
(C) Pressing the Ctrl key and clicking the

format painter button
(D) Pressing the Alt key and clicking the

format painter button

210. In Excel Status indicators are located on the
(A) Vertical scroll bar
(B) Horizontal scroll bar
(C) Formula bar
(D) Formatting toolbar

211. In Excel you can open the scenario Manager
dialog box by choosing scenarios from the
….. menu.
(A) View (B) Insert
(C) Format (D) Tools

212. In Excel you can open the Sort dialog box by
choosing Sort from the ….. menu
(A) View (B) Format
(C) Tools (D) Data

213. In Excel to edit in an embedded excel
worksheet object in a word document
(A) Use the excel menu bar and toolbars

inside the word application
(B) Edit the hyperlink
(C) Edit the data in a excel source

application
(D) Use the word menu bar and toolbars

214. In Excel to create a formula, you can use
(A) Values but not cell references
(B) Cell references but not values
(C) Values or cell references although not

both at the same time
(D) Value and cell references

215. In Excel when working in the page break
preview, you can
(A) View exactly where each page break

occurs
(B) Add or remove page breaks
(C) Change the print area
(D) All of above

216. In Excel A data map is helpful
(A) When you have too much data to chart
(B) To show a geographic distribution of

data
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(C) To compare data points
(D) To show changes in data over time

217. In Excel Rounding errors can occur
(A) When you use multiplication, division or

exponentiation in a formula
(B) When you use addition and subtraction

in a formula
(C) Because Excel uses hidden decimal

places in computation
(D) When you show the results of formulas

with different decimal places than the
calculated results

218. In Excel you can copy data or formulas
(A) With the copy, paste and cut commands

on the edit menu
(B) With commands on a shortcut menu
(C) With buttons on the standard toolbar
(D) All of the above

219. In Excel Hyperlinks can be
(A) Text (B) Drawing objects
(C) Pictures (D) All of above

220. In Excel to activate the previous cell in a pre-
selected range, press
(A) The Alt key (B) The Tab key
(C) The Enter key (D) None of the above

221. In Excel when the formula bar is active, you
can see
(A) The edit formula button
(B) The cancel button
(C) The enter button
(D) All of the above

222. To   copy   formatting   from   one   area   in   a
worksheet and apply it to another area you
would use
(A) The Edit>Copy Format and Edit>Paste

Format commands form the menu.
(B) The Copy and Apply Formatting dialog

box, located under the Format>Copy and
Apply menu.

(C) There   is   no   way   to   copy  and  apply
formatting in Excel – You have to do it
manually

(D) The   Format   Painter   button   on   the
standard toolbar

223. In Excel In a worksheet you can select
(A) The entire worksheet
(B) Rows
(C) Columns
(D) All of the above

224. When you link data maintained in an excel
workbook to a word document
(A) The word document cannot be edit
(B) The  word  document   contains   a

reference to the original source
application

(C) The word document must contain a
hyperlink

(D) The word document contains a copy of
the actual data

225. Which area in an excel window allows
entering values and formulas ?
(A) Title bar (B) Menu bar
(C) Formula bar (D) Standard toolbar

Answer Sheet

1. (C) 2. (A) 3. (D) 4. (C) 5. (C)
6. (D) 7. (B) 8. (D) 9. (B) 10. (D)

11. (D) 12. (D) 13. (C) 14. (B) 15. (C)
16. (A) 17. (C) 18. (C) 19. (B) 20. (C)
21. (D) 22. (B) 23. (C) 24. (D) 25. (C)
26. (D) 27. (A) 28. (D) 29. (D) 30. (B)
31. (C) 32. (D) 33. (B) 34. (D) 35. (D)
36. (B) 37. (B) 38. (C) 39. (D) 40. (C)
41. (D) 42. (B) 43. (C) 44. (A) 45. (C)
46. (B) 47. (B) 48. (A) 49. (D) 50. (A)
51. (B) 52. (D) 53. (D) 54. (D) 55. (B)
56. (B) 57. (C) 58. (B) 59. (D) 60. (A)
61. (D) 62. (D) 63. (A) 64. (B) 65. (C)
66. (C) 67. (D) 68. (D) 69. (A) 70. (A)
71. (A) 72. (A) 73. (A) 74. (A) 75. (B)
76. (D) 77. (D) 78. (D) 79. (D) 80. (D)
81. (C) 82. (D) 83. (C) 84. (A) 85. (C)
86. (A) 87. (A) 88. (B) 89. (D) 90. (D)
91. (B) 92. (B) 93. (C) 94. (C) 95. (D)
96. (B) 97. (A) 98. (D) 99. (D) 100. (C)

101. (A) 102. (D) 103. (A) 104. (B) 105. (A)
106. (A) 107. (D) 108. (D) 109. (D) 110. (B)
111. (B) 112. (B) 113. (D) 114. (B) 115. (B)
116. (A) 117. (D) 118. (A) 119. (C) 120. (B)
121. (B) 122. (D) 123. (D) 124. (D) 125. (B)
126. (D) 127. (C) 128. (D) 129. (D) 130. (B)
131. (D) 132. (D) 133. ( A) 134. (B) 135. (B)
136. (C) 137. (A) 138. (C) 139. (D) 140. (A)
141. (D) 142. (D) 143. (A) 144. (B) 145. (C)
146. (D) 147. (D) 148. (A) 149. (B) 150. (B)
151. (C) 152. (B) 153. (A) 154. (C) 155. (A)
156. (C) 157. (D) 158. (D) 159. (C) 160. (B)
161. (C) 162. (A) 163. (C) 164. (A) 165. (A)
166. (B) 167. (C) 168. (A) 169. (A) 170. (A)
171. (C) 172. (C) 173. (B) 174. (C) 175. (B)
176. (B) 177. (A) 178. (C) 179. (D) 180. (B)
181. (B) 182. (D) 183. (D) 184. (B) 185. (A)
186. (D) 187. (D) 188. (C) 189. (D) 190. (D)
191. (D) 192. (D) 193. (A) 194. (B) 195. (B)
196. (C) 197. (A) 198. (B) 199. (B) 200. (B)
201. (C) 202. (A) 203. (C) 204. (A) 205. (D)
206. (D) 207. (D) 208. (A) 209. (B) 210. (C)
211. (D) 212. (D) 213. (A) 214. (D) 215. (D)
216. (B) 217. (A) 218. (D) 219. (D) 220. (D)

221. (D) 222. (D) 223. (B) 224. (B) 225. (C)
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1. In Microsoft PowerPoint to add a header or

footer to your handout, you can use
(A) The title master
(B) The slide master
(C) The handout master
(D) All of above

2. In Microsoft PowerPoint the following will not
advance the slides in a slide show view
(A) Esc key (B) The spacebar
(C) The Enter key (D) The mouse button

3. In Microsoft PowerPoint to select all of the
boxes of an organization chart
(A) Clicking and edit and select all
(B) Right click the chart background and

then click select all
(C) Press and hold the SHIFT key and click

each box
(D) All of above

4. In Microsoft PowerPoint what are lines, curve,
freeform, and scribble
(A) Emphasis effects that can be applied to

animations
(B) Types of custom motion paths
(C) Predefined entrance and exit effects
(D) All of the above

5. When using PowerPoint, to play a PowerPoint
show for previewing the show, select
(A) View, slide sorter (B) View, slide
(C) View, slide show (D) View outline

6. In Microsoft PowerPoint in order to see all
the slides on one screen use
(A) View, slide sorter
(B) View, slide
(C) View, master
(D) View, slide show

7. In Microsoft PowerPoint  the best place to
find animated images for your presentation
(A) Microsoft online
(B) Word clipart
(C) PowerPoint tools and ins
(D) All of the above

8. In Microsoft PowerPoint  the easy way to apply
varied animations to test on slides
(A) Apply effects in the custom animation

text pane
(B) Apply an animation scheme
(C) Customize bullets with animated clipart
(D) All of above

9. In  Microsoft  PowerPoint  using  a  custom
animation effect, how do you make text
appear on a slide by letter
(A) Apply the animation scheme fade in one

by one.
(B) Apply an entrance effect, and then set it

to by letter in the effect option dialog box*
(C) Apply the fly in entrance to the text, and

then set its speed to very slow.
(D) All of above

10. In Microsoft PowerPoint to exit the
PowerPoint application, you should
(A) Click the application minimize button
(B) Click the document close button
(C) Double click the application control

menu icon
(D) Double click the document control menu

icon

11. In Microsoft PowerPoint you can create a new
presentation by completing all of the following
except
(A) Clicking the new button on the standard

toolbar
(B) Clicking file, new
(C) Clicking file open (D) Pressing Ctrl + N

12. In     Microsoft     PowerPoint     you    have
customized a design template in one
presentation and you want to use it in another
presentation. What the best way to do this?
(A) Use the browse feature in the slide

design task pane to find the file that has
your design template and apply it to the
current file.

(B) Copy and paste the slide with the design
template you want to include the new
presentation; inserted slide will inherit
the design
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(C) Save the presentation that has the

design template with a new name, and

then use a new file to your presentation

(D) All of the above.

13. In   Microsoft   PowerPoint     the   following

displays when an image is selected

(A) Add clip art only if it relates to your topic

(B) Be sure to place at least one clipart

image per slide

(C) Resize the image so it takes up as much

space as your text

(D) Both (A) and (B)

14. The Microsoft clip gallery allows you to

(A) Add word art images to a slide

(B) Spell check your presentation

(C) Add clip art images to a slide or slides

(D) Add slides to a presentation

15. In Microsoft PowerPoint the following

command select all object at one time when

selecting multiple objects to be deleted

(A) Alt + A (B) Ctrl + A

(C) Shift + Enter (D) Edit, Select All

16. In Microsoft PowerPoint  to edit the text within

the boxes of an organization chart, you

(A) Select the box and text, then make

changes

(B) Select the box, then make the dchanges

(C) Highlight   the   text,   them   make  the

changes

(D) (A) and (B) both

17. In Microsoft PowerPoint  the following allow

you to select more than one slide in a

presentation

(A) Alt + Click each slide

(B) Shift + drag each slide

(C) Shift + Click each slide

(D) Ctrl + Click each slide

18. In Microsoft PowerPoint the following options

in the printer dialog box would you select to

prit slides 5 and 12 in a presentation?

(A) Slides (B) Custom shows

(C) Current slide (D) All of the above

19. In   Microsoft   PowerPoint   the   following

toolbars provides different options in various

master views

(A) Common tasks toolbar

(B) Drawing toolbar

(C) Formatting toolbar

(D) Standard toolbar

20. In Microsoft PowerPoint you can tell when
an object is active because
(A) The object is highlighted
(B) Eight small sizing handles appear

surrounding the text
(C) A box frame appears surrounding the

text

(D) (B) and (C) both

21. In Microsoft PowerPoint the following is not

an option when printing handouts

(A) Six slides per page

(B) Five slides per page

(C) Three slides per page

(D) Two slides per page

22. In Microsoft PowerPoint the best way to

design the layout for your slides

(A) Create layouts for slides, handouts and

notes using the Master Layout dialog

box in slide master view

(B) For each new slide, select a layout from

the Slide Layout task pane

(C) Apply templates from the Slide Design

task pane

(D) None of above

23. In Microsoft PowerPoint any and every

command can be found on the

(A) Drawing toolbar  (B) Formatting toolbar

(C) Standard toolbar (D) Menu bar

24. In Microsoft PowerPoint slide that is used to

introduce a topic and set the tone for the

presentation is called the

(A) Table slide (B) Graph slide

(C) Bullet slide (D) Title slide

25. In Microsoft PowerPoint the following

features should you use when typing in he

notes text box

(A) Slide shows (B) Insert

(C) Slide master (D) Zoom

26. In Microsoft PowerPoint following should be

used when you want to add a slide to an

existing presentation

(A) File, add a new slide

(B) Insert, new slide

(C) File, open

(D) File, new

27. In Microsoft PowerPoint the following is the

default page setup orientation for notes

pages, outlines and handouts

(A) Vertical (B) Landscape

(C) Portrait (D) None of above
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28. In Microsoft PowerPoint the following is the

default page setup orientation for slides in

PowerPoint

(A) Vertical (B) Landscape

(C) Portrait (D) None of above

29. In Microsoft PowerPoint are symbols used

to identify items in a list

(A) Icons (B) Markers

(C) Bullets (D) Graphics

30. In Microsoft PowerPoint toolbars that are

displayed by default in the PowerPoint

window includes

(A) Menu bar, standard toolbar, formatting

toolbar, drawing toolbar, status bar

(B) Menu bar, standard toolbar, formatting

toolbar, drawing toolbar, status bar

(C) Standard toolbar, formatting toolbar,

drawing toolbar, status bar

(D) Menu bar, standard toolbar, status bar,

drawing toolbar

31. In Microsoft PowerPoint view that displays

the slides on a presentation as miniature

representations of the slides is called

(A) Slide show    (B) Slide sorter view

(C) Notes page view (D) Outline view

32. In Microsoft PowerPoint view that displays

only text (title and bullets) is

(A) Slide show    (B) Slide sorter view

(C) Notes page view (D) Outline view

33. In Microsoft PowerPoint the entry effect as

one slide replaces another in a show is

called

(A) Animation

(B) Slide transition

(C) Custom animation

(D) Preset animation

34. In Microsoft PowerPoint  the following

presentation elements can you modify using

the slide master

(A) Slide comments

(B) Slide transitions

(C) Speaker note font and color

(D) All of above

35. In   Microsoft   PowerPoint    the   following

provides a printed copy of your presentation

(A) Outline

(B) Speaker notes

(C) Audience handouts

(D) All of the above

36. In Microsoft PowerPoint  slide show options
available to the presenter include all of the
following except
(A) Transitions command
(B) Speaker notes command
(C) Meeting reminder command
(D) Navigation commands

37. In Microsoft PowerPoint presentation
designs regulate the formatting and layout
for the slide and are commonly called
(A) Design plates (B) Templates
(C) Placeholders (D) Blueprints

38. In Microsoft PowerPoint  the following
bypasses the print dialog box when printing
individual slides or an entire presentation
(A) File, print, preview
(B) The print button
(C) File, print
(D) Ctrl + P

39. In Microsoft PowerPoint you can show the
shortcut menu during the slide show by
(A) Clicking the shortcut button on the

formatting toolbar
(B) Right clicking the current slide
(C) Clicking an icon on the current slide
(D) (A) and (B) both

40. In Microsoft PowerPoint auto clipart is a
feature that
(A) Automatically places clipart in your

presentation
(B) Scans your presentation for incorrect

spelling in your words on each slide
(C) Scans your presentation for incorrect

spelling in Word Arts objects
(D) All of above

41. Which   file   format   can   be   added   to   a
PowerPoint show?
(A) .jpg (B) .giv
(C) .wav (D) All of the above

42. In Microsoft PowerPoint two kind of sound
effects files that can be added to the
presentation are
(A) .wav files and .mid files
(B) .wav files and .gif files
(C) .wav files and .jpg files
(D) .jpg files and .gif files

43. In   Microsoft   PowerPoint   the  following
includes special effects that can be applied
to drawing objects
(A) Gradient fills (B) Line color and style
(C) Rotating (D) All of above
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44. In Microsoft PowerPoint the term used when
a clip art image changes the direction it faces
(A) Group (B) Flip
(C) Rotate (D) (A) and (B) both true

45. In Microsoft PowerPoint  the term used when
you press and hold the left mouse key and
move the mouse around the slide
(A) Highlighting (B) Dragging
(C) Selecting (D) (B) and (C) both true

46. In Microsoft PowerPoint size of a table object
(A) Is dependent on the amount of text

within the table
(B) Is determined by the presentation

design but can be changed
(C) Is determined by the presentation

design and cannot be changed
(D) (A) and (C) both are true

47. In    Microsoft     PowerPoint   size   of  an
organization chart object

(A) Is  determined  by  the  presentation
design and cannot be changed

(B) Is  determined   by   the   presentation
design   but   can   be   changed  in
PowerPoint

(C) Is dependent on the amount of text
within the organization chart

(D) Both (A) and (C) are true

48. In Microsoft PowerPoint  special effects used
to introduce slides in a presentation are
called

(A) Effects (B) Custom animations

(C) Transitions (D) Present animations

49. In Microsoft PowerPoint you can edit an
embedded organization chart object by

(A) Clicking edit object

(B) Double clicking the organization chart
object

(C) Right clicking the chart object, then
clicking edit MS-Organizaiton Chart
object

(D) (B) and (C) are true

50. In Microsoft PowerPoint  the term used when
you press and hold the left mouse key and
more the mouse around the slide

(A) Highlighting (B) Dragging

(C) Selecting (D) Moving

51. In Microsoft PowerPoint  the following is not
one of PowerPoint’s views

(A) Slide show view (B) Slide view

(C) Presentation view (D) Outline view

52. In Microsoft PowerPoint the following format

options should be used to display dollars

on an axis

(A) Normal (B) Percentage

(C) Currency (D) Comma

53. In Microsoft PowerPoint to maintain the

perspective (height and width ratio) of an

object when resizing, you need to

(A) Press and hold the shift key while

dragging a corner sizing handle

(B) Press and hold the alt + ctrl keys while

dragging a middle handle

(C) Drag a corner sizing handle

(D) (A) and (C) both true

54. In Microsoft PowerPoint the following is/are

true about rulers and guides

(A) Rulers and guides can be turned on or

off

(B) Rulers and guides print on the slide

(C) Rulers and guides help place objects

on the slide

(D) (A) and (C) both true

55. In Microsoft PowerPoint to edit the text within

the boxes of an organization chart, you

(A) Select the box and text, then make the

changes

(B) Select the box, then make the changes

(C) Highlight the text, then make the

changes

(D) Highlight the text then make the change

56. In Microsoft PowerPoint  the following best

describes serifs

(A) Serifs on characters help to differentiate

between similar looking letters

(B) Serifs fonts are best for viewing test at a

distance

(C) Serifs are fine cross strokes that appear

at the bottom and top of a letter

(D) Serif font are very simple in appearance

57. In Microsoft PowerPoint the following options

changes the fill color of an object back to the

default color

(A) Template (B) Automatic

(C) Patterns (D) Fill colors

58. In Microsoft PowerPoint  the following  you

use to add shading to a drawing object on or

an auto shape object

(A) Text box tool (B) Line tool

(C) Fill color (D) (B) and (C) both true
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59. In Microsoft PowerPoint the following tools
enable you to add text to a slide without using
the standard placeholders
(A) Text box tool (B) Line tool;
(C) Fill color (D) Auto shapes tool

60. In Microsoft PowerPoint cell is defined as
(A) The intersection of a column and a row
(B) An input box
(C) A rectangular marker
(D) All of the above

61. In Microsoft PowerPoint the following must
be used with the mouse when you want to
resize an image from the center and keep it
proportioned
(A) The space bar (B) The alt key
(C) The ctrl key (D) The shift key

62. In Microsoft PowerPoint the following should
be used with the mouse when you want to
draw a perfect shape
(A) The spacebar (B) The alt key
(C) The ctrl key (D) The shift key

63. In Microsoft PowerPoint on which part of the
chart are the values entered in a data sheet
displayed
(A) The title area (B) The legend
(C) The y-axis (D) The x-axis

64. In Microsoft PowerPoint one way to make a
PowerPoint slide display animations is to
(A) Select the slide in normal view; and click

Format, Animation
(B) Click the PowerPoint window and move

it around vigorously with the mouse for
a manual animation effect

(C) Select the slide in slide sorter view, right
click and choose preset animations
from the shortcut menu

(D) PowerPoint does not have an animation
feature

65. In Microsoft PowerPoint the following is not
a way to cut ext
(A) Select the text and press the delete

button
(B) Select the text and select Edit, Cut from

the menu
(C) Select the text and click the Cut button

on the toolbar
(D) Select the text and press Ctrl + X

66. In   Microsoft   PowerPoint   which   of   the
following can you use to add times to the
slides in a presentation
(A) Slice Show menu
(B) Rehearse timing button
(C) Slide transition button
(D) All of the above

67. In Microsoft PowerPoint  in order to edit a
chart, you can
(A) Triple click the chart object
(B) Click and drag the chart object
(C) Double click the chart object
(D) Click the chart objects

68. In Microsoft PowerPoint an image is
selected, it displays which of the following?
(A) Two corner handles
(B) Six middle handles
(C) Eight sizing handles
(D) Six boxes

69. In Microsoft PowerPoint material consisting
of text and numbers is best presented as
(A) A table slide (B) A bullet slide
(C) A title slide (D) All of the above

70. In Microsoft PowerPoint is a motion path
(A) A type of animation entrance effect
(B) A method of advancing slides
(C) A method of moving items on a slide
(D) All of the above

71. In Microsoft PowerPoint what is a slide-title
master pair?
(A) The title area and text area of a specific

slide
(B) A slide master and title master merged

into a single slide
(C) A slide master and title master for a

specific design template
(D) All of above

72. In Microsoft PowerPoint  the following should
you use if you want all the slide in the
presentation to have the same “look”
(A) The slide layout option
(B) Add a slide option
(C) Outline view
(D) A presentation design template

73. In Microsoft PowerPoint in the context of
animations, what is a trigger?
(A) An action button that advances to the

next slide
(B) An item on the slide that performs an

action when clicked
(C) The name of a motion path
(D) All of above

74. In  Microsoft  PowerPoint  if  you  have  a
PowerPoint show you created and want to
send using email to another teacher you can
add the show to your email message as
(A) Inclusion (B) Attachment
(C) Reply (D) Forward
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75. In Microsoft PowerPoint in order to edit a
chart, you can
(A) Triple click the chart object
(B) Click and drag the chart object
(C) Double click the chart object
(D) Click the chart object

76. In Microsoft PowerPoint to exit the PowerPoint
(A) Click the application minimize button
(B) Click the document close button
(C) Double click the applications control

menu icon
(D) Double click the document control menu

icon

77. In Microsoft PowerPoint  to preview a motion
path effect using the custom animation task
pane, you should
(A) Click the play button
(B) Click the show effect button
(C) Double click the motion path
(D) All of above

78. In Microsoft PowerPoint you can create a new
presentation by completing all of the
following except
(A) Clicking the new button on the standard

toolbar
(B) Clicking file, new
(C) Clicking file open
(D) Pressing Ctrl + N

79. Which of the following will not advance the
slides in a slide show view?
(A) The esc key (B) The space bar
(C) The enter key (D) The mouse button

80. To import text from a word document that
uses headings into a PowerPoint
presentation:
(A) This can not be done in PowerPoint
(B) Click Insert, Slides from Outline
(C) Click Import, Word Document Headings
(D) Click File, New, Presentation from Word

Headings

81. Format painter
(A) To paint pretty pictures on your slides
(B) To copy formatting from one object or

piece of text and then apply it elsewhere
(C) To change the background color of your

slides
(D) To paint pretty pictures on background

of slides

82. Slide show options available to the presenter
include all of the following except
(A) Transitions command
(B) Speaker notes command
(C) Meeting minder command
(D) Navigation commands

83. Which of the following is an example for
automatic text formatting
(A) Underlining hyperlink
(B) Adjusting extra space
(C) Replacing two -’s with an em hyphens
(D) All of above

84. Which of the following is not a way to create
a new presentation?
(A) Using the Scan-In Slides feature
(B) From scratch (create a blank

presentation
(C) Using a template
(D) Using the auto content wizard

85. The quickest way to create a PowerPoint
presentation is to use the
(A) Word for windows templates
(B) Auto creation wizard
(C) Auto content wizard
(D) Presentation wizard

86. Which of the following toolbars provide
different options in various master views?
(A) Common tasks toolbar
(B) Drawing toolbar
(C) Formatting toolbar
(D) Standard toolbar

87. How can you create a uniform appearance
by adding a background image to all slides?
(A) Create a template
(B) Edit the slide master
(C) Use the autocorrect wizard
(D) All of the above

88. How do you create speaker note pages that
show the slides, related notes, and your
company logo on each page?
(A) Edit the notes master and add your

company logo
(B) Edit the slide master and insert your

company logo and notes pane
(C) Edit the handout master to include your

company logo and one slide per page
with additional note space

(D) All of the above

89. Which option on the custom animation task
pane allows you to apply a preset or custom
motion path?
(A) Add effect (B) Emphasis
(C) Animate now (D) All of the above

90. What is the term used when a clip art image
changes the direction of faces?
(A) Group (B) Flip
(C) Rotate (D) All of the above
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91. The slide that is used to introduce a topic
and set the tone for the presentation is called
the
(A) Table slide (B) Graph slide
(C) Bullet slide (D) Title slide

92. Which of the following features should you
use when typing in the notes text box?
(A) Slide show    (B) Insert
(C) Slide maser (D) Zoom

93. Which option allows you to select line, curve,
freeform or scribble tools?
(A) Create effect
(B) Insert motion path
(C) Draw custom path
(D) All of the above

94. In Microsoft PowerPoint you can embed a
MS-Organization Chart in a slide by
(A) Clicking the object command on the edit

menu
(B) Clicking the object command on the edit

menu
(C) Clicking the insert new slide button the

standard toolbar, then double click the
organization chart button on the
formatting toolbar

(D) Clicking the MS-Organization Chart
button on the standard toolbar

95. In Microsoft PowerPoint to select one
hyperlink after another during a slide
presentation, what do you press?
(A) Tab (B) Ctrl + K
(C) Ctrl + h (D) All of above

96. In Microsoft PowerPoint which application
view works best for adding slide transitions?
(A) Slide show view(B) Slide sorter view
(C) Slide view  (D) Notes view

97. Which of the following views is the best view
to use when setting transition effects for all
slides in a presentation ?
(A) Slide sorter view  (B) Notes page view
(C) Slide view     (D) Outline view

98. Which option can be used to set custom
timings for slides in a presentation?
(A) Slider Timings (B) Slider Timer
(C) Rehearsal (D) Slide Show Setup

99. Which of the following should be used when
you  want  to  add  a  slide  to  an  existing
presentation?
(A) File, add a new slide
(B) Insert, New slide
(C) File Open
(D) File, New

100. Which of the following tool enables you to
add text to a slide without using the standard
placeholders?
(A) Text tool box (B) Line tool
(C) Drawing tool (D) Auto shapes tool

101. Want your logo in the same position on every
slide, automatically. Insert it on the
(A) Handout master (B) Notes master
(C) Slide master (D) All of the above

102. Which of the following views is the best view
to use when setting transition effects for all
slides in a presentation?
(A) Slide sorter view  (B) Notes pages view
(C) Slide view     (D) Outline view

103. Objects on the slide that hold text are called
(A) Placeholders (B) Object holders
(C) Auto layouts (D) Text holders

104. Which of the following provides a means of
printing out feature notes with a miniature
slide on a printed page?
(A) Slide with animation
(B) Outline view
(C) Notes page
(D) Audience handout

105. Which command brings you to the first slide
in your presentation?
(A) Next slide button (B) Page up
(C) Ctrl + Home (D) Ctrl + End

106. In normal view, how can you quickly change
to handout master view?
(A) Click the outline tab and select handout

master view
(B) Press the shift key and click the handout

master view button
(C) On the view menu, click slide sorter, and

click handouts.
(D) All of above

107. How can you quickly reinstate a deleted
footer placeholder in master view?
(A) Create a new slide master
(B) Re-apply the footer placeholder
(C) Re-apply the slide layout
(D) All of the above

108. Which of the following can you use to add
times to the slides in a presentation?
(A) Slide show menu
(B) Rehearse timings button
(C) Slide transition button
(D) All of the above

109. Objects on the slide that hold text are called
(A) Placeholders (B) Object holders
(C) Auto layout (D) Text holders
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110. You have got a bunch of digital holiday photo
you want to put into a slide show. What the
quickest method?
(A) Apply a multiple-picture layout to several

slides, and use the clipart icon on the
slides to import your picture

(B) On the insert menu, point to the picture,
click from file, and select your picture in
a group for each slide

(C) On the insert menu, point the picture and
click new photo album

(D) All of the above

111. In Microsoft PowerPoint Line spacing refers
to
(A) The space between the lines of text
(B) The height of the line
(C) The length of the line
(D) (A) and (C) both

112. In Microsoft PowerPoint which of the
following uses the spelling and grammar
feature to indicate an incorrect spelling?
(A) The incorrect word appears in all capital

letters
(B) The incorrect word has a wavy red line

under it
(C) The incorrect word appears italicized
(D) The incorrect word appears bold

113. In Microsoft PowerPoint in Microsoft
PowerPoint which of the following bypasses
the print dialog box when printing individual
slides or an entire presentation?
(A) File, Print Preview  (B) The print button
(C) File, print       (D) Ctrl + P

114. In Microsoft PowerPoint how do you add
degrees of transparency to shapes such as
arrows, so that the slide background shows
though?
(A) Use #D style 4 button on the drawing

toolbar
(B) Use the Set Transparent Color button

on the Picture toolbar
(C) Use the Transparency slider in the

Format AutoShapes dialog box
(D) All of above

115. In Microsoft PowerPoint material consisting
of text and numbers is best presented as
(A) A table slide (B) A bullet slide
(C) A title slide (D) All of above

116. In Microsoft PowerPoint   auto clip art is a
feature that
(A) Automatically places clip art in your

presentation
(B) Scans your presentation for incorrect

spelling of words on each slide

(C) Scans your presentation for incorrect
spelling in word art objects

(D) All of the above

117. In Microsoft PowerPoint to select all the
boxes of an organization chart
(A) Click edit, select all
(B) Right click the chart background click

select all
(C) Press and hold the shift key and click

each box
(D) All of the above

118. In Microsoft PowerPoint to adjust the width
of table columns, you
(A) Click table menu. Column width, then

make adjustments
(B) Drag the vertical gridline between two

columns
(C) Drag the column markers on the table

ruler bar
(D) Both (B) and (C)

119. In Microsoft PowerPoint   to add a new row to
a table you would
(A) Click the insert rows command on the

insert menu
(B) Press the enter key
(C) Click the insert rows button on the

standard toolbar
(D) None of the above

120. In Microsoft PowerPoint after moving a clip
art image to a particular location on the slide,
you can immediately reverse the action using
the
(A) Click the not do move object command

on the edit menu
(B) Click on the undo button
(C) Click on redo button
(D) All of above

121. In Microsoft PowerPoint you can edit an
embedded organization chart object by
(A) Clicking the edit object
(B) Double clicking the organization chart

object
(C) Right clicking the chart object, then

clicking edit MS-Organization Chart
object

(D) (B) and (C) both are true

122. You edit an embedded table object by
(A) Clicking the edit sub command of the

document object command on the edit
menu

(B) Double clicking the table object
(C) Right clicking the table object, then

clicking edit document on the edit menu
(D) All of above
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123. In Microsoft PowerPoint you can embed a
Microsoft Word tale in a slide by

(A) Clicking the insert new slide button on
the standard toolbar, then double

clicking table
(B) Clicking the insert Microsoft word table

button on the formatting toolbar
(C) Clicking the insert Microsoft word table

button on the standard toolbar
(D) Both (A) and (C)

124. In Microsoft PowerPoint  you can embed a

organization chart in a slide by
(A) Clicking the object command on the edit

menu
(B) Clicking the insert new slide button on

the standard toolbar, then double clicking
the organization chart auto layout

(C) Clicking the ms organization chart
button on the formatting toolbar

(D) Clicking   the   ms   organization   chart
button on the standard toolbar

125. In Microsoft PowerPoint you can add multiple
subordinates to a position by

(A) Clicking the subordinate button as you
press and hold shift

(B) Clicking the subordinate button each
and every time you add a subordinate

(C) Clicking the subordinate button as many
times as the desired boxes

(D) All of above

126. How would you create the following diagram

in PowerPoint
(A) Use auto shapes and the drawing toolbar

to create the diagram and design it
(B) Open   the   diagram   gallery   from   the

drawing   toolbar   and   choose   this
diagram type

(C) Use the chart command on the insert
menu to import the diagram

(D) All of above

127. Which of the following provides a means of
printing out features notes with a miniature

slide on a printed page?
(A) Slides with animation

(B) Outline view
(C) Notes page

(D) Audience handout

128. Which command brings you to the first slide

in your presentation?
(A) Next slide button (B) Page up

(C) Ctrl + home (D) Ctrl + end

129. In Microsoft PowerPoint you were giving your

presentation, and you need to click a slide
that’s few slides back. How do you get there?
(A) Press ESC to get back into a normal

view; click the slide thumbnail in normal
view; then click the resume slide show
button

(B) Press backspace until your desired
slide

(C) Right click, point to go on the shortcut
menu, point to by title, and click the slide
you want to go to

(D) All of above

130. In Microsoft PowerPoint which of the
following should you do to bring a bullet back
to a previous level?
(A) Press the shift + tab keys
(B) Press the shift key
(C) Press the enter key
(D) Press the tab key

131. In   Microsoft   PowerPoint   good   design
determines
(A) Credibility (B) Readability
(C) First impression (D) All of above

132. In Microsoft PowerPoint your presentation is
ready to go, but you don’t know if PowerPoint
is installed on the computer, you will use to
present with what’s the safe way
(A) Save your presentation as a web page
(B) Set up your presentation to be ”browse

as a kiosk”
(C) Use the Pack and Go wizard
(D) All of the above

133. In Microsoft PowerPoint  view that displays
the slides of a presentation as miniature
representations of the slides is called
(A) Slide show     (B) Slide sorter view
(C) Notes page view  (D) Outline view

134. In Microsoft PowerPoint  view that displays
only text (title and bullets) is
(A) Slide show     (B) Slide sorter view
(C) Notes page view  (D) Outline view

135. In   Microsoft   PowerPoint   the   following
provides a printed copy of your presentation
(A) Outlines (B) Speaker notes
(C) Audience handouts (D) All of above

136. In Microsoft PowerPoint presentation
designs regulate the formatting and layout
for the slide and are commonly called
(A) Design templates (B) Templates
(C) Placeholders (D) Blueprints
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137. In Microsoft PowerPoint  the following should
you use if you want all the slides in the

presentation to have the same look

(A) The slid layout option

(B) The add a slide option

(C) Outline view

(D) A presentation design template

138. In Microsoft PowerPoint the key deletes text

before, or the left of, the insertion point

(A) Backspace (B) Page up

(C) Delete (D) Page down

139. Which of the following is not a transition

effect?

(A) Blinks diagonal (B) Dissolve

(C) Fade through black (D) Blinds vertical

140. In Microsoft PowerPoint to create a

PowerPoint presentation from a template

(A) Click File, New, select the presentations

tab and choose a template

(B) Click File, New Template and choose a

template

(C) Import a presentation template from

PowerPoint’s template wizard

(D) Click Create Template from scratch,

Now

141. In Microsoft PowerPoint to save a

presentation you

(A) click save on the windows start button

(B) press Ctrl + F5

(C) select File, Save from the menu

(D) click the saver button on the formatting

toolbar

142. In Microsoft PowerPoint to change font size

of a selected slide title, you

(A) Click the toolbars font dropdown arrow

and choose the font you prefer

(B) Click format, title and choose a font from

the font tab

(C) Click the toolbar’s increase font size

button

(D) Click title, new font, ok.

143. In Microsoft PowerPoint  to change font size

of a selected slide title, you

(A) Click the toolbars Font dropdown arrow

and choose the font you prefer

(B) Click Format, Title and choose a font

from the font tab

(C) Click the toolbar’s Increase Font Size

button

(D) Click Title, New Font, OK

144. In Microsoft PowerPoint you can show the
shortcut menu during the slide show by
(A) Clicking the shortcut button in the

formatting toolbar
(B) Right clicking the current slide
(C) Clicking an icon on the current slide
(D) A and b

145. In Microsoft PowerPoint  to insert a new slide
in the current presentation, we can choose
(A) Ctrl + M (B) Ctrl + N
(C) Ctrl + O (D) Ctrl + F

146. Microsoft PowerPoint is a
(A) Database program
(B) Spreadsheet program
(C) Presentation program
(D) Word processing program

147. In Microsoft PowerPoint  the name of the form
used to input chart values
(A) Datasheet  (B) Microsoft Excel
(C) Microsoft graph (D) Auto form

148. In Microsoft PowerPoint  Right clicking
something in PowerPoint
(A) Deletes the object
(B) Selects the object
(C) Opens a shortcut menu listing for the

object
(D) Nothing he right mouse button for

operation

149. In Microsoft PowerPoint after choosing a
predefine template, …………. option has to
be chosen to change a background color
(A) Design template    (B) Color scheme
(C) Animation scheme (D) Color effects

150. In Microsoft PowerPoint ellipse Motion is a
predefined
(A) Design template (B) Color scheme
(C) Animation scheme (D) None of these

151. In Microsoft PowerPoint we can replace a
font on all slides with another font using the
…. option
(A) Edit, Fonts
(B) Tools, Fonts
(C) Tools, Replace Fonts
(D) Format, Replace Fonts

152. In Microsoft PowerPoint  special effects used
to introduce slides in a presentation are
called
(A) Effects (B) Custom animations
(C) Transitions (D) Preset animations

153. In Microsoft PowerPoint the key on the
keyboard can be used to view slide show

(A) F1 (B) F2

(C) F5 (D) F10
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154. In Microsoft PowerPoint it  is the name of the
form used to input chart values
(A) Datasheet  (B) Microsoft Excel
(C) Microsoft graph (D) Auto form

155. Which of the following you must first complete
in order to delete an object?
(A) Double click the image
(B) Select the image
(C) Resize the image
(D) Move the image to a new location

156. In Microsoft PowerPoint the term used to
describe the separation of a clip art object
into different parts so that it becomes a
PowerPoint object
(A) Embedding (B) Regrouping
(C) Ungrouping (D) Grouping

157. In Microsoft PowerPoint auto shapes tool
provides you with

(A) Fancy text to place on your slide

(B) usually found shapes

(C) Any shape you want to add on a slide

(D) Clip art that is related to your
presentation

158. In Microsoft PowerPoint the following should
be used when you want to add a slide to an
existing presentation

(A) File, add a new slide

(B) Insert, new slide

(C) File, open

(D) File, new

159. An  organization  has  a  president,  vice
president, managers and supervisors. On
what level of an organization chart are the
vice presidents

(A) Fourth level (B) Third level

(C) Second level (D) First level

160. In Microsoft PowerPoint press animation
effects allows you to

(A) Add clip art images to your slides

(B) Create a custom transition to the nect
slide

(C) Show bullet items as they are discussed
(D) None of above

161. In Microsoft PowerPoint the following
features allows you to view slides in a slide
show without manually advancing each slide

(A) Adding build effects

(B) Setting slide times

(C) Adding transitions

(D) All of these

162. In Microsoft PowerPoint Animation schemes

can be applied to ….. in the presentation

(A) All slides (B) Select slides

(C) Current slide (D) All of the above

163. In Microsoft PowerPoint  the following feature

allows you to select more than one slide in

slide sorter view

(A) Alt + Click each slide

(B) Shift + drag each slide

(C) Shift + Click each slide

(D) Ctrl + Click each slide

164. In Microsoft PowerPoint one thing the

common tasks button allows you to do is

(A) Apply a design template to a slide

(B) Insert a new slide

(C) Choose a new layout for a slide

(D) All of above

165. In Microsoft PowerPoint file which contains

readymade styles that can be used for a

presentations is called

(A) Auto style (B) Template

(C) Wizard (D) Pre-formatting

166. In Microsoft PowerPoint  the following fill

effects can you use for the slide background

(A) Gradient (B) Texture

(C) Picture (D) All of the above

167. In Microsoft PowerPoint  the following

statements is not true

(A) Holding down the Shift key while you

draw an object creates perfect squares,
circles and straight lines

(B) The text in a text box can’t be formatted
(C) The drawing toolbar contains tools for

drawing shapes, lines, arrows, and
more

(D) Ctrl + S save the document

168. In Microsoft PowerPoint chart can be put as
a part of the presentation using
(A) Insert -> Chart
(B) Insert -> Pictures -> Chart
(C) Edit -> Chart
(D) View -> Chart

169. The arrangement of elements such as Title
and Subtitle text, pictures, tables etc. is called
(A) Layout (B) Presentation

(C) Design (D) Scheme

170. In Microsoft PowerPoint the following are

types of sound files

(A) LOG files (B) DAT files

(C) WAV files (D) DRV files
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171. In Microsoft PowerPoint the following can you

use to add times to the slides in a

presentation

(A) Microsoft graph  (B)  Microsoft Table

(C) Microsoft Excel   (D)  Microsoft Word

172. In Microsoft PowerPoint  view  can be used

to enter speaker comments

(A) Normal (B) Slide show

(C) Slide sorter (D) Notes page view

173. In Microsoft PowerPoint  best way to insert a

new slide in a presentation is to use the
(A) Normal view
(B) Special view
(C) Slide show view
(D) Slide sorter view

174. In Microsoft PowerPoint the best view for
getting your thoughts for a presentation out
on the computer
(A) Outline view   (B) Notes page view
(C) Slide sorter view (D) Slide view

175. In Microsoft PowerPoint boxes that are
displayed to indicate that the text, pictures or
objects are placed in it is called
(A) Placeholder (B) Auto text
(C) Text box (D) Word art

176. In Microsoft PowerPoint the following is not
a feature of PowerPoint
(A) Printing transparencies
(B) Printing the speaker’s notes along with

slide images
(C) Linking a slide transition with a laser

pointer
(D) Drawing with a pen

177. In Microsoft PowerPoint the  option can be

used to create a new slide show with the

current slides but presented in a different

order

(A) Rehearsal

(B) Custom slider show

(C) Slide show setup

(D) Slide show view

178. In Microsoft PowerPoint the following are
actions you can assign to an action button
or slide object
(A) Run a macro (B) Play a sound
(C) Hyper link (D) All of above

179. Which option in PowerPoint allows to carry
slides from one computer to another?
(A) Save As (B) Save and Go
(C) Pack and Go (D) Web and Go

180. In Microsoft PowerPoint the handout master
contains placeholders fro all of the following
except
(A) Slide number (B) Title
(C) Footer (D) Header
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MICROSOFT ACCESS

1. In Access to open new database press
(A) CTRL+N (B) CTRL+O
(C) ALT+F4 (D) None of these

2. In Access to open an existing database
press
(A) CTRL+N (B) CTRL+O
(C) ALT+F4 (D) None of these

3. In Access, to Exit Office Access 2007Access
(A) CTRL+N (B) CTRL+O
(C) ALT+F4 (D) None of these

4. In Access press CTRL+N to
(A) Open a new database
(B) Open an existing database
(C) Exit Office Access 2007Access
(D) None of these

5. In Access press CTRL+O to
(A) Open a new database
(B) Open an existing database
(C) Exit Office Access 2007Access
(D) None of these

6. In Access press ALT+F4 to
(A) Open a new database
(B) Open an existing database
(C) Exit Office Access 2007Access
(D) None of these

7. Press the following keys in Access to  Print
the current or selected object
(A) CTRL+P (B) P or CTRL+P
(C) S (D) C or ESC

8. Press the following keys in Access to  Open
the Print dialog box from Print Preview
(A) CTRL+P (B) P or CTRL+P
(C) S (D) C or ESC

9. Press the following keys in Access to  Open
the Page Setup dialog box from Print Preview
(A) CTRL+P (B) P or CTRL+P
(C) S (D) C or ESC

10. Press the following keys in Access to  Cancel
Print Preview or Layout Preview
(A) CTRL+P (B) P or CTRL+P
(C) S (D) C or ESC

11. Press the following keys in Access to Save a
database object
(A) CTRL+P
(B) P or CTRL+P
(C) CTRL+S or SHIFT+F12
(D) F12

12. Press the following keys in Access to Open
the Save As dialog box
(A) CTRL+P
(B) P or CTRL+P
(C) CTRL+S or SHIFT+F12
(D) F12

13. In Access to Open a combo box
(A) F4 or ALT+DOWN ARROW
(B) DOWN ARROW
(C) PAGE DOWN
(D) F9

14. In Access to Refresh the contents of a
Lookup field (Lookup field: A field, used on a
form or report in an Access database, that
either displays a list of values retrieved from
a table or query, or stores a static set of
values.) list box or combo box
(A) F4 or ALT+DOWN ARROW
(B) DOWN ARROW
(C) PAGE DOWN
(D) F9

15. In Access to Move down one page
(A) F4 or ALT+DOWN ARROW
(B) DOWN ARROW
(C) PAGE DOWN
(D) F9

16. When using Access Database, use this
feature to have Access select only certain
records in the database to prepare form
letters.
(A) Report (B) Table
(C) Query (D) Tools

17. In Access to Move down one line
(A) F4 or ALT+DOWN ARROW
(B) DOWN ARROW
(C) PAGE DOWN
(D) F9
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18. In Access press…………………….to Move
the selected control to the left (except

controls that are part of a layout)
(A) CTRL+C (B) CTRL+X

(C) CTRL+V (D) None of these

19. In Access press …………………….to Move
the selected control to the right (except

controls that are part of a layout)
(A) CTRL+C (B) CTRL+X

(C) CTRL+V (D) None of these

20. In Access press …………………….to Paste

the contents of the Clipboard in the upper-
left corner of the selected section

(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

21. In Access press …………………….to Cut the
selected control and copy it to the Clipboard

(A) CTRL+C (B) CTRL+X
(C) CTRL+V (D) None of these

22. In Access press …………………….to Copy

the selected control to the Clipboard
(A) CTRL+C (B) CTRL+X

(C) CTRL+V (D) None of these

23. In Access press  RIGHT ARROW or

CTRL+RIGHT ARROW
(A) Move the selected control to the right

(except controls that are part of a layout)
(B) Move the selected control to the left

(except controls that are part of a layout)
(C) Move the selected control up

(D) None of these

24. In Access press  LEFT ARROW or

CTRL+LEFT ARROW
(A) Move the selected control to the right

(except controls that are part of a layout)
(B) Move the selected control to the left

(except controls that are part of a layout)
(C) Move the selected control up

(D) None of these

25. In Access press ALT+F11 to
(A) Display the Control menu

(B) Display the shortcut menu
(C) Close the active window

(D) None of these

26. In Access press ALT+F11 to

(A) Display the Control menu
(B) Display the shortcut menu

(C) Close the active window
(D) Switch between the Visual Basic Editor

and the previous active window

27. In Access press to Toggle the focus forward

between controls in the wizard

(A) TAB (B) ALT+N

(C) ALT+B (D) ALT+F

28. In access press to Move to the next page of

the wizard

(A) TAB (B) ALT+N

(C) ALT+B (D) ALT+F

29. In Access press  UP ARROW to

(A) Move up one line

(B) Move up one page

(C) Exit the combo box or list box

(D) None of these

30. In Access press  PAGE UP

(A) Move up one line

(B) Move up one page

(C) Exit the combo box or list box

(D) None of these

31. In Access press  TAB

(A) Move up one line

(B) Move up one page

(C) Exit the combo box or list box

(D) None of these

32. In Access to find the next occurrence of the

text specified in the Find and Replace dialog

box when the dialog box is closed

(Datasheet view and Form view only)

(A) CTRL+F (B) CTRL+H

(C) SHIFT+F4 (D) None of these

33. In Access to open the Find tab in the Find

and Replace dialog box (Datasheet view and

Form view only)

(A) CTRL+F (B) CTRL+H

(C) SHIFT+F4 (D) None of these

34. In Access to open the Replace tab in the Find

and Replace dialog box (Datasheet view and

Form view only)

(A) CTRL+F (B) CTRL+H

(C) SHIFT+F4 (D) None of these

35. In  Access to switch between Edit mode (with

insertion point displaye(D)

(A) F2 (B) F4

(C) F5 (D) F6

36. In  Access to switch to the property sheet

(Design view in forms and reports in both

Access databases and Access projects)

(A) F2 (B) F4

(C) F5 (D) F6
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37. In  Access to switch between the upper and
lower portions of a window (Design view of
queries, and the Advanced Filter/Sort
window)
(A) F2 (B) F4
(C) F5 (D) F6

38. In  Access to switch to Form view from form
Design view
(A) F2 (B) F4
(C) F5 (D) F6

39. In Access press to Cycle through the field
grid, field properties, Navigation Pane,
access keys in the Keyboard Access System,
Zoom controls, and the security bar (Design
view of tables)
(A) F6 (B) F7
(C) F8 (D) None of these

40. In Access press to Open the Choose Builder
dialog box (Design view window of forms
and reports)
(A) F6 (B) F7
(C) F8 (D) None of these

41. In Access press to Open the Visual Basic
Editor from a selected property in the property
sheet for a form or report
(A) F6 (B) F7
(C) F8 (D) None of these

42. In Access press to Switch from the Visual
Basic Editor back to form or report Design
view
(A) F6 (B) F7
(C) F8 (D) None of these

43. Switch from the Visual Basic Editor back to
form or report Design view in Access press
(A) ALT+F11
(B) SHIFT+F7
(C) A and B both are true
(D) None is true

44. In Access press to Move to the previous page
of the wizard
(A) TAB (B) ALT+N
(C) ALT+B (D) ALT+F

45. In Access press to Complete the wizard
(A) TAB (B) ALT+N
(C) ALT+B (D) ALT+F

46. In Access press  UP ARROW or CTRL+UP
ARROW
(A) Move the selected control to the right

(except controls that are part of a layout)
(B) Move the selected control to the left

(except controls that are part of a layout)
(C) Move the selected control up
(D) None of these

47. In  Access  press  DOWN ARROW or CTRL+
DOWN ARROW
(A) Move the selected control to the right

(except controls that are part of a layout)
(B) Move the selected control to the left

(except controls that are part of a layout)
(C) Move the selected control up
(D) None of these

48. In Access to Increase the height of the
selected control
(A) SHIFT+RIGHT ARROW
(B) SHIFT+DOWN ARROW
(C) DOWN ARROW or CTRL+DOWN

ARROW
(D) None of these

49. In Access press F11 to
(A) Toggle the Navigation Pane
(B) Cycle between open windows
(C) Restore the selected minimized window

when all windows are minimized
(D) Turn on Resize mode for the active

window when it is not maximized; press
the arrow keys to resize the window

50. In Access press CTRL+F6 to
(A) Toggle the Navigation Pane
(B) Cycle between open windows
(C) Restore the selected minimized window

when all windows are minimized
(D) Turn on Resize mode for the active

window when it is not maximized; press
the arrow keys to resize the window

51. In Access press ENTER to
(A) Toggle the Navigation Pane
(B) Cycle between open windows
(C) Restore the selected minimized window

when all windows are minimized
(D) Turn on Resize mode for the active

window when it is not maximized; press
the arrow keys to resize the window

52. In Access press CTRL+F8 to
(A) Toggle the Navigation Pane
(B) Cycle between open windows
(C) Restore the selected minimized window

when all windows are minimized
(D) Turn on Resize mode for the active

window when it is not maximized; press
the arrow keys to resize the window

53. In Access press ALT+SPACEBAR to
(A) Display the Control menu
(B) Display the shortcut menu
(C) Close the active window
(D) None of these
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54. In Access press SHIFT+F10 to
(A) Display the Control menu
(B) Display the shortcut menu
(C) Close the active window
(D) None of these

55. In Access press CTRL+W or CTRL+F4 to
(A) Display the Control menu
(B) Display the shortcut menu
(C) Close the active window
(D) None of these

56. In Access to reduce the height of the selected
control
(A) SHIFT+RIGHT ARROW
(B) SHIFT+DOWN ARROW
(C) DOWN ARROW or CTRL+DOWN

ARROW
(D) None of these

57. In Access  to  increase  the  width  of  the
selected control
(A) SHIFT+RIGHT ARROW
(B) SHIFT+DOWN ARROW
(C) DOWN ARROW or CTRL+DOWN

ARROW
(D) None of these

58. In Access to move the selected control down
(A) SHIFT+RIGHT ARROW
(B) SHIFT+DOWN ARROW
(C) DOWN ARROW or CTRL+DOWN

ARROW
(D) None of these

59. A-  Press DOWN ARROW or CTRL+DOWN
ARROW , B- Press SHIFT+LEFT ARROW: 1-
Move the selected control down, 2- Reduce
the width of the selected control.
(A) A-1, B-2 (B) A-2, B-2
(C) A-1, B-1 (D) A-2, B-1

60. According to Access Help, what’s a good way
to design a database?
(A) Start from data access pages and work

backward
(B) Sketch the design of your database

using a pencil and paper
(C) Use the Table Analyzer to reverse-

engineer your flat source data.
(D) None of above

61. Which editor was provided for use with
Access Basic?
(A) The Visual Basic 1.0 editor
(B) Notepad
(C) The QuickBasic editor
(D) All of above

62. You add a table to the query design window
(A) Select Edit>Add Table from the menu
(B) Select Tools>Add table from the menu
(C) Click the Show Table button on the

toolbar
(D) Select the table from the Table list on

the toolbar

63. Which of the following type s of queries are
action queries?
(A) Update queries.
(B) Crosstab Queries

(C) Parameter queries

(D) Append Queries

64. A query prompts a user for a data and then

displays only records that contain the

specified date. The  type of of query is this

(A) A parameter query

(B) A crosstab query

(C) An update query

(D) An action query

65. Which of the following is NOT a report

section?

(A) Report Header section

(B) Summary section

(C) Page header section

(D) Details section

66. You can display a database object in design

view by

(A) Opening the database object and

clicking the view button on the toolbar

(B) Selecting the database object and

clicking the design button on the

database window

(C) Selecting the database object and
press Ctrl + V

(D) Opening the database object and
selecting Tools>Design view

67. How can you display the relationship in a
database?
(A) Select View > Relationship form the

menu
(B) Click the Relationship button on the

toolbar
(C) Select Edit >Relationship from the menu
(D) All the above are true

68. If you are creating a cross tab query, what
must table you are querying contain?
(A) Lots of confusing information
(B) More than 100 records
(C) At least one field
(D) None of the above

yoursmahboob.wordpress.com
        (shared by Sujoy)



M.C.Qs. on Computer  |  59

69. A query summarizes information in a grid,
organized by regions and months. Which
type of query is this?
(A) A cross tab query
(B) An update query
(C) A parameter query
(D) An action query

70. What type of text box does the toolbox and to
a form?
(A) Unbound (B) Bound
(C) Rebound (D) Calculated

71. The filter by selection feature allows you to
filter
(A) Those records that match an entity in a

field
(B) Records  based  on  a  criterion  you

specify
(C) Records that meet any of several criteria

you specify
(D) All of above

72. What is the memo data type field used for?
(A) To add table
(B) To   store   objects   created   in  other

programs
(C) For long text entries
(D) For shout text entries of no more than

255 characters

73. What is the purpose of the description
column in Table Design View?
(A) To define the data type applied to each

field within the table
(B) To describe the data that should be

entered in each field
(C) To enter lookup data that the field should

refer to.
(D) None of the above

74. What is the propose to a sub datasheet?
(A) To provide a hierarchial view of related

tables or queries in a single window
(B) To display grouped data in a report
(C) To display summarized data.
(D) All of the above

75. Which  of  the  following  is  not  a  selection
technique ?
(A) To select a word, double click the word
(B) To select an entire table click the empty

bosx to the left of the field names
(C) To select a row, click the record selector

box to the left of the row
(D) To   select   a   column,   double  click

anywhere in the column

76. How can you display Pivot Table report
summary data in a currency format?
(A) Use custom calculation
(B) Type in the currency symbol
(C) Modify the field settings
(D) None of the above

77. What method can you use to add a new table
to your database?
(A) Use Design View to create a table
(B) Enter data directly by using a datasheet
(C) Both of above
(D) All of the above

78. Which action do you use in a a macro to
automatically send a report snapshot in an
email message?
(A) Use mail (B) Send object
(C) Run macro (D) All of the above

79. How can you display sales grouped by
country, region, and salesperson, all at the
same time?
(A) Use the Sort Descending command.
(B) Use the Pivot table view command
(C) Use the find command on specified

groups
(D) All of above

80. The checking operation performed on
input data is called the
(A) Validation of data
(B) Verification of data
(C) Cross check
(D) Control of data

81. A form defines
(A) Where data is placed on the screen
(B) The width of each field
(C) Both (A) and (B)
(D) All of the above

82. The following method  you can  use to add a
new table to your database
(A) Use Design View to create a table
(B) Enter data directly by using a datasheet
(C) Both of above
(D) All of the above

83. The following you can use in a macro to
automatically send a report snapshot in an
email message
(A) Use mail (B) Send object
(C) Run macro (D) All of the above

84. To display sales grouped by country, region,
and salesperson, all at the same time
(A) Use the Sort Descending command.
(B) Use the Pivot table view command
(C) Use the find command on specified

groups
(D) All of above

yoursmahboob.wordpress.com
        (shared by Sujoy)



60  |  M.C.Qs. on Computer

85. The   checking   operation   performed   on
input data is called the
(A) Validation of data  (B) Verification of data
(C) Cross check    (D) Control of data

86. A form defines
(A) Where data is placed on the screen
(B) The width of each field
(C) Both (A) and (B)
(D) All of the above

87. To  insert a graphic of your company’s logo
on a report
(A) Click the image button on the toolbox

and drag on the report to draw a place
holder for the graphics

(B) You can’t. Microsoft Access won’t let you
insert graphics files.

(C) Select Insert > Picture from the menu
(D) Select Tools > Insert Picture from the

menu

88. The Fill/Back Color button on the formatting
toolbar applies color to:
(A) The border fo the selected control
(B) The text in the selected control
(C) All aspects of the control
(D) The background of the selected control

89. The  type of query extract the data and put
them into separate table
(A) A parameter query
(B) A make-table query
(C) An update query
(D) A crosstab query

90. The following criterion is NOT written using
the proper syntax?
(A) “Haris” (B) <500
(C) NO VALUE
(D) Between #1/1/2000# and #12/31/2000#

91. (IF [Age]>65, “Senior”,”Adult”) This
expression is an example of:
(A) A conditional expression
(B) Algebraic expression
(C) Something that belongs in a Microsoft

Excel book
(D) A financial expression

92. The following property determines what is
displayed in a control.
(A) The control source property
(B) The display property
(C) The comes from property
(D) The data property

93. You view the properties of a form
(A) Select View>Form properties form the

menu
(B) Right click anywhere on the form and

select properties from the shortcut menu

(C) Double click the form selector box in the
upper left corner of the form

(D) All of the above

94. You can keep the sum([Sales]) to calculate
the totals for each month in
(A) the report footer section
(B) the page footer section
(C) the month group footer section
(D) the summary section

95. The procedure for selecting multiple controls
on a report?
(A) Hold down the Shift key as you click each

object that you want to select
(B) If the controls are aligned along a

horizontal or vertical line, click the
horizontal or vertical ruler above or to
the left of the controls

(C) Hold down the Ctrl key as you click each
object that you want to select

(D) All of these above are true

96. The following database object can you
import from one Microsoft Access database
to another?
(A) Queries (B) Tables
(C) Forms (D) All of the above

97. What field type is used to store picture in a
table?
(A) Memo (B) OLE
(C) Hyperlink (D) None

Answer Sheet

1. (A) 2. (B) 3. (C) 4. (A) 5. (B)
6. (C) 7. (A) 8. (B) 9. (C) 10. (D)

11. (C) 12. (D) 13. (A) 14. (D) 15. (C)
16. (C) 17. (B) 18. (D) 19. (D) 20. ()
21. (B) 22. (A) 23. (A) 24. (B) 25. (D)
26. (D) 27. (A) 28. (B) 29. (A) 30. (B)
31. (C) 32. (C) 33. (A) 34. (A) 35. (A)
36. (B) 37. (D) 38. (C) 39. (A) 40. (B)
41. (B) 42. (D) 43. (C) 44. (C) 45. (D)
46. (C) 47. (D) 48. (B) 49. (A) 50. (B)
51. (C) 52. (A) 53. (A) 54. (B) 55. (C)
56. (D) 57. (A) 58. (C) 59. (A) 60. (B)
61. (B) 62. (C) 63. (D) 64. (A) 65. (B)
66. (B) 67. (B) 68. (C) 69. (A) 70. (A)
71. (A) 72. (C) 73. (B) 74. (A) 75. (D)
76. (C) 77. (C) 78. (B) 79. (B) 80. (A)
81. (C) 82. (C) 83. (B) 84. (B) 85. (A)
86. (C) 87. (A) 88. (B) 89. (B) 90. (C)
91. (A) 92. (A) 93. (B) 94. (C) 95. (A)
96. (D) 97. (B)
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OPERATING SYSTEM

1. The main memory of the computer

(A) Controls the operations of computer.

(B) Performs data processing functions.

(C) Stores data and programs.

(D) None of these.

2. Program counter (P(C) contains

(A) Address of an instruction to be fetched

(B) Instructions most recently fetched

(C) Data to be written into memory

(D) Data to be read from memory

3. MAR (memory address register)

(A) Contains data to be written into memory.

(D) Contains data to be read from memory.

(C) Specifies location in memory for next

read/or writer.

(D) Contains address of next instruction to

be fetched.

4. IR (Instruction register)

(A) Contains the address of an instruction

to be fetched.

(B) Contains the instruction most recently

fetched

(C) Specifies memory addresses.

(D) None of these.

5. Which of the following is not an address

register?

(A) Index register (B) Segment pointer

(C) Stack pointer (D) Data register.

6. Following is not the state of Five-State

process model

(A) Ready (B) Running

(C) Not Running (D) New.

7. Memory table is used

(A) To allocate main memory to processes
(B) To allocate secondary memory to

processes
(C) To manage virtual memory
(D) A, B and C are true.

8. I/O tables are used
(A) To assign I/O devices of computer
(B) To manage I/O devices of computer

system
(C) A  and B both true
(D) A and B both false.

9. The operating system control tables
maintains file table, because
(A) These tables manage I/O devices and

channels of the computer system.
(B) These tables provide information about

the existence of files, their location on
secondary memory and their current
status.

(C) These tables provide information to
manage process.

(D) None of these.

10. Processor in computer
(A) Controls the operations of the computer/

processes data functions.
(B) Stores data and program.
(C) Moves data between computer and its

external environment.
(D) None of these.

11. Memory buffer register (MBR) contains
(A) Data that is to be written into memory
(B) A particular I/O device.
(C) Exchange data between I/O module and

the processor.
(D) The instruction most recently fetched.

12. I/O modules move data
(A) Between external environment and

computer.
(B) In the computer main memory.
(C) In Processors

(D) None of these.

13. I/O OBR (I/O Buffer register) is

(A) Used for the exchange of data between

an I/O module and the processor.

(B) Specifies particular I/O device.
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(C) (A) and (B) both true.

(D) (A) and (B) both false.

14. User-visible register

(A) Enables  machine  language
programmer to minimize main memory
reference by optimizing register use.

(B) Enables assembly language
programmer to minimize main memory
reference by optimizing register use.

(C) A and B  both true.
(D) A and B both false.

15. The operations of the processor are
supervised by
(A) Control and Status register
(B) Data register.
(C) Address register.

16. User-Visible register Which of the following
do not support GUI (Graphical User
Interface)
(A) DOS (B) WINDOWS
(C) Linux (D) None of these.

17. In the given operating system match the
correct

(i) Thread (ii) Process

(A) The unit of resource ownership.

(B) The unit of dispatching.

(A) (i) A and (ii) B (C) (i) B and (ii) A

(D) (i) A, B (E) (ii) A, B.

18. The MS-DOS an operating system supports

(A) Single user process and multiple

threads

(B) Multiple user process and single thread

(C) Single user process and single thread

(D) Multiple user processes and multiple

threads.

19. The UNIX, an operating system supports

(A) Multiple user processes and single

thread per process.

(B) Multiple user processes and multiple

threads per process.

(C) Single user process and single thread

per process.

(D) Single user process and multiple

threads per process.

20. The   Java   run   time   environment   is  an

example of

(A) Single user process with multiple

threads

(B) Multiple user processes with single
thread per process.

(C) Multiple user processes with multiple

threads per process.

(D) None of these.

21. The Windows 2000, operating system

supports

(A) Multiple user processes with single

thread per process.

(B) Multiple processes with multiple thread

per process.

(C) Single process with single thread.

(D) Single process with multiple threads.

22. In the pure User Level Threads (ULT)

(i) Thread management is done by

application,

(ii) Thread management is done by kernel,

(iii) Kernel is not aware of the existence of

thread,

(iv) Application program interface (API) to

the kernel thread facility.

(A) i, iii are true

(B) i, ii and iii are true

(C) All are false

(D) None of these are true

23. The Window 2000 (W2K) and Linux are the

example of

(A) User Level Thread (ULT)

(B) Kernel Level Thread (KLT)

(C) A  and B  both

(D) None of these.

24. The following is not an advantage of User

Level Threads (ULT).

(A) Thread switching does not requires

kernel mode privileges because all of

the thread management are within the

user address space of a single process.

(B) Here scheduling can be application

specific.

(C) ULT can be run an any operating system.

(D) When ULT executes a system call, not

only that thread blocked, but all of the

threads within the process are blocked.

25. The Linux operating system supports

(A) Single thread per process and single

process.

(B) Multiple thread per process and single

process.

(C) Single thread per process and multiple

processes.

(D) Multiple thread per process and multiple

processes.
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26. The Vector and array processors fall into
(A) Single Instruction Single Data (SIS(D)

stream
(B) Single Instruction Multiple Data (SIM(D)

stream.
(C) Multiple Instruction Single Data (MIS(D)

stream.
(D) Multiple Instruction Multiple Data

(MIM(D) system.

27. In cluster
(A) Computers communicate with each

other’s via fixed paths or via some
network facilities

(B) Computer communicates with each
other’s via a shared memory.

(C) Both (A) and (B)
(D) None of these.

28. The cluster is a case of
(A) Distributed memory
(B) Shared memory
(C) Master/slave architecture
(D) Symmetric multi processor.

29. The master/slave architecture is an example
of
(A) Distributed memory processing
(B) Shared memory processing
(C) Symmetric multi processing
(D) None of these.

30. I/O modules in computer
(A) Controls the operation of the computer.
(B) Stores data and program.
(C) Move data between the computer and

external environment.
(D) Provides communication among

processors and main memory.

31. Instruction register contains
(A) The address of an instruction to be

fetched.
(B) The instructions most recently fetched.
(C) The data to be written into memory.
(D) The data to be read from memory.

32. The following
(A) Start? Fetch next instruction?

Execute Instruction ? Halt, represents
(B) Instruction cycle with interrupt
(C) Instruction cycle without interrupt
(D) Instruction cycle with two interrupts
(E) None of these.

33. Instruction processing consists of
(A) Fetch cycle only
(B) Execution cycle only
(C) Fetch and Execution cycle both
(D) None of these.

34. Operating System is

(A) Software

(B) Hardware

(C) Software and Hardware both

(D) None of these.

35. The concept used to support multi

programming environment on a computer

is

(A) Virtual memory

(B) Hierarchy of physical memory

(C) Display of multiple windows

(D) None the above.

36. Which combination of the following features

will suffice to characterize an OS as a multi

programmed OS ?

(i) More than one program may be loaded
into main memory at the same time for
execution.

(ii) If a program waits for certain events such
as I/O, another program is immediately
scheduled for execution.

(iii) If the execution of a program terminates,
another program is immediately
scheduled for execution.

(A) (i) only (B) (ii) and (iii)
(C) (i) and (iii) (D) (i), (ii) and (iii).

37. Turnaround time is defined as
(A) Delay between job submission and job

completion
(B) A waiting time
(C) Both (A) and (B) above
(D) None of these

38. The only state transition initiated by the user
process itself in an operating system is
(A) Block (B) Timer run out
(C) Dispatch (D) Wake up

39. Window 98 is a
(A) Single user system
(B) Multi user system
(C) Single tasking system
(D) None of these.

40. OS/390 is a
(A) Single user system
(B) Multi user system
(C) Single tasking system
(D) None of these.

41. Thread is
(A) Dispatch able unit of work
(B) Can be interrupted
(C) A  and B  both true
(D) A and B  both false.
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42. Multithreading allows
(A) To run threads concurrently
(B) To run threads independently
(C) A is true, B  is false
(D) A and B both true.

43. For multithreading
(A) Tasks to be performed can be

independent
(B) Task to be performed is essentially

serialized.
(C) Tasks cannot be divided into number of

threads.
(D) None is true.

44. The principal function of a process is
(A) To execute machine instructions

residing in main memory.
(B) To execute assembly instructions

residing outside main memory.
(C) A and B both true.
(D) A and B both false.

45. The trace of the process is
(A) A set of instructions that execute process
(B) A listing of sequence of instructions that

execute  process
(C) A track of network
(D) None of these.

46. The two state process models have the
following states
(A) Running and Not Running
(B) Running and Ready
(C) Ready and Blocked
(D) New and Ready.

47. The process control blocks are referred for
(A) Process control
(B) I/O devices
(C) Memory allocation
(D) None of these.

48. Given three switch processes, when they
occur match them
(1) Clock Interrupt A- The processor

encounters a virtual
memory address
reference for a word
that is not in the main
memory.

(2) I/O Interrupt B- The operating
system determines
whether the currently
running process has
been executed for the
maximum allowable
time slice.

(3) Memory fault C- The operating
system determines
the I/O action that
occurs.

(A) 1-A, 2-B, 3-C (B) 1-B, 2-C, 3-A

(C)  1-B, 2-A, 3-C (D) 1-C, 2-B, 3-A.

49. With trap in process control

(A) Operating system determines the error

or exception condition that is fatal.

(B) Operating system interrupted for

maximum allowable time.

(C) Are tables that manage information

process

(D) None of these.

50. Process control block is also referred as

(A) Fast control block

(B) Process descriptor

(C) Task descriptor

(D) A, B, C are all true.

51. The operating system control tables

maintain process tables, because

(A) These tables manages I/O devices

(B) These tables manages files

(C) These tables manages memory

(D) None of these.

52. Windows XP is

(A) Uni-programming processes

(B) Multi programming processes

(C) Hardware

(D) None of these.

53. The OS/2 is the operating system that

support

(A) Single thread per process

(B) Multiple thread per process

(C) Single process

(D) None of these.

54. In shared memory multi processor

(A) Computer communicate to each other

by fixed paths

(B) Computer communicates to each other

via a shared memory.

(C) Each processing element is a self

contained computer.

(D) None of these.

55. The following is not true for master/slave
architecture
(A) A failure of master brings down the

whole system
(B) Operating system kernel runs on

master processor only.
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(C) Operating system kernel can run on any
processor either master or slave.

(D) All scheduling and process manage-
ment is done on master processor.

56. In monolithic operating system
(A) Virtually any procedure can call any

other procedure.
(B) Virtually specific procedure can call any

other procedure.
(C) Virtually specific procedure can call

specific procedure.
(D) None of these.

57. In Layered operating system following
statement is false
(A) Most or all the layers execute in kernel

mode.
(B) Interaction only takes place between

adjacent layers.
(C) Functions are organized hierarchically.
(D) None of these.

58. When operating system always run on a
particular processor and that particular
processor do all scheduling and process
management then this is an example of
(A) Master/slave architecture
(B) Symmetric multiprocessor
(C) Cluster
(D) None of these.

59. In micro kernel architecture following is false.
(A) Intersection takes place only between

adjacent layers.
(B) Intersection takes place via micro kernel.
(C) It supports portability.
(D) It supports object-oriented operating

system.
60. In the following processes: a = a + 1; b = 2 ×

b; b = b + 1; a = 2 × a;the output is.
(A) a > b (B) a < b
(C) a = b (D) None of these.

61. A Semaphore is initialized to
(A) Negative integer value
(B) Positive integer value
(C) Non-negative integer value
(D) Non-positive integer value.

62. The wait operation
(A) Decrements the semaphore value
(B) Increments the semaphore value
(C) Fixes the semaphore value
(D) None of these.

63. In semaphore, the process executing the wait
is blocked if
(A) The semaphore value becomes

negative
(B) The semaphore value become positive

(C) The semaphore value becomes non-
positive

(D) The semaphore value becomes non-
negative.

64. In semaphore when the order of processes
that are waiting to be removed from the queue
is first in first out (FIFO) then it is called
(A) Weak semaphore
(B) Strong semaphore
(C) Binary semaphore
(D) None of these.

65. In semaphore the process blocked by wait
operation is unblocked if
(A) Semaphore value becomes non-

negative
(B) Semaphore value becomes non-

positive
(C) Semaphore value is negative

(D) Semaphore value is positive.
66. The compaction is the technique in memory

management that is used to over come
(A) Internal fragmentation

(B) External fragmentation
(C) Both (A) and (B)

(D) None of these.
67. Physical address (absolute address) in

memory partitioning is
(A) Actual location in main memory

(B) A reference to memory location
independent of current assignment

(C) A logical address
(D) None of these.

68. The frame
(A) Can hold exactly  one page of data

(B) Can hold more than one page of data
(C) Can hole two page of data

(D) None of these.
69. The page table that is maintained by

operating system
(A) Shows frame location for each page of

the process
(B) Shows actual address in main memory
(C) Referrer memory location to memory
(D) None of these.

70. Match the following pairs
A. Logical address
(1) An actual location in main memory
B. Relative address
(2) An address is expressed as a location

relative to some known point.
C. Physical address
(3) A memory location independent of the

current assignment of data to memory
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(A) A – 3, B – 2, C–1
(B) A – 2, B – 1, C – 3
(C) A – 3, B – 1, C – 2
(D) A – 1, B – 2, C – 3

71. The resident set of process is
(A) A process that are actually in main

memory at anytime.
(B) A process that are actually in virtual

memory at any time.
(C) A process that are actually in disk.
(D) None of these.

72. Physical address in memory management
is
(A) Actual location in main memory
(B) Memory location independent of current

assignment of data to memory.
(C) Memory location dependent to some

known point.
(D) None of these.

73. Relative address in memory management
is
(A) Independent of some known point
(B) Dependent to some known point
(C) Actual location in the main memory
(D) None of these.

74. A Absolute loading B  Re-locatable loading
C Dynamic Run-Time loading; 1. For loader,
load module, either is an absolute main
memory address or specific address
reference. 2. For loader, load modules have
no absolute address. 3. For loader, load
modules have all memory reference in
relative form.
(A) A – 1, B – 2, C – 3
(B) A – 2, B – 3 , C – 1
(C) A – 1, B – 3, C – 2
(D) A – 3, B – 2, C – 1

75. For Load-time dynamic linking
(A) Load module (application module) to be

loaded is read into memory.
(B) Some of the linking is postponed until

execution time.
(C) External references to target modules

remain in the loaded program.
(D) None of these.

76. In thread scheduling, load sharing is referred
to
(A) Simultaneous scheduling of threads

that make up a single process.
(B) Implicit scheduling defined by the

assignment of threads to processors.

(C) A   global   queue   of   ready   thread   is

maintained and each processor, when

idle, selects a thread from queue.

(D) None of these.

77. The real time task

(A) The tasks that reacts to events that take

place in out side world.

(B) The tasks that do not reacts to the

outside world events.

(C) The tasks are independent of the time

when it occurs.

(D) None of these.

78. Hard real-time tasks are

(A) A real time task that do not require dead

line constraints.

(B) A real time task that requires dead line

constraints.

(C) A task independent to time when it

occurs.

(D) None of these.

79. The deterministic operating system

(A) Where operations are performed with

in pre-determined time interval.

(B) Where operations can be performed

with out pre-determined time interval.

(C) The operating time can not be

determined.

(D) None of these.

80. In Responsive real time operating system

(A) The interruption is acknowledge and

operating system response to interrupt.

(B) Once the operation starts no interrupt is

acknowledge.

(C) The operation completes in fixed inter

of time.

(D) None of these.

81. In multi processor scheduling; A: Gang

scheduling, B: Dynamic scheduling, C:

Dedicated processor management.; 1- The

number of threads in a process can be

altered during the course of execution. 2-

This provides implicit scheduling defined by

the assignment of threads to processors, 3-

It is applied to the simultaneous scheduling

of threads that make up a single process.

(A) A – 1, B – 2, C – 3

(B) A – 2, B – 1, C – 3

(C) A – 1, B – 3, C – 2

(D) A – 3, B – 1, C – 1
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82. In real time computing
(A) The result of computation does not

depend on the time at which computa-
tion is done.

(B) The result of computation also depends
on the time at which computation is
done.

(C) The results are independent of the time
considered.

(D) None of these.
83. In soft real time tasks

(A) The dead line is always mandatory.
(B) The dead line is desirable but not

mandatory.
(C) The results are independent of the time,

when it took place.
(D) None of these.

84. In real time scheduling: A:  Static table driven
approach, B:  Static priority driven preemptive
approach, C:  Dynamic planning based
approach; 1- A static analysis of feasible
scheduler of dispatching is done and
implemented. 2- A static analysis of feasible
schedules of dispatching is done and
assigns priorities to tasks. 3- Feasibility is
determined at run time.
(A) A – 1, B – 2, C – 3
(B) A – 2, B – 3, C – 1
(C) A – 3, B – 1, C – 2
(D) None of these.

85. Match the following I/O devices : A- Keyboard,
1- Human readable, B- Disk and tape drives,
2- Communication, C- Modems, 3-Machine
readable
(A) A – 1, B – 3, C – 2
(B) A – 1, B – 2, C – 3
(C) A – 3, B – 2, C – 1
(D) A – 2, B – 1, C – 3

86. Arrange the following I/O device in increasing
data rate Hard disk, Floppy disk, Key board
(A) Key board, Floppy disk, Hard disk
(B) Floppy disk, Key board, Hard disk
(C) Key board, Hard disk, Floppy disk
(D) Hard disk, Floppy disk, Key board.

87. In I/O management when buffering is
allowed then : Statement A: Input transfer is
performed before request is made.
Statement B: Output transfer is performed
after request is made. Statement A and B are
both true
(A) Statement A and B are both false
(B) Statement A is true but Statement B is

false

(C) Statement B is true but statement A is
false.

(D)
88. Resident set of process is

(A) Portion of a process that is actually in
main memory at any time.

(B) Portion of a process that is actually in
virtually memory at any time.

(C) A and b both true.
(D) None of these.

89. Main memory is referred as
(A) Virtual memory  (B) Real memory
(C) A and B both  (D) None of these.

90. Memory that is located on the disk either
Hard or floppy is referred as
(A) Virtual memory
(B) Real memory
(C) Main memory
(D) None of these.

91. The principle of locality states
(A) The program and data references within

a process tend to cluster.
(B) The program and data references within

a process do not tend to cluster.
(C) A process actually referred in virtual

memory.
(D) None of these.

92. In memory management : A- Fetch Policy B-
Cleaning Policy C- Placement Policy: 1- It
determines when a modified page should
be written out to secondary memory. 2- It
determines when a page should be bought
into main memory. 3- It determines where in
real memory a process piece is to be reside.
(A) A – 1, B – 2, C – 3
(B) A – 2, B – 1, C – 3
(C) A – 2, B – 1, C – 3
(D) A – 3, B – 1, C – 2

93. In memory management when demand
cleaning policy is applied
(A) A modified page is written before their

page frames are needed to so that
pages can be written out in batches.

(B) A page is written out to secondary
memory only when it has been selected
for replacement.

(C) A and B both true.
(D) None of these.

94. In two level scheme for page table, if one
assume byte-level addressing and 4-kbyte
(212 pages) then the 4-Gbyte (232) virtual
address space is composed of
(A) 210 pages (B) 220 pages
(C) 230 pages (D) 240 pages
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95. When pre cleaning policy is applied in
memory management
(A) A page is written out to secondary

memory only when it has been selected
for replacement.

(B) Modified pages are written before their
page frames are needed so that can be
written out in batches.

(C) A and B  both true.
(D) None of these.

96. In virtual memory management, when local
control policy is applied

(A) It determines the number of processes
that are to be resident in main memory.

(B) It determines the number of processes
that are to be resident in virtual memory.

(C) It determines when a modified page
should be written out to secondary
memory.

(D) None of these.

97. In two level scheme if each page is mapped
by 4-byte (22) page table entry then to create
a page table composed of 220 page table
entry one requires
(A) 222 bytes (B) 212 bytes
(C) 216 bytes (D) None of these.

98. In defining page table structure in virtual
memory, A page number portion of a virtual
address is mapped into a hash table using
simple hash function, where hash table
contains a pointer to the inverted page table,
which contains page table entries, this
approach is referred as
(A) One page table per process structure.
(B) Two level page table structure.
(C) Inverted page table structure.
(D) None of these.

99. A fetch policy for virtual memory determines
(A) When a page should be bought into

main memory.
(B) Where in real memory a process piece

is to be reside.
(C) The selection of a page in memory that

is to replaced.
(D) The page in memory that is not been

referenced for long time.

100. The demand paging and pre paging of virtual
memory management are
(A) Fetch policy for virtual memory

management.
(B) Placement policy for virtual memory

management.

(C) Replacement policy for virtual memory
management.

(D) None of these.
(i) A- Fetch, B-Demand paging, C-Pre-

paging; 1-Determines when a page
should be bought into main memory. 2-
A page is bought into main memory only
when a reference is made to a location
on that page. 3-Pages other than the
one demanded by a page fault are
bought in.

(E) A – 1, B – 2, C – 3
(F) A – 3, B – 2, C – 1
(G) A – 2, B – 3, C – 1
(H) A – 3, B – 1, C – 2

101. When process is swapped out of main
memory and put in a suspended state
(A) All of its resident pages are moved out.
(B) All of the pages that were previously in

main memory are returned to main
memory.

(C) Pages other than the one demanded by
a page fault are bought in main memory.

(D) None of these.

102. Statement A: The placement policy
determines where in real memory a process
piece is to reside. Statement B: The fetch
policy determines when a page should be
bought into main memory.
(A) A and B both true
(B) A and B both false
(C) A is true, B is false
(D) A is false, B is true

103. When a frame in main memory is locked
(A) The page currently stored in that frame

can be replaced.
(B) The page currently stored in that frame

cannot be replaced.
(C) Pages currently in frame can be

removed in round-robin style.
(D) None of these.

104. Statement A : In memory management, the
replacement policy deals with the selection
of pages in memory to be replaced by arrived
new page. Statement B: In memory
management, the policy the fetch policy
determines when a page should be bought
into main memory.
(A) A and B both false
(B) A and B both true
(C) A is true, B is false
(D) A is false, B is true
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105. The Least Recently Used (LRU) policy
(A) Replaces the page in memory that has

not been referenced for the least time.
(B) Replaces the page in memory that has

not been referenced for the longest
time.

(C) Replaces the page in memory in round
robin fashion.

(D) None of these.

106. In memory management where replacement
is allowed in First-in-First-out (FIFO) fashion
(A) The page frames are allocated to a

process as circular buffer and pages
are removed in random order.

(B) The page frames are allocated to a
process as circular buffer and pages
are removed in round-robin order.

(C) Replaces the pages that are least
referred.

(D) Replaces the pages that are most
referred.

107. By principle of locality, in least recently used
policy, in memory management
(A) The page replaced in memory is least

likely to be referenced in the near future.
(B) The page replaced in memory is most

likely to be referenced in the near future.
(C) The pages replaced in memory in

round-robin fashion.
(D) None of these.

108. In First-In-First-out (FIFO) replacement policy
used in memory management, the page
frames to allocated to a process as circular
buffer and
(A) The most recent page is removed at first
(B) The most recent page is removed at the

last
(C) The most recent page is removed any

time
(D) None of these

109. The memory management, y one clock policy
is applied then the page first loaded into a
frame in memory its use bit is set to
(A) Zero (B) One
(C) Two (D) Three

110. In memory management Free page list is:
A- A list of page frames available for reading
in pages. B- A list where replaced page is
assigned without modification. C-A list where
replaced page is assigned with modification.
(A) A, B, C are true (B) A and B are true
(C) A and C are true (D) B and C are true.

111. A policy in memory management referred as
clock policy because one can visualize the
page frames as laid out in
(A) Straight line (B) Rectangle
(C) Circle (D) Square

112. In memory management :A-Fixed allocation
policy, B-Variable allocation policy: 1-It gives
a process a fixed number of frames in main
memory within which to execute. 2-It allows
the number of page frames allocated to a
process to be varied over the life time of the
process. 3-In it a number of allocated frames
are decided at initial load time.
(A) A – 1, 3, B – 2  (B) A – 1, B – 3
(C) A – 2, B – 1, 3  (D) A – 1, 2, B – 3

113. In uni-processor scheduling :A : Turnaround
time, B : Response time, 1: A time interval
between the submission of a process and
its completion. 2: For interactive process, it
is a time from the submission of a request
until the response begins to received. 3: It
includes actual execution time plus time
spent waiting for resources.
(A) A – 2, 2, B – 3  (B) A – 1, 3, B – 2
(C) A – 2, B – 1, 2  (D) A – 2, B – 1, 3

114. In uni-processor management processor
through put
(A) Is a measure of how much work is being

performed
(B) Is the percentage of time that the

processor is busy
(C) Is a time interval between the

submission of a process and its
completion

(D) None of these

115. In uni-processor scheduling, a priorities
enforcement is
(A) When processes are assigned priorities

and scheduling policy favor higher
priority processes.

(B) The scheduling keeps resources of
system busy.

(C) Here currently running process can be
interrupted and moved to ready state by
the operating system.

(D) None of these.

116. In     uni-processor     scheduling,   if   non-
preemptive policy is applied then
(A) Once a process is in running state, it

continues to execute until it terminates
or block itself.

(B) Currently running process can be
interrupted and moved to ready state by
the operating system.
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(C) The clock interrupt is generated at
periodic intervals.

(D) None of these.

117. In aperiodic (real time) tasks
(A) The dead line for start is mandatory, but

for finish it is not.
(B) The dead line for finish is mandatory,

but for start it is not.
(C) The dead line for finish and start is

mandatory.
(D) The dead line for finish and start is not

mandatory.

118. The time table of railway, and airline which
defines arrival and departure can be
considered as
(A) Hard real time scheduling
(B) Soft real time scheduling
(C) None real time scheduling.
(D) None of these.

119. When preemptive policy is applied to uni-
processor scheduling then
(A) Once a process is in running state, it

continues to execute until it terminates
or block itself.

(B) Currently running process can be
interrupted and moved to ready state by
the operating system.

(C) The processes are assigned priorities.
(D) None of these.

120. The normalized turnaround time is
(A) Ratio of turnaround time to service time
(B) Ratio of turnaround time to waiting time
(C) Ratio of service time to waiting time
(D) Ratio of waiting time to service time.

121. In uni-processor scheduling, shortest
process next policy is
(i) A: Non-preemptive policy
(ii) B: Preemptive policy
(iii) C: A policy where the process with

shortest expected processing time is
selected next.

(iv) D: A policy where the process with
shortest expected processing time is
not selected.

(B) A and D are true (C) B and C are true
(D) A and C are true (e) B and D are true.

122. In uni-processor scheduling, shortest
remaining time policy is
(A) A policy where scheduler chooses the

process that has the shortest expected
remaining processing time.

(B) A policy where scheduler discards the
process that has the shortest expected
remaining process time.

(C) A policy where process with shortest

expected processing time is selected

next.

(D) None of these.

123. In round robin (time slicing) policy applied

on uni-processor scheduling

(A) When interrupt occurs, the currently

running process is placed in ready

queue, and next ready job is selected in

First come First serve basis.

(B) When interrupt occurs, the currently

running process is placed in ready

queue and next ready job is selected in

random order.

(C) No interruption is entertained.

(D) None of these.

124. If normalized turnaround time of different

process are given. Then Highest

response ratio next policy in uni-

processor scheduling policy selects.

(A) The ready process with lowest

normalized turnaround time.

(B) The ready process with highest

normalized turnaround time.

(C) The process with shortest expected

processing time.

(D) The process with highest expected

processing time.

125. In multi processor scheduling, independent

parallelism indicates

(A) There is synchronization among

processes at gross level.

(B) There is no explicit synchronization

among processes.

(C) A parallel processing or multi tasking is

done within a single application.

(D) None of these.

126. In multi processor scheduling : A: Course

gained parallelism, B: Medium grained

parallelism, C: Fine grained parallelism; 1-

Concurrent processes running on a multi

programmed uni- processor. 2- Parallel

processing or multi tasking is done within a

single application. 3- Parallel processing is

done within a single instruction stream.

(A) A – 1, B – 2, C – 3

(B) A – 2, B – 3, C – 1

(C) A – 3, B – 2, C – 1

(D) A – 1, B – 3, C – 2
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127. In round robin (time slicing) policy applied

on uni processor scheduling

(A) When interrupt occurs, the currently

running process is placed in ready

queue, and next ready job is selected in

First come First serve basis.

(B) When interrupt occurs, the currently

running process is placed in ready

queue and next ready job is selected in

random order.

(C) No interruption is entertained.

(D) None of these.

128. If normalized turnaround time of different

process are given. Then Highest response

ratio next policy in uni processor scheduling

policy selects

(A) The ready process with lowest

normalized turnaround time.

(B) The ready process with highest

normalized turnaround time.

(C) The process with shortest expected

processing time.

(D) The process with highest expected

processing time.

129. In multi processor scheduling, independent

parallelism indicates

(A) There is synchronization among

processes at gross level.

(B) There is no explicit synchronization

among processes.

(C) A parallel processing or multi tasking is

done within a single application.

(D) None of these.

130. In multi processor scheduling; A: Coarse

gained parallelism, B: Medium grained

parallelism, C: Fine grained parallelism; 1-

Concurrent processes running on a multi

programmed uni processor, 2 Parallel

processing or multi tasking is done within a

single application, 3-Parallel processing is

done within a single instruction stream.

(A) A – 1, B – 2, C – 3

(B) A – 2, B – 3, C – 1

(C) A – 3, B – 2, C – 1

(D) A – 1, B – 3, C – 2

131. A situation where two or more processes

coordinate their activities based on a

condition is referred as

(A) Synchronization (B) Dead lock

(C) Starvation (D) Par begin

132. Par begin (P1)
(A) Suspends main program, execute

procedure P1 and after execution
resume main program.

(B) Procedure P1 is delayed infinitely due
to other procedure are given preference.

(C) Procedure P1 is not considered for
execution.

(D) None of these.

133. The mail box and ports are examples of
(A) Indirect process communication
(B) Direct process communication.
(C) Both A and B true
(D) None is true

134. In Dynamic partition of main memory in
memory management, the sized of process
and memory partition is
(A) of exactly same size
(B) of different size.
(C) Both A and B true
(D) None is true

135. In   the   simple   paging   in   memory
management where
(A) Process can be loaded into a partition

of equal or greater size.
(B) Process is loaded into a partition of

exactly same size.
(C) Process is divided into a number of

equal size pages of same length as of
frames.

(D) None of these.

136.  A.   Absolute Loading B. Relocatable Loading
C. Dynamic Run-Time Loading;  1- It requires
that a load module always be loaded into
some location in main memory. 2- A load
module can be located anywhere in main
memory.
(A) A – 2, B – 1, C – 1
(B) A – 1, B – 1, C – 2
(C) A – 1, B – 2, C – 2
(D) A – 1, B – 2, C – 1

137. The disk and tape devices are referred as
(A) Block oriented I/O devices
(B) Stream oriented I/O devices
(C) Logical I/O devices
(D) None of these

138. Which of the following is not human readable
I/O device ?
(A) Video display terminals
(B) Key board
(C) Printers
(D) Disk drives
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139. Following is not the stream oriented I/O
device
(A) Printer
(B) Mouse
(C) Communication modules
(D) Disk/tape

140. The direct memory access (DM(A) module
(A) Controls the data exchange between

main memory and I/O module.
(B) The processor issues I/O command,

execute subsequent instructions and
interrupt I/O module.

(C) The processor issues I/O commands
to an I/O module.

(D) None of these.

141. In disk scheduling, the seek time is
(A) The time taken to position the head at

the track.
(B) The time taken to reach the beginning

of sector once the track is selected.
(C) A and B both.
(D) None of these.

142. The access time in disk scheduling is
(A) The time taken to position the head at

the track.
(B) The time taken to reach the beginning

of the sector of the track.
(C) The sum of seek time and rotational

delay.
(D) None of these.

143. The transfer time in disk scheduling is
(A) Proportional to rotation speed.
(B) Inversely proportional to rotation speed.
(C) Equal to rotation speed.
(D) None of these.

144. In last- in-first- out, disk scheduling policy
(A) Recently received request is entertained

at the last.
(B) Recently received request is entertained

first.
(C) Requests are selected at random
(D) None of these.

145. In disk scheduling, SCAN algorithm states
(A) The arm is required to move in one

direction only.
(B) The arm can be moved in any direction.
(C) The arm is fixed.
(D) None of these.

146. RAID (Redundant Array of Independent
Disks) scheme consists of
(A) Five levels from one to six.
(B) Six levels, from zero to five.

(C) Seven levels, from zero to six.

(D) None of these.

147. In RAID scheme, which of the RAID level does
not use parity calculation in redundancy
achievement
(A) RAID 4 (B) RAID 3
(C) RAID 2 (D) RAID 1

148. In system buffer cache, used in UNIX,
following not true
(A) It is a disk cache
(B) It is not a disk cache
(C) Data transfer between buffer cache and

user process space always occurs
using DMA.

(D) I/O operations with disk are handled
through buffer code.

149. In disk scheduling, the shortest service time
first policy selects the disk request that
(A) In cure the maximum seek time
(B) In cure the minimum seek time
(C) Is received first
(D) Is received at last.

150. The C–SCAN, in disk scheduling states
(A) The arm movement is uni directional
(B) The arm movement is bidirectional
(C) The are is to be state fixed
(D) None of these.

151. RAID-O does not support the following
characteristics: A: RAID is a set of physical
disk drives viewed by the operating system
as a single logical drive. B: Data distributed
across the physical drives of an array. C: Re-
demdant disk capacity is used to store parity
information, which guarantees data
recoverability in case of a disk failure.
(A) A and B (B) A only
(C) B only (D) C only

252. The UNIX scheduling gives
(A) Highest preference to real time

processes
(B) Highest preference to kernel mode

processes
(C) Highest preference to user mode

processes
(D) Highest preference to shared

processes.

153. In disk scheduling when SCAN (Look) policy
is applied and when last track reached
in one direction

(A) The service direction is reversed and
scan proceeds in opposite direction.

(B) The arm returns to the opposite end of
the disk and scan begins again.

(C) A and B both true.
(D) None of these.
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154. In RAID (Redundant Array of Independent
Disks) scheme, which of the following RAID
level does not include redundancy to improve
performance ?
(A) RAID level 0 (B) RAID level 1
(C) RAID level 2 (D) RAID level 4

155. In which of the following RAID scheme,
redundancy is achieved by the simple
expedient of duplicating all the data ?
(A) RAID level 0 (B) RAID level 1
(C) RAID level 2 (D) RAID level 3

156. In shortest service time first policy, applied
on disk scheduling, the disk request is
selected
(A) That requires the least movement of disk

arm from its current position.
(B) That requires the maximum movement

of disk arm from its current position.
(C) That is recently received.
(D) On random.

157. The RAID (Redundant Array of Independent
Disks) level one requires
(A) Same disk space of the logical disk that

it support.
(B) Twice disk space of the logical disk that

it support.
(C) Thrice disk space of the logical disk that

it support.
(D) Half disk space of the logical disk that it

support.

158. Match the following in RAID scheme : A-
Parallel access array, B-Independent
access array, 1- All member disks participate
in the execution of every I/O request. 2- Each
member disk participates separately in the
execution of every I/O request. 3- Here
spindles of the individual drives are
synchronized so that each disk head is in
the same position on each disk at any given
time.
(A) A – 1, 3 and B – 2
(B) A – 1, and B – 2, 3
(C) A – 2 and B – 1, 3
(D) A – 1, 2 and B – 3

159. The following RAID level employer parallel
access technique and single redundant disk
(A) RAID level 0 (B) RAID level 1
(C) RAID level 2 (D) RAID level 3

160. The RAID scheme indicate
(A) Random access of information data.
(B) Random array of independent disks.
(C) Redundant array of independent disks.
(D) Redundant access of information data.

161. Which of the RAID level does not employ

independent access technique ?

(A)  RAID 6 (B)  RAID 5

(C)  RAID 4 (D)  RAID 3

162. Which  of   the   following   RAID   level   uses

independent     access    technique   and

distributes the parity strips across all disks?

(A) Two (B) Three

(C) Four (D) Five

163. Cache memory is

(A) Bigger and slower than main memory

(B) Bigger and faster that main memory

(C) Smaller and slower than main memory

(D) Smaller and faster than main memory

164. By principle of locality, cache memory

(A) Increases average memory access

time.

(B) Reduces average memory access time

(C) Does not affect the average memory

access time

(D) None of these

165. Following is not true for disk cache

(A) It is a buffer in main memory for disk

sector

(B) It contains the copy of some of the sector

on the disk

(C) It is bigger is size than main memory

(D) It is smaller is size than main memory

166. In disk storage devices, data are recorded

on and later retrieved from disk via a

conducting coil named

(A) Tail (B) Foot

(C) Head (D) Hand.

167. In disk storage devices during read and write

operation

(A) Head is rotate while platter is stationary

(B) Head is stationary while platter rotates

(C) Head and platter are both stationary

(D) None is true

168. In magnetic disk, density that is in bits per

linear inch

(A) Increases in moving from the outer most

track to the inner most track.

(B) Decreases in moving from the outer

most track to the inner most track.

(C) Remains same in moving from the outer

most track to the inner most track.

(D) Randomly distributed in moving from the

outer most track to the inner most track.
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169. Data from and to magnetic disk is

transformed in
(A) Continuation
(B) Blocks
(C) Block and Continuation both
(D) None of these.

170. On magnetic disks, the data on the platter is
organized in a concentric sets of rings called
(A) Sectors (B) Gaps
(C) Rings (D) Tracks

171. In disk storage devices the width of head is:
(A) Same of the track
(B) More than of the track
(C) Less than of the track
(D) None is true.

172. In a fixed head disk, the number of read/write
head per track are
(A) One (B) Two
(C) Three (D) Four.

173. CD defines
(A) Computer device
(B) Computer disk
(C) Compact disk
(D) None of these

174. A-Fixed-Head disk, B-Movable-Head disk, 1-
One head per track and al head are mounted
on rigid arm that extends across all tracks.
2- Only one head and head is mounted on
the arm, such that it can position the track.
(A) A – 1, B – 2 (B) A – 2, B – 1
(C) A – 1, B – 1 (D) A – 2, B – 2

175. The record is the collection of
(A) Fields (B) Files
(C) Data base (D) None of these.

176. In File system architecture which is the
correct arrangement from lower level to
higher.
(A) Device drives, basic file system, basic I/

O supervisor, logical I/O.
(B) Basic file system, basic I/O, logical I/O,

device drives.
(C) Basic I/O, basic file system, logical I/O,

device drives.
(D) None of these.

177. In file management system the following
communicate directly with periphing I/O
devices.
(A) Device drives
(B) Basic file system
(C) Basic I/O supervisor
(D) Logical I/O.

178. For file management, in file operations
device drivers are
(A) Disk drivers (B) Tape drivers
(C) A and B both (D) None of these.

179. In file management, the primary interface of
computer system with external environment
is done through
(A) Device drivers
(B) Basic file system
(C) Basic I/O supervisor
(D) Logical I/O.

180. In file management, users and applications
access records via
(A)  Physical I/O     (B)  Basic I/O supervisor
(C)  Logical I/O      (D) None of these.

181. Match the following for file system
architecture : A-Basic file system, B-Logical
I/O module, 1- Deals with blocks of data, 2-
Deals with file records, 3- Provides general
purpose record I/O capacity.
(A) A – 1, B – 2, 3 (B) A – 1, 2, B – 3
(C) A – 2, 3, B – 1 (D) A – 1, 3, B – 2

182. Match the following access rights :A-Specific
user, B-User group, C-All ; 1- Individual user
who are designated by user I, 2-A set of users
who are individually defined, 3-Every user
has access to the system.
(A) A – 1, B – 2, C – 3
(B) A – 2, B – 1, C – 3
(C) A – 1, B – 3, C – 2
(D) A – 3, B – 2, C – 1

183. In file management, the pile
(A) The collection of data in order which they

arrive.
(B) A fixed format used for records.
(C) Records keep with some key sequence.
(D) None of these.

184. In file management, in the following record
blocking method, the optional use of space
is made, without unused space left
(A) Fixed blocking
(B) Variable-length spanned blocking
(C) Variable-length un-spanned blocking
(D) None of these.

185. In secondary storage management, “If
allocation of file is made on an individual
block basis and each block contains a
pointer to the next block in the chain” then it
is referred as
(A) Contiguous allocation
(B) Chained allocation
(C) Indexed allocation
(D) None of these.
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186. In secondary storage management, bit table,

for each block on disk a vector contains

(A) One bit each block

(B) Two bit each block

(C) Three bit each block

(D) Four bit each block.

187. In bit table used for Free space management

in secondary storage

(A) Bit zero corresponds to free block

(B) Bit one corresponds to free block

(C) Bit zero corresponds to block in use

(D) None of these

188. The amount of memory (in bytes) required

for a block bitmap is

(A)  Disk size × 8

(B)  Disk size/ (8 × file system block size)

(C)  File system block size/disk size

(D)  None of these.

189. In 16 G byte disk with 512-bit block, the bit

table requires

(A) 1 M bytes (B) 2 M bytes

(C) 3 M bytes (D) 4 M bytes.

190. Application Programming Interface is

(A) A set of function and call programs that

allows clients and servers to

intercommunicate.

(B) A database, where information access

is limited to the selection of rows that

satisfy all search criteria.

(C) A computer usually a high powered work

station.

(D) None of these.

191. If in a computer networking environment

when all the processing is done on single

computer can be referred as

(A) Host based processing

(B) Server based processing

(C) Client based processing

(D) None of these.

192. In three tier client/server architecture

application software match the following: A-

User machine, 1-Client, B- Middle-tier, 2-

Application server, C- Backend server, 3 Data

servers.

(A) A – 1, B – 2, C – 3

(B) A – 1, B – 3, C – 2

(C) A – 2, B – 1, C – 3

(D) A – 3, B – 2, C – 1

193. UNIX was developed by
(A) Bell Labs for PDP-7 in 1970
(B) Microsoft for IBM computers
(C) Macintosh
(D) None of these.

194. UNIX is a
(A) Operating system
(B) Hardware
(C) Programming language
(D) None of these.

195. In UNIX process management, the system
process runs in
(A) Kernel mode only
(B) Kernel and user mode both
(C) User mode only
(D) None of these.

196. In UNIX process management, the user
processes runs in
(A) Kernel mode only
(B) Kernel and user mode both
(C) User mode only
(D) None of these.

197. In UNIX process management, the following
is true
(A) User process enters kernel mode by

issuing a system call when interrupt
occurs.

(B) Kernel mode is executed in user
process.

(C) User process enters kernel mode with
out issuing a system call when interrupt
occurs.

(D) None of these.

198. The number of process states recognized
by UNIX
(A) Two (B) Nine
(C) Eight (D) Seven.

199. In process management of UNIX system,
which of the following process states are
running states in respect of whether the
process is executing in user or kernel mode
(A) Ready to run (in memory) state
(B) Ready to run (in swappe(D) state
(C) Preempted state
(D) A and C are true

200. A task in a blocked state is
(A) Executable
(B) Waiting for some temporarily unavailable

resource
(C) Running
(D) None of these
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201. Semaphores
(A) are used to do I/O
(B) Synchronize critical resources to prevent

contention
(C) synchronize critical resources to prevent

deadlock.
(D) allow processes to communicate with

one another.

202. Priorities
(A) are used to schedule processes
(B) increase as a process remains in the

processor
(C) are attached to each page in the system
(D) are assigned by the user.

203. Dijkstra’s    banker’s    algorithm    in   an
operating-system  solves the problem of
(A) deadlock avoidance
(B) deadlock recovery
(C) mutual exclusion
(D) context switching

204. Which structure prohibits the sharing of files
and directories
(A) tree structure
(B) one level structure
(C) two level structure
(D) none of these

205. With round-robin CPU scheduling in a time
shared system
(A) using very large time slices

degenerates into First-Come  First
Served Algorithm

(B) using extremely small time slices
improves performance

(C) using very small time slices degenerate
into Last-In-First-Out algorithm

(D) using medium sized time slices leades
to Shortest Request Time First
algorithm.

206. The portion of the process scheduler in an
operating system that dispatches
processes is concerned with
(A) activating suspended I/O-bound

processes
(B) temporarily suspending processes

when CPU load is too great
(C) assigning ready processes to the CPU
(D) all of the above

207. Following is  the correct definition of a valid
process transition within an operating
system
(A) wake up : ready – running
(B) dispatch: ready – running
(C) block: ready – blocked
(D) timer run out : ready – blocked

208. I/O redirection
(A) implies changing the name of a file
(B) can be employed to use an exiting file

as input file for a program

(C) implies connection to programs through

a pipe

(D) none of the above

209. When an interrupt occurs, an operating

system

(A) ignores the interrupt

(B) always changes state of interrupted

process after processing the interrupt

(C) always resumes execution of interrupted

process after processing the interrupt

(D) may change state of interrupted process

to blocked and schedule another

process

210. Thrashing

(A) reduces page I/O

(B) decreases the degree of multi-

programming

(C) implies excessive page I/O

(D) improve the system performance

211.  Dirty bit for a page in a page table

(A) helps avoid unnecessary writes on a

paging device

(B) helps maintain LRU information

(C) allows only read on a page

(D) none of the above

212. A set of resources allocations such that the

system can allocate resources to each

process is some order, and still avoid a dead

lock is called

(A) unsafe state (B) safe state

(C) Starvation (D) Greedy allocation

213. A disk scheduling algorithm in an operating

system causes the disk arm to seek back

and forth access the disc surface servicing

all request in its path, this is a

(A) first come first served

(B) shortest seek time first

(C) scan

(D) None of these

214. An attached processor

(A) is used one only a few computers

(B) causes all processor to function equally

(C) is more difficult to implement than a co-

processor

(D) is used only for limited, specific

functions
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215. Process is
(A) a program in high level language kept

on disk
(B) contents of main memory
(C) a program in execution
(D) a job in secondary memory

216. Situations where two or more processes are
reading or writing some shared data and
the final result depends on who runs
precisely which are called
(A) race condition
(B) critical sections
(C) mutual exclusions
(D) message passing

217. Producer consumer problem can be solved
using
(A) Semaphores (B) Event counters
(C) Monitors (D) All of the above

218. The strategy of allowing process that are
logically run able to be temporarily
suspended is called
(A) preemptive scheduling
(B) non preemptive scheduling
(C) shortest job first
(D) first come first served

219. Moving process from main memory to disk
is called
(A) Scheduling (B) Cache
(C) Swapping (D) Spooling

220. Banker’s algorithm for resource allocation
deals with
(A) deadlock prevention
(B) deadlock avoidance
(C) deadlock recovery
(D) mutual exclusion

221. The dispatcher
(A) actually schedules the tasks into the

processor
(B) is always very small and simple
(C) puts tasks in wait
(D) None of these

222. A set or resource allocations such that the
system can allocate resources to each
process in some order, and still avoids a
deadlock is called
(A) unsafe state (B) safe state
(C) starvation (D) greedy allocation

223. Processor-bound tasks
(A) use the processor more often
(B) use more processor time
(C) use less processor time
(D) always take longer to execute

224. The    following    resources    can   cause
deadlocks
(A) Read only files (B) Shared programs
(C) Printers (D) All of the above

225. Complex scheduling algorithms
(A) use more resources than they gain
(B) recover more resources than they use
(C) always use many resources
(D) are most appropriate for very large

computers

226. The intensive jobs
(A) use less processor time than most jobs
(B) you are constrained by their I/O

requirements
(C) run more quickly than processor-

intensive jobs
(D) should all be executed at the same time

227. The FIFO algorithm
(A) executes first the job that last entered

the queue
(B) executes first the job that first entered

the queue
(C) executes first the job with the least

processor needs
(D) executes first the job that has been in

the queue the longest

228. Check pointing a job
(A)  allows it to be completed successfully
(B)  allows it to continue executing later
(C)  prepares it for finishing
(D)  occurs only when there is an error in it

229. Windows is an
(A) operating system
(B) operating environment
(C) user interface
(D) programming platform

230. Following is/are  operating system used in
computers
(A) MS-DOS (B) OS/2
(C) UNIX (D) All of the above

231. The following operating system writes
through catches?
(A) UNIX (B) DOS
(C) ULTRIX (D) XENIX

232. Which is/are the most important features of
Microsoft windows program?
(A) Windows (B) Pull-down menus
(C) Icons (D) All of the above

233. Multiprocessing models have
(A) symmetric multiprocessing model
(B) asymmetric multiprocessing model
(C) both (A) and (B) above
(D) None of  these
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234. Real-time systems are
(A) primarily used on mainframe computers
(B) used for monitoring events as they occur
(C) used for program development
(D) used for real-time interactive users.

235. Multiprogramming systems
(A) are   easier   to   develop   than   single

programming systems
(B) execute each job faster
(C) execute more jobs in the same time

period
(D) are used only one large mainframe

computers

236.  Virtual memory is
(A) simple to implement
(B) used on all major commercial operating

systems
(C) less efficient in utilization of memory
(D) useful when fast I/O devices are not

available

237. Memory management is
(A) not used in modern operating systems
(B) replaced with virtual memory on current

systems
(C) not used on multiprogramming systems
(D) critical for even the simplest operating

systems

238. Scheduling is
(A) allowing job to use the processor
(B) making proper use of processor
(C) Both A and B
(D) None of these

239. Following is true for  Multiprocessing
(A) It makes the operating system simpler
(B) It allows multiple processes to run

simultaneously
(C) It allows the same computer to have

multiple processors
(D) None of these

240. A monitor program is a program that
(A) interprets the interrupt calls
(B) restores the status of the CPU after a

function call
(C) interprets the input from a keyboard and

converts the input into its binary
equivalent

(D) checks the status of the I/O devices

241. The process scheduler in the processor
management unit
(A) gives all jobs to the job scheduler
(B) selects a job to run
(C) selects a process to run
(D) co-ordinates the process synchronization

242. Round robin is a
(A) kind of magnetic drum
(B) process scheduling policy
(C) process synchronization policy
(D) memory allocation policy

243. Which is the correct definition of a valid
process transition in an operating system?
(A) Wake up: ready ? running
(B) Dispatch: ready? running
(C) Block: ready ? running
(D) Timer runout : ready ? blocked

244. A critical section is a program segment
(A) which should run in a certain specified

amount of time
(B) which avoids deadlocks
(C) where shared resources are accessed
(D) which must be enclosed by a pair of

semaphore operations.

245. Which of the following is an example of a
spooled device?
(A) A line printer used to print the output of a

number of jobs
(B) A terminal used to enter input data to a

running program
(C) A secondary storage device in a virtual

memory system
(D) A graphic display device

246. A solution to the Dining Philosophers
Problem which avoids deadlock is
(A) ensure that all philosophers pick up the

left fork before the right fork.
(B) ensure that all philosophers pick up the

right fork before the left fork.
(C) ensure that one particular philosopher

picks up the left fork before the right fork,
and all other philosophers pick up the
right fork before the left fork.

(D) none of the above

247. Locality of reference implies that the page
reference being made by a process
(A) will always be to the page used in the

previous page reference
(B) is likely to be to one of the pages used

in the last few page references
(C) will always be to one of the pages

existing in memory
(D) will always lead to a page fault

248. The correct matching for the following pairs
is - (A) Disk sucheduling, (1) Round robin,
(B) Batch processing, (2) SCAN ,(C) Time
sharing, (3) LIFO, (D) Interrupt processing,
(4) FIFO,
(A) A-2, B-4, C-1,  D-3
(B) A-1, B-2, C-3,  D-4
(C) A-2, B-1, C-4,  D-3
(D) None of these
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249. Shared sub-directories and files are
example of
(A) cyclic graph directory
(B) tree structured direction
(C) one level directory
(D) none of these

250. The lowest level of I/O control consists of
(A) device drivers
(B) interrupt handlers
(C) both A and B above
(D) none of the above

251. Which type of design problem in file system
(A) how the file system should look to the

user
(B) algorithm and data structure must be

created to map the logical file system
onto the secondary storage device

(C) Both A and B above
(D) none of the above

252. Of the following which is the methods for
allocating disks
(A) Contiguous (B) Linked
(C) Indexed (D) All of the above

253. External fragmentation solved by which
allocation?
(A) contiguous allocation
(B) linked allocation
(C) index allocation
(D) both B and C

254. Which O/I are best method for allocating?
(A) Contiguous (B) Linked
(C) Index (D) All of the above

255. Allocate the first hole that is big enough is
called
(A) first fit (B) best fit
(C) worst fit (D) all of the above

256. Allocate the smallest hole that. is big enough
is called
(A) first fit (B) best fit
(C) worst fit (D) all of the above

257. The most efficient data set organization is
(A) a sequential file
(B) an ISAM file
(C) variable depending upon the usage of

the data set
(D) a partitioned data set

258. A partitioned data set is most used for
(A) storing program data
(B) storing ISAM files
(C) a program or source library

(D) storing backup information

259. Fragmentation of the file system

(A) can always be prevented

(B) occurs only if the file system is used

improperly

(C) can be temporarily removed by

compaction

(D) is a characteristic of all file systems

260. File record length

(A) should always be fixed

(B) should always be variable

(C) depends upon the size of the file

(D) should be chosen to match the data

character

261. Disaster recovery

(A) is needed by every installation

(B) is never needed

(C) varies in degree between installations

(D) requires off-site computer for immediate

use

262. Wild-card specifies

(A) provide an easy way of finding groups

of related files

(B) are only used when printing the contents

of files

(C) can be used when writing a file

(D) allow several files to be read

simultaneously

263. The allocation map

(A) is used to store program data

(B) specifies which blocks are used by

which file

(C) is updated by applications programs

(D) allows programs to erase files

264. The activity of a file
(A) is a low percentage of number of

records that are added to or deleted
from a file

(B) is a measure of the percentage of
existing records updated during a run

(C) refers to how closely the files fit into the

allocated space

(D) is a measure of the number of records

added or deleted from a file compassed

with the original number of records

265. The volatility of a file refers to

(A) The number of records added or deleted

from a file composed to the original

number of records in that file

(B) Efficiency with which non-sequential

files are processed
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(C) The extent where the records of the file

are contiguous and in proximity to others

(D) Percentage of records that has changed

in a given time period

266. Which types of file organization are

supported by magnetic tape?

(A) random files

(B) contiguous sequential file

(C) indexed sequential file

(D) all of the above

267. Address Binding is defined as

(A) Compiler will typically bind these
symbolic addresses to relocatable
addressees

(B) Each binding is a mapping from one
address space to another

(C) The linkage editor or loader win in turn
bind these relocatable addresses to
absolute addresses

(D) All of the above

268.  Compile time
(A) where the process will reside in

memory, then absolute code can be
generated

(B) where the process will reside in
memory, then the compiler must
generate relocatable code

(C) if the process can be moved during its
execution from one memory segment
to another,the binding must be delayed
until run time

(D) all of the above

269. Load time
(A) where the process will reside in

memory, then absolute code can be
generated

(B) where the process will reside in
memory, then the compiler must
generate relocatable memory

(C) if the process can be moved during its
execution from one memory segment
to another, then binding must be
delayed until run time

(D) all of the above

270. Execution time
(A) where the process will reside in

memory, then absolute code can be
generated

(B) where the process will reside in
memory, then the compiler must
generate relocatable code

(C) if the process can be moved during its
execution from one memory segment
to another

(D) all of the above

271. In dynamic loading
(A) for better memory utilization use

dynamic loading
(B) it does not requires special support

from the operating system
(C) disadvantage is unused routine is never

loaded
(D) all of the above

272. Fragmentation of the file system
(A) occurs only if the file system is used

improperly
(B) can always be prevented
(C) can be temporarily removed by

compaction
(D) is the characteristic of all files system

273.  Stub
(A) is included in the image for each library

routine reference
(B) is small piece of code that indicates how

to locate the appropriate memory
resident library routine

(C) how to load the library if the routine is
not already present

(D) all of the above

274. Local replacement
(A) allows a process to select a replacement

frame from the set of all frames
(B) requires that each process selects from

only its own set of allocated frames
(C) both (A) and (B) above
(D) none of the above

275. Thrashing
(A) the high paging activity
(B) is spending more time in paging than

executing
(C) both A and B above
(D) none of the above

276. Thrashing can be avoided if
(A) the pages, belonging to the working set

of the programs are in main memory
(B) the speed of CPU is increased
(C) the speed of I/O processor is increased
(D) all of the above

277. The memory allocation scheme subject to
external fragmentation is
(A) segmentation
(B) swapping
(C) pure demand paging
(D) multiple contiguous fixed partitions
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278. In virtual memory systems, dynamic address
translation
(A) is the hardware necessary to implement

paging
(B) stores pages at a specific location on disk
(C) is useless when swapping is used
(D) is the part of the operating system

paging algorithm

279. Relocatable programs
(A) cannot be used with fixed partitions
(B) can be loaded almost anywhere in

memory
(C) do not need a linker
(D) can be loaded only at one specific

location

280. Fixed partitions
(A) are very common in current operating

systems
(B) are very efficient in memory utilization
(C) are very inefficient in memory utilization
(D) are most used on large mainframe

operating systems

281. Virtual system swapping
(A) allocates all of memory to one program
(B) pages working set pages in and out as

a group
(C) is never as efficient as normal paging
(D) is used only on systems that are

thrashing

282. The term paging refers to
(A) boosting up the priority of a process in

multilevel of queues without feedback
(B) gradually increasing the priority of jobs

that wait in the system for a long time to
remedy infinite blocking

(C) keeping track of the time a page has
been in memory for the purpose of LRU
replacement

(D) letting job reside in memory for a certain
amount of time, so that the number of
pages required can be estimated
accurately

283. With a segmentation, if there are 64
segments, and the maximum segment size
is 512 words, the length of the logical
address in bits is
(A) 12 (B) 14
(C) 15 (D) 16

284. High paging rate
(A) may cause high I/O rate
(B) keeps the systems running well
(C) is a symptom of too much processor

activity
(D) always creates a slow system

285. The total time to prepare a disk drive

mechanism for a block of data to be read

from it is

(A) seek time

(B) Latency

(C) latency plus seek time

(D) transmission time

286. Following illustrates Associative Memory

(A) The address of the data is supplied by

the user

(B) Same as the tracks associated with disk

memory

(C) No need for  address;  information  is

used as address

(D) Data is accessed serially

287. A disk scheduling algorithm in an operating

system causes the disk arm to seek back

and forth across the disk surface servicing

all requests in its path, based on

(A) First Come First Served

(B) Shortest Seek Time First

(C) Sean

(D) None of these

288. Access to moving head disks requires three

periods of delay before information is

brought into memory. The response that

correctly lists the three time delays for the

physical access of data in the order of the

relative speed from the slowest to the fastest

is

(A) latency time, cache overhead time, seek

time

(B) transmission time, latency time, seek

time

(C) seek time, latency time, transmission

time

(D) cache overhead time, latency time, seek

time

289. An unpaged cache associates disk domains

with the address of the read and continues

for a specific length. The major disadvantage

of unpaged cache is that

(A) it allows cache domain to contain

redundant data

(B) it does not allow writes to be cached

(C) its access time is greater than that of

paged caching

(D) read ahead cache domain blocks are

necessarily fixed in size
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290. UNIX recognizes following I/O devices
(A) Disk and Tape drives
(B) Terminals
(C) Communication lines
(D) All the above.

Answer Sheet

1. (C) 2. (A) 3. (C) 4. (B) 5. (D)
6. (C) 7. (D) 8. (C) 9. (B) 10. (A)

11. (A) 12. (A) 13. (A) 14. (C) 15. (A)
16. (A) 17. (C) 18. (C) 19. (C) 20. (A)
21. (B) 22. (A) 23. (B) 24. (D) 25. (D)
26. (B) 27. (A) 28. (A) 29. (B) 30. (C)
31. (B) 32. (C) 33. (C) 34. (A) 35. (C)
36. (D) 37. (A) 38. (A) 39. (A) 40. (B)
41. (C) 42. (D) 43. (A) 44. (A) 45. (B)
46. (A) 47. (A) 48. (B) 49. (A) 50. (D)
51. (D) 52. (B) 53. (B) 54. (B) 55. (C)
56. (A) 57. (D) 58. (A) 59. (A) 60. (D)
61. (C) 62. (A) 63. (A) 64. (B) 65. (B)
66. (B) 67. (A) 68. (A) 69. (A) 70. (A)
71. (A) 72. (A) 73. (B) 74. (A) 75. (A)
76. (C) 77. (A) 78. (B) 79. (A) 80. (A)
81. (D) 82. (B) 83. (B) 84. (A) 85. (A)
86. (A) 87. (D) 88. (A) 89. (B) 90. (A)
91. (A) 92. (C) 93. (B) 94. (B) 95. (B)
96. (A) 97. (A) 98. (C) 99. (A) 100. (A)

101. (A) 102. (A) 103. (B) 104. (B) 105. (B)
106. (B) 107. (A) 108. (B) 109. (B) 110. (B)
111. (C) 112. (A) 113. (B) 114. (A) 115. (A)
116. (A) 117. (C) 118. (A) 119. (B) 120. (A)
121. (D) 122. (A) 123. (A) 124. (B) 125. (B)

126. (A) 127. (A) 128. (B) 129. (B) 130. (A)
131. (A) 132. (A) 133. (A) 134. (A) 135. (C)
136. (C) 137. (A) 138. (D) 139. (D) 140. (A)
141. (A) 142. (C) 143. (A) 144. (B) 145. (A)
146. (C) 147. (D) 148. (B) 149. (B) 150. (C)
151. (D) 152. (A) 153. (A) 154. (A) 155. (B)
156. (A) 157. (B) 158. (A) 159. (D) 160. (D)
161. (D) 162. (D) 163. (D) 164. (B) 165. (C)
166. (C) 167. (B) 168. (A) 169. (B) 170. (D)
171. (A) 172. (A) 173. (C) 174. (A) 175. (A)
176. (A) 177. (A) 178. (C) 179. (B) 180. (C)
181. (A) 182. (A) 183. (A) 184. (B) 185. (B)
186. (A) 187. (A) 188. (B) 189. (D) 190. (A)
191. (A) 192. (A) 193. (A) 194. (A) 195. (A)
196. (B) 197. (A) 198. (B) 199. (D) 200. (B)
201. (C) 202. (A) 203. (A) 204. (D) 205. (A)
206. (C) 207. (B) 208. (B) 209. (D) 210. (C)
211. (A) 212. (B) 213. (C) 214. (D) 215. (C)
216. (A) 217. (D) 218. (A) 219. (C) 220. (B)
221. (A) 222. (B) 223. (B) 224. (C) 225. (D)
226. (B) 227. (B) 228. (B) 229. (C) 230. (D)
231. (B) 232. (D) 233. (C) 234. (B) 235. (C)
236. (C) 237. (B) 238. (C) 239. (C) 240. (C)
241. (C) 242. (B) 243. (B) 244. (C) 245. (A)
246. (C) 247. (B) 248. (A) 249. (A) 250. (C)
251. (C) 252. (B) 253. (D) 254. (B) 255. (A)
256. (B) 257. (C) 258. (C) 259. (C) 260. (C)
261. (C) 262. (A) 263. (B) 264. (A) 265. (A)
266. (B) 267. (D) 268. (A) 269. (B) 270. (C)
271. (D) 272. (C) 273. (D) 274. (B) 275. (C)
276. (A) 277. (A) 278. (A) 279. (B) 280. (C)
281. (D) 282. (B) 283. (C) 284. (A) 285. (C)
286. (C) 287. (C) 288. (C) 289. (A) 290. (D)
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SOFTWARE ENGINEERING
1. Computer system is a

(A) Hardware (B) Software
(C) Bioware (D) Virtual ware

2. Object model is a
(A) Rule (B) Process guidance
(C) System model (D) Entity

3. Software engineering is an engineering
discipline concerned with
(A) Software development
(B) Software production
(C) Software implementation
(D) All the above

4. A workflow model represents
(A) Sequence of activities
(B) Role of users involved
(C) Set of activities
(D) None of these

5. Sensor component
(A) Causes changes in system

environment
(B) Communicate with other components
(C) Collects information from system

environment
(D) Coordinate the operation of other

components.

6. Which is the correct order ?
(A) System development ? system

installation ? system operation
(B) System installation ? system operation?

system development
(C) System decomposition? system

installation ? system design
(D) None of these.

7. Sensor component is a
(A) Functional component
(B) Non-functional component
(C) Reliability component
(D) None of these

8. Which one is not the non-functional activity ?
(A) Reliability (B) Performance
(C) Coordination (D) Maintainability

9. Sub system is

(A) Dependent system

(B) Independent system

(C) Component

(D) None of these

10. System architecture model identifies

(A) Hardware components

(B) Software components

(C) Virtual components and software

components

(D) Hardware and software components

both

11. Which one is functional component ?

(A) Reliability (B) Maintainability

(C) Computation (D) Performance

12. A class room in a school is a

(A) System (B) Sub-system

(C) Module (D) None of these

13. Floating point process is a

(A) Communication component

(B) Computation component

(C) Coordination component

(D) Sensor component

14. Digital-analog converter that converter digital

input into analog output is a

(A) Communication component

(B) Computation component

(C) Sensor component

(D) Interface component

15. In software system requirements, the

functional requirement for the system

describes

(A) Services the system is expected to

provide

(B) Factors of system development

(C) Reliability, response time or system

capacity

(D) None of these
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16. In   software   system    requirements,  the
interface requirements are
(A) Requirements that are derived from the

interface of existing system
(B) Requirements that are derived from the

interface of proposed system
(C) Requirements that are derived from the

interface of existing and proposed
systems

(D) None of these

17. Validation plan describes
(A) Quality procedure
(B) Schedule procedure
(C) Management procedure
(D) None of these

18. Software requirement specification is
(A) The official statement of what is required

of the system developers
(B) The non official statement of system

interface
(C) Non specified format of system working
(D) None of these

19. What is Ethnography
(A) A graphic tool
(B) Observational technique used to

understand social and organizational
requirements

(C) A graph with nodes
(D) None of these

20. In Data Processing model
(A) Here data-flow diagram show, how data

is processed at different stages in the
system. These are behavioral models

(B) It registers all/ selected activities of a
computer system.

(C) Technique used to transform raw data
into a more useful form.

(D) Data is shifted to modern data base
management system.

21. In Data recording
(A) Here data-flow diagram show, how data

is processed at different stages in the
system.

(B) It registers all/ selected activities of a
computer system.

(C) Technique used to transform raw data
into a more useful form.

(D) Data is shifted to modern data base
management system.

22. Thermo couple in furnace is a
(A) Communication component
(B) Computation component
(C) Sensor component
(D) Interface component

23. In block diagrams, relationship between
components is shown by
(A) Boxes (B) Ovals
(C) Circular (D) Lines/Arrows

24. Cities, states and country can be defined as
(A) Subsystem – Cities, states: System –

country
(B) Subsystem – state :System– country,

cities
(C) Subsystem – Country: System– cities,

state
(D) Subsystem– Country, state: System–

Cities

25. Which of the following is correct system
design process ?
(A) Identify system requirement – define

system – develop system
(B) Define system – develop system –

identify system
(C) Identify system – develop system –

operate system
(D) None of these

26. Making different sub-system to work together
is
(A) System definition
(B) System operation
(C) System integration
(D) System decomposition

27. System procurement process involves
(A) Specifying system requirement
(B) Choosing suppliers
(C) A  and B  both
(D) None of these

28. System decommissioning normally takes
place
(A) At the beginning of the development

process
(B) At the middle of the development

process
(C) After the end of useful operational time
(D) At the beginning of the useful

operational time

29. System operation takes place after
(A) System specification
(B) System design
(C) System installation
(D) System decomposition

30. Software processes are
(A) Activities involved in producing software

system
(B) Activities involved in selling software

systems
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(C) Activities involved in system design
(D) Activities involved in managing systems

31. Iterative model includes

(A) Waterfall model

(B) Sequential model

(C) Incremental development

(D) Random model

32. In iterative process model, software process

represents

(A) Sequential activities

(B) Cycle of activities

(C) Random activities

(D) None of these

33. In spiral development the software process

form

(A) Sequences (B) Loops

(C) Zigzag (D) None of these

34. Spiral development involves

(A) Risk assessment

(B) Reduction of risk

(C) A and B  both

(D) None of these

35. Requirement Engineering involves

(A) Feasibility studies

(B) Requirement analysis

(C) Requirement validation

(D) All the above

36. Analysis and design workbench

(A) It supports system modeling during the

analysis and design stages of the

software process

(B) Organization responsible for approving

U.S. standards

(C) Stimuli that occurs irregularly

(D) Formalized set of software calls and

routines that can be referenced by an

application program in order to access

supporting system or network services

37. ANSI (American National Standards Institute)

is

(A) It supports system modeling during the

analysis and design stages of the

software process

(B) Organization responsible for approving
U.S. standards

(C) Stimuli that occurs irregularly
(D) Formalized set of software calls and

routines that can be referenced by an
application program in order to access
supporting system or network services

38. Aperiodic stimuli is
(A) It supports system modeling during the

analysis and design stages of the
software process

(B) Organization responsible for approving
U.S. standards

(C) Stimuli that occurs irregularly
(D) Formalized set of software calls and

routines that can be referenced by an
application program in order to access
supporting system or network services

39. Which is not the part of software process ?
(A) Software specification
(B) Software design
(C) Software evolution
(D) Software selling

40. Which one is not the generic process model ?
(A) Waterfall model
(B) Evolutionary development
(C) Re-use oriented development
(D) Marketing model

41. Spiral model is
(A) Iterative model
(B) Non-iterative model
(C) Random model
(D) None of these

42. Software design activities involved
(A) System programming
(B) System operations
(C) Component design
(D) Component development

43. Software implementation converts system
specifications into
(A) Development system
(B) System decomposition
(C) Executable system
(D) None of these

44. Which one is not be structured design model ?
(A) Data flow model
(B) Entity relation model
(C) Object-oriented model
(D) Debugging

45. Software process models are
(A) Abstract representation of software

process
(B) Software running the systems
(C) Software managing the systems
(D) Software implementation

46. Debugging is a process of
(A) Developing faults
(B) Removing faults
(C) Ignoring faults
(D) None of these
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47. Software validation is
(A) Checking system conformations to its

specifications
(B) Developing system conformations to its

specifications
(C) Operating system
(D) None of these

48. Unit testing process is
(A) Software designing process
(B) Software operating process
(C) Software validation process
(D) Software decomposition process

49. CASE environment supports
(A) Individual process tasks
(B) Individual process phases
(C) Most process tasks and process

phases
(D) None of these

50. CASE work benches support
(A) Individual process tasks
(B) Process phases and activities
(C) Development software
(D) Operation software

51. Error location and repair is
(A) System modeling process
(B) System design process
(C) System verification process
(D) System decomposition process

52. Quality plan describes
(A) Quality procedure and standards
(B) Approaches, resources and schedules

(C) Configuration      management      and

structure

(D) None of these

53. Which one is not true for risk analysis ?

(A) It estimate risks  (B)  It removes risks

(C) It reduces risks   (D)  It develops risks

54. Project schedule can be illustrated in

(A) Bar-charts (B) Activity-networks

(C) Figures (D) None of these

55. Change in technology is a

(A) Technology risk

(B) People risk

(C) Tool risk

(D) Implementation risk

56. Under estimate of cost is

(A) Technology risk

(B) People risk

(C) Estimation risk
(D) Organizational risk

57. Maintenance plan describes
(A) Quality procedure
(B) Schedule procedure
(C) Maintenance procedure
(D) Configuration procedure

58. Failure of schedule is
(A) People risk
(B) Organizational risk
(C) Estimation risk
(D) Requirement risk

59. Risk planning involves
(A) Avoidance strategies
(B) Minimization strategies
(C) Contingency plan
(D) All the above

60. Which is not the part of scheduling process?
(A) Creating project chart
(B) Defining roles/activities
(C) Estimating failures
(D) Selling product

61. Use of Email instead of post & telegraph is
due to
(A) Technology changes
(B) Requirement changes
(C) Users access
(D) All the above

62. Using P-IV instead of P-I is due to
(A) Requirement change
(B) Faster access
(C) Technology improvement
(D) All the above

63. The term user requirements
(A) Are statements, made in natural

language and diagrams of services that
system is expected to provide and the
constrains on the system

(B) The system services and details, can
serve as contract between buyer and
software developers

(C) An  abstract  description  of  software
design

(D) None of these

64. Software design specification
(A) Are   statements,   made   in   natural

language  to  specify   the   system
specification and constraints

(B) An abstract description of software
design, which is an extension of system
requirement specification

(C) Discusses   the   market   policy   of  the
system

(D) None of these
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65. Software consists of
(A) Computer program only
(B) Computer   program   and   associated

documentations
(C) Documentation only
(D) Hardware

66. Software engineering deals with
(A) Software development
(B) Hardware development
(C) System development
(D) Network development

67. System engineering deals with
(A) Software development only
(B) Hardware development only
(C) Software and Hardware development
(D) Network development

68. Work flow model includes
(A) Inputs  (B) Out puts
(C) Dependencies (D) All the above

69. Rules are
(A) Constraints define for system models
(B) Input data
(C) Out put data
(D) Activities in involved in the system

70. Hardware represents
(A) Documentations
(B) Programs
(C) Computer systems
(D) Rules

71. The system failure due to power failure is
considered under
(A) Hardware reliability
(B) Software reliability
(C) Operation reliability
(D) None of these

72. Components such as wheel, chain, handle
etc are assembled to produce bicycle. The
use of bicycle as transportation device is
considered to be
(A) Functional property
(B) Non-functional property
(C) Software system
(D) None of these

73. A computer program is a
(A) Software (B) Hardware
(C) System (D) None of these

74. Software system consists of
(A) Programs
(B) Configuration files
(C) Documentation
(D) All of the above

75. User documentation defines
(A) Computer program
(B) Computer system
(C) Use of computer systems
(D) Structure of computer system

76. System documentation defines
(A) Computer programs
(B) Computer systems
(C) Use of computer systems
(D) Structure of computer system

77. System engineering is concerned with
(A) Hardware development
(B) System development
(C) Software engineering
(D) All of the above

78. Software process involves
(A) Software specification and

developments
(B) Software validation and evolution
(C) A  and B both
(D) None of these

79. Mutable requirements are
(A) Requirements that change due to the

environment in which the organization
is operating

(B) Emerges due to user’s understanding
of system

(C) Dependent on particular system
(D) None of these

80. Requirement Engineering process does not
involves
(A)  Feasibility study
(B) Requirement elicitation and an analysis
(C) Requirement validation and

management
(D) Data processing

81. User requirements are written in
(A) Natural language
(B) FORTRAN
(C) Assembly language
(D) None of these

82. The system modeling is normally referred
to
(A) An abstract viewing of a system
(B) The system running
(C) Programming language
(D) None of these

83. In system modeling : A-Complementary
system model : B-Context model: C-
Composition model

(1) Here entity-relation (E-R) diagram show how
entities in the system are composed of other
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entities.2-Shows how the system being

modeled is positioned, in an environment

with other systems and process. 3-Present

different information about the system.

(A) A-1, B-2, C-3 (B) A-3, B-2, C-1

(C) A-2, B-3, C-1 (D) A-2, B-1, C-3

84. Operability is

(A) Extent to which a system or component

complies with standards

(B) Trustworthiness of operating the

software.

(C) Measures that estimates system cost

to operate and maintain.

(D) None of these

85. In system modeling: A-Architectural model:

B-Stimulus-response model: C-Behavioral

models::1-Used to describe the overall

behavior of the system: 2-State transition

diagram show how the system reacts to

internal and external events:3-Shows

principal sub-systems which makes the

system

(A) A-1, B-2, C-3 (B) A-2, B-3, C-1

(C) A-3, B-2, C-1 (D) C-2, B-1, A-3

86. In system modeling : A-Classification model;

B-Stimulus-response model; C-Data

processing model: 1-Here data-flow diagram

show how data is processed at different

stages; 2-Here object class/inheritance

diagram show, how entities have the

common characteristics;3-Here state

transition diagram shows the how the

system reader to internal and external events

(A) A-2, B-3, C-1 (B) A-3, B-1, C-2

(C) A-1, B-2, C-3 (D) A-1, B-3, C-2

87. In system modeling

Statement-1: State-machine model is used

to model the behavior of a system in

response to internal and external events.

Statement-2: Stimulus response model

represents state transition diagram that

show how system reacts to internal and

external events.

(A) Statement-1 and 2 both correct

(B) Statement-1 and 2 both false

(C) Statement-1 is true and Statement-2 is

false

(D) Statement-1 is false and Statement-2 is

true

88. Taxonomy is
(A) Classification scheme, which shows

who object class is related to other
class through common attributes and
services

(B) Standard modeling language, used for
object oriented modeling

(C) Set of tools to support software process
(D) None of these

89. In system modeling : A-Model;B-Prototype;;1-

it’s an abstract view of a system that ignores

system details; 2-It’s an initial version of

system software which givers end-users a

concrete   impression   of   the  system

capacities

(A) A-1, B-2 (B) A-1, B-1

(C) B-1, A-2 (D) A-2, B-2

90. Sub-systems in a system are

(A) Independent systems that compro-

mises the system

(B) Dependent systems that compromises

the system

(C) A and B both true

(D) None of these

91. The following is not true for client-server

model

(A) It contains the set of stand alone servers

(B) A set of clients that can use services

offered by servers

(C) A network which allows the clients to

access these services

(D) An intersection between clients by

passing the server

92. Computer Aided Software Engineering

(CASE) is

(A) Extent to which all the parts of a software

system or component are present and

each of its parts is fully specified and

developed.

(B) Testing of individual hardware/software

components

(C) An Entity-relation (E-R) diagram show

how entities in the system are

composed of other entities

(D) It consists of wide range of different

types of computer programs, which be

used to support software process

activities such as a requirement

analysis, system modeling, debugging

and testing.
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93. A control model, where one system is
designed as the system controller and has
responsibility for managing the execution of
other sub-systems can be referred as
(A) Centralized control model
(B) Call-return control model
(C) Object oriented model
(D) None of these

94. A sequential control model where control
starts at the top of a subroutine hierarchy
and through sub-routine calls, passes to
lower levels is referred as
(A) Manager control model
(B) Call-return control model
(C) Object oriented model
(D) None of these

95. A control model where one system
component is designed as system manager
which controls the starting, stopping and
coordination other system processes can
be referred as
(A) Manager control model
(B) Object oriented model
(C) Event driven control model
(D) None of these

96. When is a system where each sub-system
can respond to generated event are referred
as ?
(A) Event driven control system
(B) Object oriented model
(C) Manager control model
(D) None of these

97. An event driven control system, when an
event is transmitted to each sub-system and
each sub-system that handles that event
responds to it is referred as
(A) Broadcast model
(B) Manager control model
(C) Call-return control model
(D) None of these

98. Embedded system
(A) Run on single processor
(B) Run on integrated group of process

linked by network
(C) Network models
(D) None of these

99. If all the application processing and data
management is carried out on the server and
client is only responsible for running the
system then this is referred as
(A) Client-server model
(B) Thin client server model
(C) Thick client server model
(D) None of these

100. If the server is only responsible for data

management and software on the client

implements the application logic, then one

can referrer this model as

(A) Client server model

(B) Fat client server model

(C) Thin client server model

(D) None of these

101. In system models, object is

(A) An entity that has a state and defined

set of operations that operates on that

state

(B) Software program

(C) Programming language, that develops

any given program

(D) None of these

102. When the state of object changes by internal

operations, executing within the object it self,

then these objects are referred as

(A) Active object (B) Inactive object

(C) Silent object (D) None of these

103. The objects that are realized on call as

parallel process with method corresponding

to defined object operations can be referred

as

(A) Active object (B) Servers

(C) Modules (D) None of these

104. For real time system following is not true

(A) Correct functioning of the system

depends on the result produced by the

system

(B) Correct functioning of the system

depends on the time at which the results

are produced

(C) The time of processing affects the

system output

(D) The time of processing does not affects

the system out-put

105. If in a software system, the operation is

degraded  if   results   are   not  produced

according  to  the  specified  timing  require-

ments then the software system is referred

as

(A) Soft real time system

(B) hard real time system

(C) Real time system

(D) None of these
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106. If  in  a  software  system,  the  operation  is
incorrect if results are not produced accor-
ding to the specified timing requirements
then the software system is referred as
(A) Soft real time system
(B) Hard real time system
(C) Real time system
(D) None of these

107. Degree to which a system or component
performs only the necessary functions
relevant to a particular purpose
(A) Abstractness
(B) Acceptable risk
(C) Acceptance testing
(D) None of these

108. Subject to probability of hazard, arising will
not raise cost factors is referred as
(A) Abstractness
(B) Acceptable risk
(C) Acceptance testing
(D) None of these

109. Formal testing conducted to determine
whether a system satisfies its acceptance
criteria and to enable the customer to
determine whether to accept the system
(A) Abstractness
(B) Acceptable risk
(C) Acceptance testing
(D) None of these

110. Truthfulness with which software satisfies
differing system constraints and user needs
is
(A) Active objects (B) Activity
(C) Adaptability (D) None of these

111. Adaptive measures are
(A) Quality measures that address how

easily a system can evolve or migrate
(B) Piece of software that acts to accomplish

tasks on behalf of its user
(C) A quantitative option analysis that allows

the cost of various options to be compu-
ted, and options can be compared on
objective basis

(D) Extent to which a software system or
component allows for or supports
anonymous transactions

112. An accident is
(A) Unplanned events, which results in

injury, damage to property, or to the
environment

(B) Quantitative measure of the magnitude
of error

(C) Period that starts when a system is
considered and ends when the product
meets its initial operational capability

(D) All the above

113. An Acquisition cycle time is

(A) Unplanned events, which results in

injury, damage to property, or to the

environment

(B) Quantitative measure of the magnitude

of error

(C) Period that starts when a system is

considered and ends when the product

meets its initial operational capability

(D) All the above

114. An accuracy is

(A) Unplanned events, which results in

injury, damage to property, or to the

environment

(B) Quantitative measure of the magnitude

of error

(C) Period that starts when a system is

considered and ends when the product

meets its initial operational capability

(D) All the above

115. Here the state of the object changes by

internal operations executing within the

object itself. And also object continually

executes and operations never suspend

itself is referred as

(A) Active objects (B) Activity

(C) Adaptability (D) None of these

116. A  clearly defined objective, entry and exit

conditions which is normally is atomic is

referred as

(A) Active objects (B) Activity

(C) Adaptability (D) None of these

117. Agents are

(A) Quality measures that address how

easily a system can evolve or migrate

(B) Piece of software that acts to accomplish

tasks on behalf of its user

(C) A quantitative option analysis that allows

the cost of various options to be compu-

ted, and options can be compared on

objective basis

(D) Extent to which a software system or

component allows for or supports

anonymous transactions

118. Anonymity is

(A) Quality measures that address how

easily a system can evolve or migrate

(B) Piece of software that acts to accomplish

tasks on behalf of its user
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(C) A quantitative option analysis that allows
the cost of various options to be compu-
ted, and options can be compared on
objective basis

(D) Extent to which a software system or
component allows for or supports
anonymous transactions

119. Algorithmic cost modeling is
(A) Quality measures that address how

easily a system can evolve or migrate
(B) Piece of software that acts to accomplish

tasks on behalf of its user
(C) A quantitative option analysis that allows

the cost of various options to be
computed, and options can be
compared on objective basis

(D) Extent to which a software system or
component allows for or supports
anonymous transactions

120. Application program interface is
(A) It supports system modeling during the

analysis and design stages of the
software process

(B) Organization responsible for approving
U.S. standards

(C) Stimuli that occurs irregularly
(D) Formalized set of software calls and

routines that can be referenced by an
application program in order to access
supporting system or network services*

121. Method of defining a collection of hardware
and software components and their
interfaces to establish the framework for the
development of a computer system
(A) As low as reasonably practical (ALARP)

risk
(B) Architectural design
(C) Attack
(D) None of these

122. Probability of an accident arising because
of hazard is minimum subject of other costs
(A) As low as reasonably practical (ALARP)

risk
(B) Architectural design
(C) Attack
(D) None of these

123. Fault tolerance system are
(A) These system runs on a single proce-

ssor or an integrated group of processors
(B) A system where each sub-system can

respond to generated events where the
events might be generated from other
sub-systems or from the environment
of the system.

(C) A system continues in operation after
some system faults have manifested
themselves.

(D) A system whose operation is incorrect,
if results are not produced according to
the timing specifications

124. The misuse of system vulnerability is
(A) As low as reasonably practical (ALARP)

risk
(B) Architectural design
(C) Attack
(D) None of these

125. Attribute-based identification is
(A) Here each component has a unique

name and an associated set of attribute,
which differs for each version of
component

(B) Extent to which a software system
records information concerning
transactions performed against the
system.

(C) Extent to which a system or component
is operational and accessible when
required for use

(D) They are used to describe the over all
behavior of the system.

126. Auditable is
(A) Here each component has a unique

name and an associated set of attribute,
which differs for each version of
component

(B) Extent to which a software system records
information concerning transactions
performed against the system

(C) Extent to which a system or component
is operational and accessible when
required for use

(D) They are used to describe the over all
behavior of the system

127. Availability is
(A) Here each component has a unique

name and an associated set of attribute,
which differs for each version of
component

(B) Extent to which a software system
records information concerning transac-
tions performed against the system.

(C) Extent to which a system or component
is operational and accessible when
required for use

(D) They are used to describe the over all
behavior of the system.
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128. Behavioral models is
(A) Here each component has a unique

name and an associated set of attribute,
which differs for each version of
component

(B) Extent to which a software system
records information concerning transac-
tions performed against the system.

(C) Extent to which a system or component
is operational and accessible when
required for use

(D) Used to describe the over all behavior
of the system

129. In Bottom-up integration
(A) The low-level components of a system

are integrated and tested before the
higher-level components have been
developed

(B) The testing process starts with modules
at lower levels in the hierarchy and
works up the hierarchy of modules until
the final module is tested.

(C) An event driven control system, where
an event is broadcasted to each sub-
system and any sub-system that can
handle that event responds to it.

(D) Control starts of the top of a sub routine
hierarchy and through sub routine calls
passes to lower levels.

130. In Broadcast models
(A) The low-level components of a system

are integrated and tested before the
higher-level components have been
developed.

(B) The testing process starts with modules
at lower levels in the hierarchy and
works up the hierarchy of modules until
the final module is tested

(C) An event driven control system, where
an event is broadcasted to each sub-
system and any sub-system that can
handle that event responds to it.

(D) Control starts of the top of a sub routine
hierarchy and through sub routine calls
passes to lower levels.

131. Bottom-up testing
(A) The low-level components of a system

are integrated and tested before the
higher-level components have been
developed.

(B) The testing process starts with modules
at lower levels in the hierarchy and
works up the hierarchy of modules until
the final module is tested.

(C) An event driven control system, where
an event is broadcasted to each sub-

system and any sub-system that can
handle that event responds to it.

(D) Control starts of the top of a sub routine
hierarchy and through sub routine calls

passes to lower levels.

132. In Call-return control model
(A) The low-level components of a system

are integrated and tested before the
higher-level components have been

developed.
(B) The testing process starts with modules

at lower levels in the hierarchy and
works up the hierarchy of modules until

the final module is tested.
(C) An event driven control system, where

an event is broadcasted to each sub-
system and any sub-system that can

handle that event responds to it.
(D) Control starts of the top of a sub routine

hierarchy and through sub routine calls
passes to lower levels

133.  Capacity  is
(A) A measure of the amount of work a

system can perform
(B) It provides automated support for

software process.
(C) Support individual process tasks

(D) Set of tools to support a particular
phase of software process such as

design, implementation or testing.

134. CASE  (Computer  Aided  Software

Engineering) is
(A) A measure of the amount of work a

system can perform
(B) It provides automated support for

software process.
(C) Support individual process tasks

(D) Set of tools to support a particular
phase of software process such as

design, implementation or testing:

135. CASE Tools
(A) A measure of the amount of work a

system can perform
(B) It provides automated support for

software process.
(C) Support individual process tasks

(D) Set of tools to support a particular
phase of software process such as
design, implementation or testing
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136. CASE Workbench

(A) A measure of the amount of work a

system can perform

(B) It provides automated support for

software process.

(C) Support individual process tasks

(D) Set of tools to support a particular phase

of software process such as design,

implementation or testing

137. Centralized control models

(A) Here one system is designed as the

system controller and has responsibility

for managing the execution of other

subsystems.

(B) Each system is named as in attribute-

based identification and associated with

one or more change requests.

(C) An object class inheritance diagram,

how    entities    have   common

characteristics.

(D) The    objective    of    this   software

development is zero-defect software.

138. Change-oriented identification

(A) One system is designed as the system

controller   and   has   responsibility  for

managing   the   execution    of  other

subsystems.

(B) Each system is named as in attribute-

based identification and associated with

one or more change requests.

(C) An  object  class  inheritance  diagram,

how   entities   have  common

characteristics.

(D) The  objective  of  this  software

development is zero-defect software.

139. Hard real time systems are

(A) These system runs on a single

processor or an integrated group of

processors

(B) A system where each sub-system can

respond to generated events where the

events might be generated from other

sub-systems or from the environment

of the system.

(C) A system continues in operation after

some system faults have manifested

themselves.

(D) A system whose operation is incorrect,

if results are not produced according to
the timing specifications

140. Classification model
(A) One system is designed as the system

controller and has responsibility for
managing the execution of other
subsystems.

(B) Each system is named as in attribute-
based identification and associated with
one or more change requests.

(C) An object class inheritance diagram, how
entities have common characteristics.

(D) The objective of this software develop-
ment is zero-defect software.

141. Clean room software development
(A) One system is designed as the system

controller   and   has   responsibility  for
managing    the    execution    of   other
subsystems.

(B) Each system is named as in attribute-
based identification and associated with
one or more change requests.

(C) An object class inheritance diagram,
how entities have common
characteristics.

(D) The objective is to develop zero-defect
software.

142. COCOMO cost model
(A) It takes project, product hardware and

personnel attributes into account when
formulating a cost estimate.

(B) In it server provides set of services and
set of clients uses these services.

(C) Extent to which standards are used to
achieve interoperability.

(D) None of these

143. Client server architecture
(A) It takes project, product hardware and

personnel attributes into account when
formulating a cost estimate.

(B) In it server provides set of services and
set of clients uses these services.

(C) Extent to which standards are used to
achieve interoperability.

(D) None of these

144. Commonality
(A) It takes project, product hardware and

personnel attributes into account when
formulating a cost estimate.

(B) In it server provides set of services and
set of clients uses these services.

(C) Extent to which standards are used to

achieve interoperability

(D) None of these
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145. Transforming of logic and data from design
specifications (design descriptions) into a
programming language
(A) Compatibility (B) Compactness
(C) Coding (D) Communication

146. An inter change of information between
computer systems and peoples or between
people.
(A) Compatibility (B) Compactness
(C) Coding (D) Communication

147. Extent to which a system or component
makes efficient use of its data storage
space- occupies a small volume.
(A) Compatibility (B) Compactness
(C) Code (D) Communication

148. Entity-relation model is
(A) It describes the basic entities in the

design and relation between them.
(B) Observational techniques used to

understand social and organizational
requirements.

(C) It is based on the idea of developing an
initial implementation, exposing it uses
on requirement and refining it through
many versions until an adequate system
has been developed.

(D) Based on an idea of developing an initial
implementation, exposing this to uses
comment  and  retiring  it  until  and
adequate system has been developed.

149. Ability of two or more systems or components
to perform their required functions while
sharing the same hardware or software
environment
(A) Compatibility (B) Compactness
(C) Code (D) Communication

150. Completeness in software system is
referred as
(A) Extent to which all the parts of a software

system or component are present and
each of its parts is fully specified and
developed.

(B) Testing of individual hardware/software
components

(C) An Entity-relation (E-R) diagram show
how entities in the system are
composed of other entities.

(D) It consists of wide range of different
types of computer programs, which be
used to support software process
activities such as a requirement
analysis, system modeling, debugging
and testing.

151. Composition model is

(A) Extent to which all the parts of a software

system or component are present and

each of its parts is fully specified and

developed.

(B) Testing of individual hardware/software

components

(C) An Entity-relation (E-R) diagram show

how entities in the system are

composed of other entities

(D) It consists of wide range of different

types of computer programs, which be

used to support software process

activities such as a requirement

analysis, system modeling, debugging

and testing.

152. Match the following : A-Control metrics : B-

Process metrics: C- Control: D-Correctness:

1- They  are  associated  with  software

process. 2- They are associated with

software products. 3- Protective measure

that reduces system vulnerability. 4- Extent

to which a system or component is free from

faults in its specification, design, and

implementation

(A) A-1, B-2,C-3,D-4 (B) A-4,B-3,C-2,D-1

(C) A-3, B-2,C-1,D-4 (D) None is true

153. Corrective maintenance is

(A) Maintenance performed to correct faults

in hardware or software

(B) A failure of software-controlled systems

in convenience, but there are source

systems   where    system    failure   is

resulted in significant critical losses.

(C) Failure that corrupts system state or data

(D) None is true

154. Corrupting failure is

(A) Maintenance performed to correct faults

in hardware or software

(B) A failure of software-controlled systems

in convenience, but there are source

systems   where   system   failure  is

resulted in significant critical losses.

(C) Failure that corrupts system state or data

(D) None is true
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155. Cost estimation is

(A) Process    of    estimating    the   costs
associated with software development
projects that include the effort, time, and
labor required.

(B) Overall cost of maintaining a computer
system   that   includes   the  costs
associated with personnel/training/
maintenance of hardware and software/
requirements growth.

(C) Overall cost of operating a computer
system   that   includes   the  costs
associated with personnel / training /
system operations.

(D) Overall cost of a computer system to an
organization that includes the costs
associated with operating/ maintaining
the   system,   and   the   lifetime  of
operational use of the system.

156. Cost of ownership is
(A) Process of estimating the costs

associated with software development
projects that include the effort, time, and
labor required.

(B) Overall cost of maintaining a computer
system   that   includes   the  costs
associated   with   personnel/training/
maintenance of hardware and software/
requirements growth.

(C) Overall cost of operating a computer
system  that  includes the costs
associated with personnel / training /
system operations.

(D) Overall cost of a computer system to an
organization that includes the costs
associated with operating/ maintaining
the system, and the lifetime of
operational use of the system.

157. Cost of maintenance
(A) Process of estimating the costs

associated with software development
projects that include the effort, time, and
labor required.

(B) Overall cost of maintaining a computer
system   that   includes   the  costs
associated with personnel/training/
maintenance of hardware and software/
requirements growth.

(C) Overall  cost  of  operating  a  computer
system   that   includes   the  costs
associated with personnel / training /
system operations.

(D) Overall cost of a computer system to an
organization that includes the costs
associated with operating/ maintaining
the  system,  and   the   lifetime   of
operational use of the system.

158. Event-driven control systems are
(A) These system runs on a single proce-

ssor or an integrated group of processors
(B) A system where each sub-system can

respond to generated events where the
events might be generated from other
sub-systems or from the environment
of the system.

(C) A system continues in operation after
some system faults have manifested
themselves.

(D) A system whose operation is incorrect,
if results are not produced according to
the timing specifications

159. Cost of operation is
(A) Process   of   estimating   the   costs

associated with software development
projects that include the effort, time, and
labor required.

(B) Overall cost of maintaining a computer
system   that   includes   the   costs
associated   with   personnel / training/
maintenance of hardware and software/
requirements growth.

(C) Overall   cost of operating a computer
system     that    includes    the   costs
associated with personnel / training /
system operations.

(D) Overall cost of a computer system to an
organization that includes the costs
associated with operating/ maintaining
the system, and the lifetime of
operational use of the system.

160. In Data reduction
(A) Here data-flow diagram show, how data

is processed at different stages in the
system.

(B) It registers all/ selected activities of a
computer system.

(C) Technique used to transform raw data
into a more useful form.

(D) Data is shifted to modern data base
management system.

161. Ethnography is
(A) It describes the basic entities in the

design and relation between them.
(B) Observational techniques used to

understand social and organizational
requirements.

(C) It is based on the idea of developing an
initial implementation, exposing it uses
on requirement and refining it through
many versions until an adequate system
has been developed.

(D) Based on an idea of developing an initial
implementation, exposing this to uses
comment   and   retiring   it   until   and
adequate system has been developed.
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162. In Data migration
(A) Here data-flow diagram show, how data

is processed at different stages in the
system.

(B) It registers all/ selected activities of a
computer system.

(C) Technique used to transform raw data
into a more useful form

(D) Data is shifted to modern data base
management system

163. In Data flow (Activity model)
(A) It shows the software process as a set

of activities each of which carries out
data transformation.

(B) Data and associated programs are re-
engineered to remove limits on the data
processing.

(C) It is responsible for the definition,
operation, protection, performance, and
recovery of a database.

(D) Development of a database to meet a
user’s requirements.

164. In Data tension
(A) It shows the software process as a set

of activities each of which carries out
data transformation.

(B) Data and associated programs are re-
engineered to remove limits on the data
processing

(C) It   is   responsible   for   the   definition,
operation, protection, performance, and
recovery of a database.

(D) Development of a database to meet a
user’s requirements

165. Database administration
(A) It shows the software process as a set

of activities each of which carries out
data transformation.

(B) Data and associated programs are re-
engineered to remove limits on the data
processing.

(C) It   is   responsible   for   the  definition,
operation, protection, performance, and
recovery of a database.

(D) Development of a database to meet a
user’s requirements

166.  Database design
(A) This model shows the software process

as a set of activities each of which carries
out data transformation.

(B) Data and associated programs are re-
engineered to remove limits on the data
processing.

(C) It is responsible for the definition,

operation, protection, performance, and

recovery of a database.

(D) Development of a database to meet a

user’s requirements

167. Exploratory development is

(A) Trustworthiness with which a system or

component can be modified to take

advantage of new software or hardware

technologies.

(B) An error of some kind or an unexpected

event occurs during the execution of a

program

(C) Here the objective of the process is to

work   with   uses   to   explore  their

requirement and deliver a final system.

(D) Possible loss or harm in computing

system.

168. Collection of logically related data stored

together in one or more computerized files.

(A) Database

(B) Debugging

(C) Defect testing

(D) Defensive programming

169. Exception is

(A) Trustworthiness with which a system or

component can be modified to take

advantage of new software or hardware

technologies.

(B) An error of some kind or an unexpected

event occurs during the execution of a

program

(C) Here the objective of the process is to

work   with   uses   to   explore  their

requirement and deliver a final system.

(D) Possible loss or harm in computing

system.

170. When the program is developed, it is to be

tested and defects are to be removed from

the program.

(A) Database

(B) Debugging

(C) Defect testing

(D) Defensive programming

171. Evolutionary Development

(A) It describes the basic entities in the

design and relation between them.

(B) Observational techniques used to

understand social and organizational

requirements.
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(C) It is based on the idea of developing an
initial implementation, exposing it uses
on requirement and refining it through
many versions until an adequate system
has been developed

(D) Based on an idea of developing an initial
implementation, exposing this to uses
comment   and   retiring   it   until  and
adequate system has been developed.

172. Exposure is
(A) Trustworthiness with which a system or

component can be modified to take
advantage of new software or hardware
technologies.

(B) An error of some kind or an unexpected
event occurs during the execution of a
program

(C) Here the objective of the process is to
work  with  uses  to  explore  their
requirement and deliver a final system.

(D) Possible loss or harm in computing
system.

173. Fault tolerance is
(A) It is the process of modifying the state

space of the system so that the effects
of the fault are minimized and system
can continue in operation in some
degraded state.

(B) Capacity of a system or component to
continue normal operation despite the
presence of hardware or software faults.

(C) It is the widely used hazard technique
(D) Incorrect  step,  process,  or  data

definition in a computer program

174. It is intended to find inconsistencies between
a program and its specification. These
inconsistencies are usually due to program
faults or defects.
(A) Database
(B) Debugging
(C) Defect testing
(D) Defensive programming

175. It is a property of the system that equates to
its trustworthiness. It is the degree of user’s
confidence that the system will operate as
one expect, that the system would not fail in
normal use.
(A) Dependability (B) Availability
(C) Maintainability (D) None of these

176. Fail safe is
(A) Trustworthiness with which a system or

component can be modified to increase
its storage or functional capacity

(B) Pertaining to a system/component that
automatically places itself in a safe
operating mode in the event of a failure.

(C) Pertaining to a system or component

that continues to provide partial

operational capability in the event of

certain failures.

(D) None of these

177. Represents the number of discrete levers in

the inheritance tree where subclasses

inherit attributes and operations from super

classes.

(A) Depth of inheritance tree

(B) Breath of inheritance tree

(C) Radius of inheritance tree

(D) None of these

178. Fan- out is referred to

(A) It is a measure of number of function

that calls some other function.

(B) It is measure of number of functions that

are called by a function.

(C) In it server is only responsible for data

management.

(D) None of these

179. Fail soft is

(A) Trustworthiness with which a system or

component can be modified to increase

its storage or functional capacity

(B) Pertaining to a system/component that

automatically places itself in a safe

operating mode in the event of a failure.

(C) Pertaining to a system or component

that continues to provide partial

operational capability in the event of

certain failures

(D) None of these

180. Embedded systems are

(A) These system runs on a single

processor or an integrated group of

processors

(B) A system where each sub-system can

respond to generated events where the

events might be generated from other

sub-systems or from the environment

of the system.

(C) A system continues in operation after

some system faults have manifested

themselves.

(D) A system whose operation is incorrect,

if results are not produced according to

the timing specifications
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181. Fault is

(A) It is the process of modifying the state

space of the system so that the effects

of the fault are minimized and system

can  continue   in   operation  in  some

degraded state.

(B) Capacity of a system or component to

continue normal operation despite the

presence of hardware or software faults.

(C) It is the widely used hazard technique

(D) Incorrect   step,   process,   or   data

definition in a computer program

182.  Emergent requirements

(A) Emerges due to user’s understanding

of system develops, during system

development

(B) Requirements derived from the core

activity of the organization and directly

related to the domain of the system.

(C) Extent to which a system  allowed  the

user to intentionally or unintentionally

introduce errors into or misuse the

system.

(D) None of these.

183. Fat-client model is

(A) It is a measure of number of function

that calls some other function.

(B) It is measure of number of functions that

are called by a function.

(C) In it server is only responsible for data

management.

(D) None of these

184. Fault recovery is

(A) It is the process of modifying the state

space of the system so that the effects

of the fault are minimized and system

can   continue   in    operation   in  some

degraded state

(B) Capacity of a system or component to

continue normal operation despite the

presence of hardware or software faults.

(C) It is the widely used hazard technique

(D) Incorrect   step,    process,   or   data

definition in a computer program

185. Enduring requirements

(A) Emerges due to user’s understanding

of system develops, during system

development

(B) Requirements derived from the core

activity of the organization and directly

related to the domain of the system*

(C) Extent to which a system allowed the

user to intentionally or unintentionally

introduce errors into or misuse the

system.

(D) None of these.

186. Match the following : A- Error handling : B-

Error proneness: C- Error tolerance:: 1-

Extent to which  a system or component to

continue normal operation despite the

presence of erroneous inputs.:  2- Extent to

which a system allowed the user, to

intentionally or unintentionally introduce

errors into or misuse the system.: 3- Function

of a computer system/ component that

identify and respond to user or system errors

to maintain normal or at the very least

degraded operations.

(A) A-3,B-2,C-1 (B) A-1,B-2,C-3

(C) A-2,B-1,C-3 (D) None of these

187. Hazard avoidance

(A) Hazard cannot arise due system design.

(B) The probability of the event occurring

which create a hazard.

(C) An assessment of the worst possible

damage, which could result from a

particular hazard.

(D) A condition with the potential for causing

or contributing to an accident.

188.  Evolutionary prototyping is

(A) It describes the basic entities in the

design and relation between them.

(B) Observational techniques used to

understand social and organizational

requirements.

(C) It is based on the idea of developing an

initial implementation, exposing it uses

on requirement and refining it through

many versions until an adequate system

has been developed.

(D) Based on an idea of developing an initial

implementation, exposing this to uses

comment   and   retiring   it   until  and

adequate system has been developed.
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189. Match the following : A- Managed device : B-

Managed object: C- Managed processes: 1-

Type of node residing on a network, such as

a computer, printer or routers that contain a

management agent.  2- Characteristic of a

managed device that can be monitored,

modified or controlled. 3- It is a defined

process model. Procedures used are

defined and scheduling and relationship

between them is defined.

(A) A-1, B-3,C-2 (B) A-1,B-2,C-3

(C) A-2,B-3,C-1 (D) A-3,B-2,C-1

190.  Goal is

(A) Extent to which a system or component

performs a broad range of functions.

(B) The objective of an organization to

achieve.

(C) Methods and techniques for converting

data to or from graphic display via

computers.

(D) None of these

191. Implementation phase is

(A)  Period in the software life cycle in which

a software product is created from

design documentation and debugged.*

(B) Period in the software life cycle in which

a software product is integrated in its

operational environment, and tested in

this environment to ensure it performs

as required.

(C) Period in the software life cycle during

which the basic version of a software

product is adapted to a specified set of

operational environments and is

distributed to a customer base.

(D) None of these

192.  Evolvability is

(A) Trustworthiness with which a system or

component can be modified to take

advantage of new software or hardware

technologies.

(B) An error of some kind or an unexpected

event occurs during the execution of a

program

(C) Here the objective of the process is to

work with uses to explore their

requirement and deliver a final system.

(D) Possible loss or harm in computing

system.

193. Match the following A- Functional
requirements: B- Functional scope : C-
Function-point count: D- Function-related
measures: 1- It describe the functionality or
services that system is expected to provide.
2- Range to which a system component is
capable of being applied. 3- These are
language independent productive measure..
4- It is related to the overall functionality of
the delivered software.
(A) A-4,B-2,C-3,D-1   (B) A-2,B-1,C-3,D-4
(C) A-1,B-3,C-2,D-4   (D) A-1,B-2,C-3,D-4

194. Lehman’s  Second Law (Lehman and
Belady 1985) is
(A) Continuing change: A program used in

real-world environment must change
necessarily or become progressively
less useful in that environment.

(B) Increase complexity: As an evolving
program change, its strictures tend to
become more complex. Extra resources
must be devoted to preserving and
simplifying the structure.

(C) Large program evolution: Program
evolution is a self-regulating process.

(D) None of these

195. Hazard probability
(A) Hazard cannot arise due system design.
(B) The probability of the event occurring

which create a hazard.
(C) An assessment of the worst possible

damage, which could result from a
particular hazard.

(D) A condition with the potential for causing
or contributing to an accident.

196. Flexibility
(A) The software and hardware system

architectures that provide explicit
support for tolerance, which includes
software redundancy and fault-
tolerance controller that detects
problems and supports fault recovery

(B) It  is  an  initial  step  for  requirements
engineering   process,   includes   the
outline description of system, its use in
an organization and recommending the
system feasibility.

(C) Trustworthiness with which a system or
component can be modified for use in
applications or environments other than
those for which it was specifically
designed.

(D) None of these
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197. Extendibility is

(A) Trustworthiness with which a system or

component can be modified to increase

its storage or functional capacity

(B) Pertaining to a system/component that

automatically places itself in a safe

operating mode in the event of a failure.

(C) Pertaining to a system or component

that continues to provide partial

operational capability in the event of

certain failures.

(D) None of these

198. Generality is

(A)  Extent to which a system or component

performs a broad range of functions.

(B) The objective of an organization to

achieve.

(C) Methods and techniques for converting

data to or from graphic display via

computers.

(D) None of these

199. Feasibility studies

(A) The software and hardware system

architectures that provide explicit

support for tolerance, which includes

software redundancy and fault-

tolerance controller that detects

problems and supports fault recovery

(B) It is an initial step for requirements

engineering process, includes the

outline description of system, its use in

an organization and recommending the

system feasibility.

(C) Trustworthiness with which a system or

component can be modified for use in

applications or environments other than

those for which it was specifically

designed.

(D) None of these

200. Fan-in  is referred to

(A) It is a measure of number of function

that calls some other function.

(B) It is measure of number of functions,

which are called by a function.

(C) In it server is only responsible for data

management.

(D) None of these

201. Manufacturing phase  is

(A) Period in the software life cycle in which

a software product is created from

design documentation and debugged.

(B) Period in the software life cycle in which

a software product is integrated in its

operational environment, and tested in

this environment to ensure it performs

as required.

(C) Period in the software life cycle during

which the basic version of a software

product is adapted to a specified set of

operational environments and is

distributed to a customer base.

(D) None of these

202. Human engineering is
(A) It is concerned with the design,

evaluation, and implementation of
interactive computing systems for
human use and with the study of major
phenomena surrounding them.

(B) Extent to which a software product fulfills
its purpose without wasting user’s time/
energy/degrading their morale.

(C) Human behavior that results in the
introduction of faults into a system.

(D) None of these

203. Hazard severity
(A) Hazard cannot arise due system design.
(B) The probability of the event occurring

which create a hazard.
(C) An assessment of the worst possible

damage, which could result from a
particular hazard.

(D) A condition with the potential for causing
or contributing to an accident.

204. Latency is
(A) Ability of two or more systems, to

exchange information and to use the
information that has been exchanged.

(B) Time taken to respond to an event.
(C) Either the hazard not arises, if arise; it

will not result in an accident.
(D) None of these

205. Fault tree analysis is
(A) It is the process of modifying the state

space of the system so that the effects
of the fault are minimized and system
can continue in operation in some
degraded state.

(B) Capacity of a system or component to
continue normal operation despite the
presence of hardware or software faults.
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(C) It is the widely used hazard technique
(D) Incorrect    step,    process,    or   data

definition in a computer program

206. Lehman’s  Fourth Law (Lehman and Belady
1985) is
(A) Organizational stability: Over a

program’s lifetime, its rate of
development is approximately constant
and independent of the resources
devoted to system development.

(B) Increase complexity: As an evolving
program change, its strictures tend to
become more complex. Extra resources
must be devoted to preserving and
simplifying the structure.

(C) Large program evolution: Program
evolution is a self-regulating process.

(D) None of these

207. Human error is
(A) It is concerned with the design,

evaluation, and implementation of
interactive computing systems for
human use and with the study of major
phenomena surrounding them.

(B) Extent to which a software product fulfills
its purpose without wasting user’s time/
energy/degrading their morale.

(C) Human behavior that results in the
introduction of faults into a system.

(D) None of these

208.   Fault-tolerant architectures is
(A) The software and hardware system

architectures that provide explicit
support for tolerance, which includes
software redundancy and fault-
tolerance controller that detects
problems and supports fault recovery*

(B) It is an initial step for requirements
engineering process, includes the
outline description of system, its use in
an organization and recommending the
system feasibility.

(C) Trustworthiness with which a system or
component can be modified for use in
applications or environments other than
those for which it was specifically
designed.

(D) None of these

209. Match the following: A- Formal mathematical
transformation: B- Formal process model:
C-Formal Specifications: D-Formal System
development: 1- Here the formal mathema-
tical representation of the system takes
place. 2- It is a starting point for process

analysis. It is abstract and only defines the
principal process activities and deliverables.
3-Specifications expressed in a language
whose vocabulary, syntax and semantics are
formally defined. 4-It is more common to
waterfall model, but here the development
process is based on formal mathematical
transformation of a system specification to
an exactable program.
(A) A-1,B-2,C-3,D-4
(B) A-4,B-2,C-3,D-1
(C) A-2,B-1,C-3,D-4
(D) A-1,B-3,C-2,D-4

210. Lehman’s First Law (Lehman and Belady
1985) is
(A) Continuing change: A program used in

real-world environment must change
necessarily or become progressively
less useful in that environment.

(B) Increase complexity: As an evolving
program change, its strictures tend to
become more complex. Extra resources
must be devoted to preserving and
simplifying the structure.

(C) Large program evolution: Program
evolution is a self-regulating process.

(D) None of these

211. Graphics
(A) Extent to which a system or component

performs a broad range of functions.
(B) The objective of an organization to

achieve.
(C) Methods and techniques for converting

data to or from graphic display via
computers.

(D) None of these

212. Intolerable risk is
(A) Ability of two or more systems, to

exchange information and to use the
information that has been exchanged.

(B) Time taken to respond to an event.
(C) Either the hazard not arises, if arise; it

will not result in an accident.
(D) None of these

213. Hazard
(A) Hazard cannot arise due system design.
(B) The probability of the event occurring

which create a hazard.
(C) An assessment of the worst possible

damage, which could result from a
particular hazard.

(D) A condition with the potential for causing
or contributing to an accident.
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214.  Human Computer Interaction is
(A) It is concerned with the design,

evaluation, and implementation of
interactive computing systems for
human use and with the study of major
phenomena surrounding them.

(B) Extent to which a software product fulfills
its purpose without wasting user’s time/
energy/degrading their morale.

(C) Human behavior that results in the
introduction of faults into a system.

(D) None of these

215. Match the following : A- Maintenance control:
B- Maintenance prediction: C- Maintenance
process: 1-Cost of planning and scheduling
hardware preventive maintenance, and
software maintenance and upgrades,
managing the hardware and software
baselines, and providing response for
hardware corrective maintenance. 2-
Predicting the number of change requires a
system understanding and the relationship
between  the  system  and  external
environment. 3- It is triggered by a set of
change  requests  from  system  users,
management or customers.
(A) A-1, B-3,C-2 (B) A-1,B-2,C-3
(C) A-2,B-3,C-1 (D) A-3,B-2,C-1

216. Installation and checkout phase
(A) Period in the software life cycle in which

a software product is created from
design documentation and debugged.

(B) Period in the software life cycle in which
a software product is integrated in its
operational environment, and tested in
this environment to ensure it performs
as required.

(C) Period in the software life cycle during
which the basic version of a software
product is adapted to a specified set of
operational environments and is
distributed to a customer base.

(D) None of these

217. A- Interface requirement: B-Interface testing:
C-Interfaces design: 1- Requirements
derived from the interfaces of existing system
and developing system. 2- It detects faults
that have been arise in the system because
of interface errors or invalid assumptions
about interface. 3-Activity concerned with the
interfaces of the software system contained
in the software requirements and software
interface requirements documentation.
(A) A-1,B-2,C-3 (B) A-2,B-1,C-3
(C) A-2,B-3,C-1 (D) A-3,B-2,C-1

218. Software implementation is
(A) It is concern with modification of existing

system to meet changing requirements.
(B) It is a process of converting system

specifications into an executable
system.

(C) It analyzes and checks system
representation such as the
requirements document, design
diagrams and program source code.

(D) None of these

219. An object-oriented model of system
architecture structures the system into a set
of loosely coupled objects with well-defined
interfaces.
(A) Object design models
(B) Object interface design
(C) Object oriented models
(D) None of these

220. Interoperability  is
(A) Ability of two or more systems, to

exchange information and to use the
information that has been exchanged.

(B) Time taken to respond to an event.
(C) Either the hazard not arises, if arise; it

will not result in an accident.
(D) None of these

221. Parkinson’s Law is
(A) The cost is determined by available

resources rather than by objective
assessment.

(B) A program used in real-world
environment must change necessarily
or become progressively less useful in
that environment.

(C) As an evolving program change, its
strictures tend to become more complex.

(D) Program evolution is a self-regulating
process.

222. An object-oriented model of system
architecture structures the system into a set
of loosely coupled objects with well-defined
interfaces.
(A) Object design models
(B) Object interface design
(C) Object oriented models
(D) None of these

223. Retirement phase is
(A) Reason for a computer program to

resume execution after a failure, using
status and results recorded at a
checkpoint.

(B) Period of time in the software life cycle
during which support for a software
product is terminated.
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(C) The fault detection mechanism is
initiated after the system state has been
changed to check if a fault has occurred.

(D) None of these

224. Retrospective Fault detection is
(A) Reason for a computer program to

resume execution after a failure, using
status and results recorded at a
checkpoint.

(B) Period of time in the software life cycle
during which support for a software
product is terminated.

(C) The fault detection mechanism is
initiated after the system state has been
changed to check if a fault has occurred*

(D) None of these

225. Risk planning process
(A) Extent to which a software module can

be used in more than one computing
program

(B) It involves regular monitoring of the risks
identified and of new risks that develops.

(C) It considers each of the key risks that
are identified and identifies strategies
to manage the risk.

(D) None of these

226. Software engineering method is
(A) Associated with production of software

as per specification
(B) Structured approach to software

development, whose aim is to facilitate
the production of high-quality software
in a cost-effective way.

(C) An engineering discipline, concern with
software development.

(D) None of these

227. Restart is
(A) Reason for a computer program to

resume execution after a failure, using
status and results recorded at a
checkpoint.

(B) Period of time in the software life cycle
during which support for a software
product is terminated.

(C) The fault detection mechanism is
initiated after the system state has been
changed to check if a fault has occurred.

(D) None of these

228. Risk Management is
(A) Here each identified risk is analyzed and

prioritized
(B) It begins after all hazards are identified.

For each hazard, the outcome of the risk
assessment process is a statement of
acceptability.

(C) The anticipate risks which night affect
the project schedule or the quality of the
software being developed and to take
action to avoid these risks.

(D) None of these

229. ROCOF (Rate of failure occurrence) is
(A) The probability that the system will

cause an accident
(B) Extent to which a system or component

can function correctly in the presence of
invalid inputs or stressful environment
conditions.

(C) The frequency of occurrence with which
unexpected behavior is likely to occur

(D) None of these

230. Software system is
(A) Associated with functionality of software

and constraints of operations defined.
(B) It consists of computer programs,

configuration files that are used to set
up these programs system
documentation for describing to
structure of the system and used
documentation that describes use of the
system.

(C) It involves executing an implementation
of the software with test data and
examines the outputs of the software
and its operational behavior to check
that it is performing as required

(D) None of these

231. Scalability is
(A) Avoiding catastrophic moment
(B) Ease with which a system or component

are modified to fit the problem area.
(C) It is a bounded area of responsibility.
(D) None of these

232. Risk analysis process is
(A) Here each identified risk is analyzed and

prioritized
(B) It begins after all hazards are identified.

For each hazard, the outcome of the risk
assessment process is a statement of
acceptability.

(C) The anticipate risks which night affect
the project schedule or the quality of the
software being developed and to take
action to avoid these risks.

(D) None of these

233. Reusability is
(A) Extent to which a software module can

be used in more than one computing
program.

(B) It involves regular monitoring of the risks
identified and of new risks that develops.
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(C) It considers each of the key risks that
are identified and also identifies
strategies to manage the risk.

(D) None of these

234. Safety argument is
(A) Associated with the role of people

involved in software process and the
activities for which they are responsible.

(B) The most effective technique for
demonstrating the safety of a system is
proof by contradiction.

(C) It is concerned with establishing a

confidence level in the system that might

vary from low to high

(D) None of  these

235. Risk assessment is

(A) Here each identified risk is analyzed and

prioritized

(B) It begins after all hazards are identified.

For each hazard, the outcome of the risk

assessment process is a statement of

acceptability.

(C) The anticipate risks which night affect

the project schedule or the quality of the

software being developed and to take

action to avoid these risks.

(D) None of these

236. Risk is

(A) The  probability  that  the  system  will

cause an accident

(B) Extent to which a system or component

can function correctly in the presence of

invalid inputs or stressful environment

conditions.

(C) The frequency of occurrence with which

unexpected behavior is likely to occur.

(D) None of these

237. Safety is

(A) Avoiding catastrophic moment

(B) Ease with which a system or component

are modified to fit the problem area.

(C) It is a bounded area of responsibility.

(D) None of these

238.  Role/action model is

(A) Associated   with   the   role   of   people

involved in software process and the

activities for which they are responsible

(B) The most effective technique for

demonstrating the safety of a system is

proof by contradiction.

(C) It   is   concerned   with  establishing  a

confidence level in the system that might

vary from low to high

(D) None of  these

239. Role is

(A) Avoiding catastrophic moment

(B) Ease with which a system or component

are modified to fit the problem area.

(C) It is a bounded area of responsibility

(D) None of these

240. Robustness is

(A) The probability that the system will

cause an accident

(B) Extent to which a system or component

can function correctly in the presence of

invalid inputs or stressful environment

conditions

(C) The frequency of occurrence with which

unexpected behavior is likely to occur.

(D) None of these

241. Risk monitoring process

(A) Extent to which a software module can

be used in more than one computing

program

(B) It involves regular monitoring of the risks

identified and of new risks that develops.

(C) It considers each of the key risks that

are identified and identifies strategies

to manage the risk.

(D) None of these

242. These objects can be realized as parallel

process with method corresponding to

defined object operations.

(A) Self-descriptiveness

(B) Servers

(C) Simplicity

(D) None of these

243. Safety validation is

(A) Associated   with  the   role   of  people

involved in software process and the

activities for which they are responsible.

(B) The   most   effective   technique  for

demonstrating the safety of a system is

proof by contradiction.

(C) It   is   concerned   with  establishing a

confidence level in the system that might

vary from low to high

(D) None of  these
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244. Software process model
(A) Time-period   that   begins   when  a

software product is conceived and ends
when the software is no longer available

for use.
(B) Adaptive maintenance, performed to

make a computer program usable in a
changed environment.

(C) A simplified description of a software
process   that  is   presented   from   a

particular perspective.
(D) None of these

245. Extent  to  which  a  system  or  component
contains enough information to explain its
objectives and properties is referred as
(A) Self-descriptiveness
(B) Servers
(C) Simplicity
(D) None of these

246. Degree to which a system or component has
a design and implementation that is
straightforward and easy to understand is
referred as
(A) Self-descriptiveness
(B) Servers
(C) Simplicity
(D) None of these

247. Software attributes are
(A) Maintainability (B) Reliability
(C) Portability (D) All the above

248. Software measurement is
(A) It is the general process of changing

system after it has been delivered. The
changes can be to correct coding error
to correct design error, or adding new
components to system.

(B) It is concerned with deriving a numeric
value for some attribute of a software
product or a software process.

(C) It is any type of measurement, which
relates to software system, process and
related documentation.

(D) None of these
249. Software development is

(A) Associated with production of software
as per specification

(B) Structured   approach   to  software
development, whose aim is to facilitate
the production of high-quality software
in a cost-effective way.

(C) An engineering discipline, concern with
software development.

(D) None of these

250. Software evolution is
(A) It is concern with modification of existing

system to meet changing requirements.
(B) It  is  a  process  of  converting  system

specifications    into     an   executable
system.

(C) It    analyzes    and    checks    system
representation   such   as   the   require-
ments document, design diagrams and
program source code.

(D) None of these
251. Software maintenance is

(A) It is the general process of changing
system after it has been delivered. The
changes can be to correct coding error
to correct design error, or adding new
components to system.

(B) It is concerned with deriving a numeric
value for some attribute of a software
product or a software process.

(C) It is any type of measurement, which
relates to software system, process and
related documentation.

(D) None of these
252. Software Engineering is

(A) Associated with production of software
as per specification

(B) Structured   approach   to  software
development, whose aim is to facilitate
the production of high-quality software
in a cost-effective way.

(C) An engineering discipline, concern with
software development.

(D) None of these
253. Software inspection is

(A) It is concern with modification of existing
system to meet changing requirements.

(B) It is a process of converting system
specifications into an executable system.

(C) It    analyzes    and    checks   system
representation   such   as   the  require-
ments document, design diagrams and
program source code.

(D) None of these
254. Software life cycle is

(A) Time-period   that   begins   when  a
software product is conceived and ends
when the software is no longer available
for use.

(B) Adaptive  maintenance,  performed  to
make a computer program usable in a
changed environment.

(C) A  simplified  description  of  a  software
process    that    is    presented    from    a
particular perspective.

(D) None of these
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255. Software requirements specification are
(A) A set of activities and associated results

that produce a software product.
(B) It is concerned with re-implementing

legacy system to make them more
maintainable.

(C) It  is  the  official  statement  of  what  is
required  of  the  system  developers;  it
includes   uses   requirements   for  a
system and detailed specification of the
system requirements

(D) None of these.

256. Software migration and evolution is
(A) Time-period that begins when a

software product is conceived and ends
when the software is no longer available
for use.

(B) Adaptive maintenance, performed to
make a computer program usable in a
changed environment.

(C) A simplified description of a software
process that is presented from a
particular perspective.

(D) None of these

257. Software process is
(A)  A set of activities and associated results

that produce a software product
(B) It is concerned with re-implementing

legacy system to make them more
maintainable.

(C) It is the official statement of what is
required of the system developers; it
includes uses requirements for a
system and detailed specification of the
system requirements

(D) None of these.

258. Software re-engineering is
(A) A set of activities and associated results

that produce a software product.
(B) It is concerned with re-implementing

legacy system to make them more
maintainable

(C) It is the official statement of what is
required of the system developers; it
includes uses requirements for a
system and detailed specification of the
system requirements

(D) None of these.

259. Procedural interface
(A) Trustworthiness with which a system

are transferred from one hardware
environment to another

(B) Here one sub system encapsulates a
set of procedures, which can be called
by other sub-systems.

(C) It is concerned with studying existing
process to understand the relationship
between different parts of the process.

(D) None of these

260. Software metric is
(A)  It is the general process of changing

system after it has been delivered. The
changes can be to correct coding error
to correct design error, or adding new
components to system.

(B) It is concerned with deriving a numeric
value for some attribute of a software
product or a software process.

(C) It is any type of measurement, which
relates to software system, process and
related documentation.

(D) None of these

261. Software specification is
(A)  Associated with functionality of software

and constraints of operations defined.
(B) It consists of computer programs,

configuration files that are used to set
up these programs system documen-
tation for describing to structure of the
system and used documentation that
describes use of the system.

(C) It involves executing an implementation
of the software with test data and
examines the outputs of the software
and its operational behavior to check
that it is performing as required

(D) None of these

262. System is
(A) The   set   of   system   services  and

constraints in details
(B) System functions that restricts the use

of objects to certain users.
(C) Purposeful    collection    of   interrelated

components   that   work   together  to
achieve some objective.

(D) None of these

263. Software testing is
(A) Associated with functionality of software

and constraints of operations defined.
(B) It consists of computer programs,

configuration files that are used to set
up   these   programs   system
documentation for describing to
structure of the system and used
documentation that describes use of the
system.
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(C) It involves executing an implementation
of the software with test data and
examines the outputs of the software
and its operational behavior to check
that it is performing as required

(D) None of these

264. It is concerned with making decision about
the best way for an organization that acquire
a system and deciding on the best suppliers
of that system.
(A) System procurement
(B) System quality assessment
(C) System release management
(D) System reliability

265. It   is   responsible   for   deciding   when   the
system  can  be  released  to   customers,
managing   the   process   of   creating  the
release and distribution media and documen-
ting the release.
(A) System procurement
(B) System quality assessment
(C) System release management
(D) System reliability

266. Process analysis
(A) Trustworthiness with which a system

are transferred from one hardware
environment to another

(B) Here one sub system encapsulates a
set of procedures, which can be called
by other sub-systems.

(C) It is concerned with studying existing
process to understand the relationship
between different parts of the process.

(D) None of these

267. System requirements are
(A) The set of system services and

constraints in details
(B) System functions that restricts the use

of objects to certain users.
(C) Purposeful   collection   of   interrelated

components  that  work  together   to
achieve some objective.

(D) None of these

268. System security  is
(A) The   set   of   system   services  and

constraints in details
(B) System functions that restricts the use

of objects to certain users
(C) Purposeful   collection   of   interrelated

components    that   work   together  to
achieve some objective.

(D) None of  these

269. Portability
(A) Trustworthiness with which a system

are transferred from one hardware
environment to another

(B) Here one sub system encapsulates a
set of procedures, which can be called
by other sub-systems.

(C) It is concerned with studying existing
process to understand the relationship
between different parts of the process.

(D) None of these

270. Lehman’s  Third  Law  (Lehman and Belady
1985) is
(A) Continuing change: A program used in

real-world environment must change
necessarily or become progressively
less useful in that environment.

(B) Increase complexity: As an evolving
program change, its strictures tend to
become more complex. Extra resources
must be devoted to preserving and
simplifying the structure.

(C) Large program evolution: Program
evolution is a self-regulating process.

(D) None of these

271. Model is
(A) These measurements need to be

collected to help answers to the
questions and to confirm whether
process improvements have achieved
the desired goal.

(B) Approximation, representation, or
idealization of selected aspects of the
structure, behavior, operation, or other
characteristics of a real-world process

(C) Extent to which a system or component
facilitates the incorporation of changes,
once the nature of the desired change
has been determined.

(D) None of  these

272. Lehman’s Fifth Law (Lehman and Belady
1985) is
(A) Organizational  stability:  Over  a  pro-

gram’s lifetime, its rate of development
is    approximately    constant   and
independent of the resources devoted
to system development.

(B) Conservation of familiarity: Over the
lifetime of a system, the incremental
change in each release is approxima-
tely constant.

(C) Large program evolution: Program
evolution is a self-regulating process.

(D) None of these

273. Match the following : A- Maintenance control:
B-Maintenance measures: C-Maintenance
personnel :  1-Cost of  planning  and
scheduling  hardware  preventive  main-
tenance, and software maintenance and
upgrades, managing the hardware and
software baselines, and providing response
for hardware corrective maintenance. 2-
Measures that address how easily a system
can be repaired or changed. 3-Number of
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personnel needed to maintain all aspects
of a computer system, including the support
personnel and facilities needed to support
that activity.
(A) A-1, B-3,C-2 (B) A-1,B-2,C-3
(C) A-2,B-3,C-1 (D) A-3,B-2,C-1

274. Organizational measures
(A) Extent to which a system or component

complies with standards
(B) Trustworthiness of operating the

software.
(C) Measures that estimates system cost

to operate and maintain
(D) None of these

275. Metric is
(A) These  measurements  need  to  be

collected  to  help  answers  to  the
questions  and  to  confirm  whether
process improvements have achieved
the desired goal.

(B) Approximation,   representation,  or
idealization of selected aspects of the
structure, behavior, operation, or other
characteristics of a real-world process

(C) Extent to which a system or component
facilitates the incorporation of changes,
once the nature of the desired change
has been determined.

(D) None of  these

276. It shows the objects and object classes in a
system and the relationship between these
entities.
(A) Object design models
(B) Object interface design
(C) Object oriented models
(D) None of these

277. It is concerned with specifying the details of
interface to an object or to a group of objects
(A) Object design models
(B) Object interface design
(C) Object oriented models
(D) None of these

278. Modifiability is
(A) These measurements need to be

collected to help answers to the
questions and to confirm whether
process improvements have achieved
the desired goal.

(B) Approximation, representation, or
idealization of selected aspects of the
structure, behavior, operation, or other
characteristics of a real-world process*

(C) Extent to which a system or component
facilitates the incorporation of changes,
once the nature of the desired change
has been determined.

(D) None of  these

Answer Sheet

1. (A) 2. (C) 3. (D) 4. (A) 5. (C)
6. (A) 7. (A) 8. (C) 9. (B) 10. (D)

11. (C) 12. (B) 13. (B) 14. (D) 15. (B)
16. (C) 17. (B) 18. (A) 19. (B) 20. (A)
21. (B) 22. (C) 23. (D) 24. (A) 25. (C)
26. (C) 27. (C) 28. (C) 29. (C) 30. (A)
31. (D) 32. (B) 33. (B) 34. (C) 35. (D)
36. (A) 37. (B) 38. (C) 39. (D) 40. (D)
41. (A) 42. (C) 43. (C) 44. (D) 45. (A)
46. (B) 47. (A) 48. (C) 49. (D) 50. (B)
51. (C) 52. (A) 53. (D) 54. (D) 55. (A)
56. (C) 57. (C) 58. (C) 59. (D) 60. (D
61. (D) 62. (D) 63. (A) 64. (B) 65. (B)
66. (A) 67. (C) 68. (D) 69. (A) 70. (C)
71. (A) 72. (A) 73. (A) 74. (D) 75. (C)
76. (D) 77. (D) 78. (C) 79. (A) 80. (D)
81. (A) 82. (A) 83. (B) 84. (B) 85. (C)
86. (A) 87. (A) 88. (A) 89. (A) 90. (A)
91. (D) 92. (C) 93. (A) 94. (B) 95. (A)
96. (A) 97. (A) 98. (A) 99. (B) 100. (B)

101. (A) 102. (A) 103. (B) 104. (D) 105. (A)
106. (A) 107. (A) 108. (B) 109. (C) 110. (C)
111. (A) 112. (A) 113. (C) 114. (B) 115. (A)
116. (B) 117. (B) 118. (D) 119. (A) 120. (A)
121. (B) 122. (A) 123. (C) 124. (C) 125. (A)
126. (B) 127. (C) 128. (D) 129. (A) 130. (C)
131. (B) 132. (D) 133. ( A) 134. (B) 135. (C)
136. (A) 137. (A) 138. (B) 139. (D) 140. (C)
141. (D) 142. (A) 143. (B) 144. (C) 145. (C)
146. (D) 147. (B) 148. (A) 149. (A) 150. (A)
151. (C) 152. (A) 153. (A) 154. (C) 155. (A)
156. (D) 157. (B) 158. (B) 159. (C) 160. (C)
161. (B) 162. (D) 163. (A) 164. (B) 165. (C)
166. (D) 167. (C) 168. (A) 169. (B) 170. (B)
171. (B) 172. (C) 173. (B) 174. (C) 175. (A)
176. (D) 177. (A) 178. (B) 179. (B) 180. (A)
181. (D) 182. (A) 183. (C) 184. (A) 185. (B)
186. (A) 187. (A) 188. (D) 189. (B) 190. (B)
191. (A) 192. (A) 193. (D) 194. (B) 195. (B)
196. (C) 197. (A) 198. (A) 199. (B) 200. (A)
201. (C) 202. (B) 203. (C) 204. (B) 205. (C)
206. (A) 207. (C) 208. (A) 209. (A) 210. (A)
211. (C) 212. (C) 213. (D) 214. (A) 215. (B)
216. (B) 217. () 218. (B) 219. (C) 220. (A)
221. (A) 222. (C) 223. (B) 224. (C) 225. (C)
226. (B) 227. (A) 228. (C) 229. (C) 230. (B)
231. (B) 232. (A) 233. (A) 234. (B) 235. (B)
236. (A) 237. (A) 238. (A) 239. (C) 240. (B)
241. (B) 242. (B) 243. (C) 244. (C) 245. (A)
246. (C) 247. (D) 248. (B) 249. (A) 250. (A)
251. (A) 252. (C) 253. (A) 254. (A) 255. (C)
256. (B) 257. (A) 258. (B) 259. (B) 260. (A)
261. (A) 262. (C) 263. (C) 264. (A) 265. (C)
266. (C) 267. (A) 268. (B) 269. (A) 270. (C)
271. (B) 272. (B) 273. (B) 274. (C) 275. (A)
276. (A) 277. (B) 278. (C)
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DATA STRUCTURES &

ALGORITHMS
1. Each data item in a record may be a group

item composed of sub-items; those items
which are indecomposable are called
(A) Elementary items
(B) Atoms
(C) Scalars
(D) All of above

2. Which of the following statement is false ?
(A) Arrays are dense lists and static data

structure
(B) Data elements in linked list need not be

stored in adjacent space in memory
(C) Pointers store the next data element of

a list
(D) Linked lists are collection of the nodes

that contain information part and next
pointer

3. Binary search algorithm cannot be applied
to
(A) Sorted binary trees
(B) Sorted linear array
(C) Pointer array
(D) Sorted linked list

4. When new data are to be inserted into a data
structure, but there is no available space;
this situation is usually called
(A) Housefull (B) Saturated
(C) Underflow (D) Overflow

5. The  situation  when  in  a  linked  list
START=NULL is
(A) Underflow (B) Overflow
(C) Housefull (D) Saturated

6. The following is two-way list
(A) Grounded header list
(B) Circular header list
(C) Linked list with header and trailer nodes
(D) None of above

7. The following name does not relate to stacks
(A) FIFO lists (B) LIFO list
(C) Piles (D) Push-down lists

8. In a binary tree, certain null entries are re-

placed by special pointers which point to

nodes higher in tree for efficiency. These

special pointers are called

(A) Leaf (B) Branch

(C) Path (D) Thread

9. In a graph if e=(u, v) means

(A) e begins at u and ends at v

(B) u is processor and v is successor

(C) both B and C are true

(D) none is true

10. If every node u in G is adjacent to every other

node v in G, A graph is said to be

(A) Isolated (B) Complete

(C) Finite (D) Strongly connected

11. A variable P is called pointer if

(A) P points to the address of first element

in DATA

(B) P can store only memory addresses

(C) P contain the DATA and the address of

DATA

(D) P contains the address of an element

in DATA.

12. The Worst case occur in linear search algo-

rithm when

(A) Item is not in the array at all

(B) Item is the last element in the array

(C) Item is the last element in the array or is

not there at all

(D) None of above

13. The Average case occur in linear search al-

gorithm

(A) When Item is somewhere in the middle

of the array

(B) When Item is not in the array at all

(C) When Item is the last element in the ar-

ray

(D) All the above
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14. The complexity of the average case of an
algorithm is
(A) Much more complicated to analyze than

that of worst case
(B) Much more simpler to analyze than that

of worst case

(C) Sometimes more complicated and

some other times simpler than that of

worst case

(D) None of the above

15. The following data structure allows deleting

data elements from front and inserting at rear

(A) Stacks (B) Queues

(C) Deques (D) Binary search tree

16. This data structure allows deletions at both

ends of the list but insertion at only one end.

(A) Input-restricted deque

(B) Output-restricted deque

(C) Priority queues

(D) None of the above

17. The following data structure is non-linear

type

(A) Strings (B) Lists

(C) Stacks (D) None of the above

18. The following data structure is linear type

(A) Strings (B) Lists

(C) Queues (D) All of the above

19. To represent hierarchical relationship be-

tween elements, the following data structure

is not suitable

(A) Deque (B) Priority

(C) Tree (D) All of above

20. A binary tree whose every node has either

zero or two children is called

(A) Complete binary tree

(B) Binary search tree

(C) Extended binary tree

(D) None of above

21. The depth of a complete binary tree is given

by

(A) D
n
 = n log

2
n (B) D

n
 = n log

2
n+1

(C) D
n
 = log

2
n (D) D

n
 = log

2
n+1

22. The complexity of Binary search algorithm is

(A) O(n) (B) O(log )

(C) O(n log n) (D) None of the above

23. The complexity of Bubble sort algorithm is

(A) O(n) (B) O (n2)

(C) O(n log n) (D) None of the above

24. When in order traversing a tree resulted E A

C K F H D B G; the preorder traversal would

return

(A) FAEKCDBHG (B) FAEKCDHGB

(C) EAFKHDCBG (D) FEAKDCHBG

25. When representing any algebraic expression

E the following  uses only binary operations

in a 2-tree
(A) the variable in E will appear as external

nodes and operations in internal nodes
(B) the operations in E will appear as exter-

nal nodes and variables in internal
nodes

(C) the variables and operations in E will
appear only in internal nodes

(D) None of the above

26. When converting binary tree into extended
binary tree, all the original nodes in binary
tree are
(A) internal nodes on extended tree
(B) external nodes on extended tree
(C) vanished on extended tree
(D) None of the above

27. The post order traversal of a binary tree is
DEBFCA. Find out the pre order traversal
(A) ABFCDE (B) ADBFEC
(C) ABDECF (D) None of the above

28. Which of the following data structure is lin-
ear data structure?
(A) Trees (B) Graphs
(C) Arrays (D) None of the above

29. The operation of processing each element
in the list is known as
(A) Merging (B) Inserting
(C) Traversal (D) All the above

30. Finding the location of the element with a
given value is called
(A) Traversal (B) Search
(C) Sort (D) All of  the above

31. Arrays are best data structures for
(A) relatively permanent collections of data
(B) the size of the structure and the data in

the structure are constantly changing
(C) both of above situation
(D) none of above situation

32. Linked lists are best suited for
(A) relatively permanent collections of data
(B) the size of the structure and the data in

the structure are constantly changing
(C) both of above situation
(D) none of above situation
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33. Each array declaration need not give, implicitly
or explicitly, the information about the

(A) name of array
(B) data type of array

(C) first data from the set to be stored
(D) index set of the array

34. The complexity of merge sort algorithm is

(A) O(n) (B) O(log n)
(C) O(n log n) (D) None of these

35. The indirect change of the values of a vari-
able in one module by another module is

called
(A) internal change

(B) inter-module change
(C) side effect

(D) all the above

36. Two main measures for the efficiency of an

algorithm are
(A) Time and space

(B) Processor and memory
(C) Complexity and capacity

(D) Data and space

37. The time factor when determining the effi-
ciency of algorithm is measured by

(A) Counting the number of key operations
(B) Counting the number of statements

(C) Counting the kilobytes of algorithm
(D) None of the above

38. The space factor when determining the effi-
ciency of algorithm is measured by

(A) Counting the maximum memory
needed by the algorithm

(B) Counting the minimum memory needed

by the algorithm

(C) Counting the average memory needed

by the algorithm

(D) Counting the maximum disk space

needed by the algorithm

39. All the above* Which of the following data

structures are indexed structures

(A) linear arrays (B) linked lists

(C) both of above (D) none of above

40. Which of the following is not the required

condition for binary search algorithm

(A) there must be mechanism to delete and/

or insert elements in list

(B) the list must be sorted

(C) there should be the direct access to the

middle element in any sublist

(D) none of the above

41. Which of the following is not a limitation of

binary search algorithm ?

(A) binary search algorithm is not efficient

when the data elements are more than

1000.

(B) must use a sorted array

(C) requirement of sorted array is expen-

sive when a lot of insertion and dele-

tions are needed

(D) there must be a mechanism to access

middle element directly

42. Two dimensional arrays are also called

(A) tables arrays

(B) matrix arrays

(C) both of the above

(D) none of the above

43. The term “push” and “pop” is related to the

(A) Array (B) Lists

(C) stacks (D) all of above

44. A data structure where elements can be

added or removed at either end but not in

the middle is referred as

(A) Linked lists (B) Stacks

(C) Queues (D) Deque

45. The following sorting algorithm is of divide-

and-conquer type

(A) Bubble sort (B) Insertion sort

(C) Quick sort (D) None of the above

46. An algorithm that calls itself directly or indi-

rectly is known as

(A) Recursion

(B) Polish notation

(C) Traversal algorithm

(D) None of the above

47. The elements of an array are stored suc-

cessively in memory cells because

(A) by this way computer can keep track only

the address of the first element and the

addresses of other elements can be

calculated

(B) the architecture of computer memory

does not allow arrays to store other than

serially

(C) A and B both false

(D) A and B both true

48. The memory address of the first element of

an array is called

(A) base address  (B) floor address

(C) foundation address (D) first address
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49. The memory address of fifth element of an

array can be calculated by the formula

(A) LOC(Array[5])=Base(Array[5])+(5-lower

boun(D), where w is the number of

words per memory cell for the array

(B) LOC(Array[5])=Base(Array[4])+(5-Upper

boun(D), where w is the number of

words per memory cell for the array

(C) LOC(Array[5]=Base(Array)+w(5-lower

boun(D), where w is the number of

words per memory cell for the array

(D) None of the above

50. The following data structure can’t store the

non-homogeneous data elements

(A) Arrays (B) Records

(C) Pointers (D) None of the above

51. The in order traversal of tree will yield a sorted

listing of elements of tree in

(A) Binary trees

(B) Binary search trees

(C) Heaps

(D) None of above

52. In a Heap tree values in a node is greater

than

(A) every value in left sub tree and smaller

than right sub tree
(B) every value in children of it
(C) Both of above conditions are true
(D) None of above conditions are true

53. In a graph if e=[u, v], Then u and v are called
(A) endpoints of e
(B) adjacent nodes
(C) neighbors
(D) all of  the above

54. A connected graph T without any cycles is
called
(A) tree graph (B) free tree
(C) tree (D) All of the above

55. The difference between linear array and a
record is
(A) An array is suitable for homogeneous

data but hte data items in a record may
have different data type

(B) In a record, there may not be a natural
ordering in opposed to linear array.

(C) A record form a hierarchical structure but
a linear array does not

(D) All of above

56. The following data structure store the ho-
mogeneous data elements
(A) Arrays (B) Records
(C) Pointers (D) None of the above

57. Which of the following data structure is not
linear data structure?
(A) Arrays    (B)  Linked lists
(C) A and B are true (D)  None is true

Answer Sheet
1. (D) 2. (C) 3. (D) 4. (D) 5. (A)
6. (D) 7. (A) 8. (D) 9. (C) 10. (B)

11. (D) 12. (C) 13. (A) 14. (A) 15. (B)
16. (A) 17. (D) 18. (D) 19. (C) 20. (C)
21. (D) 22. (B) 23. (B) 24. (B) 25. (A)
26. (A) 27. (C) 28. (C) 29. (C) 30. (B)
31. (A) 32. (B) 33. (C) 34. (C) 35. (C)
36. (A) 37. (A) 38. (A) 39. (A) 40. (A)
41. (A) 42. (C) 43. (C) 44. (D) 45. (B)
46. (A) 47. (A) 48. (A) 49. (C) 50. (A)
51. (B) 52. (B) 53. (D) 54. (D) 55. (D)
56. (B) 57. (C)
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DATA MINING AND DATA

WARE HOUSE
1. Adaptive system management is

(A) It uses machine-learning techniques.
Here program  can learn from past

experience and adapt themselves to
new situations

(B) Computational procedure that takes
some value as input and produces

some value as output.
(C) Science of making machines performs

tasks that would require intelligence
when performed by humans

(D) None of these

 2. Algorithm is

(A) It uses machine-learning techniques.
Here program  can learn from past

experience and adapt themselves to
new situations

(B) Computational procedure that takes
some value as input and produces

some value as output
(C) Science of making machines performs

tasks that would require intelligence
when performed by humans

(D) None of these

3. Background knowledge referred to

(A) Additional acquaintance used by a
learning algorithm to facilitate the

learning process
(B) A neural network that makes use of a

hidden layer.
(C) It is a form of automatic learning.

(D) None of these

4. Back propagation networks is
(A) Additional   acquaintance  used  by a

learning  algorithm  to  facilitate  the
learning process

(B) A neural network that makes use of a
hidden layer

(C) It is a form of automatic learning.
(D) None of these

5. Bayesian classifiers is

(A) A class of learning algorithm that tries

to find an optimum classification of a

set of examples using the probabilistic

theory.

(B) Any mechanism employed by a learning

system to constrain the search space

of a hypothesis.

(C) An approach to the design of learning

algorithms that is inspired by the fact

that when people encounter new

situations, they often explain them by

reference to familiar experiences,

adapting the explanations to fit the new

situation.

(D) None of these

6. Bias is

(A) A class of learning algorithm that tries

to find an optimum classification of a

set of examples using the probabilistic

theory.

(B) Any mechanism employed by a learning

system to constrain the search space

of a hypothesis.

(C) An approach to the design of learning

algorithms that is inspired by the fact

that when people encounter new

situations, they often explain them by

reference to familiar experiences,

adapting the explanations to fit the new

situation.

(D) None of these

7. Case-based learning is

(A) A class of learning algorithm that tries

to find an optimum classification of a

set of examples using the probabilistic

theory.

(B) Any mechanism employed by a learning

system to constrain the search space
of a hypothesis.
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(C) An approach to the design of learning
algorithms that is inspired by the fact
that when people encounter new
situations, they often explain them by
reference to familiar experiences,
adapting the explanations to fit the new
situation.

(D) None of these

8. Binary attribute are
(A) This takes only two values. In general,

these values will be 0 and 1 and they
can be coded as one bit

(B) The natural environment of a certain
species

(C) Systems that can be used without
knowledge of internal operations

(D) None of these

9. Biotope are
(A) This takes only two values. In general,

these values will be 0 and 1 and they
can be coded as one bit.

(B) The natural environment of a certain
species

(C) Systems that can be used without
knowledge of internal operations

(D) None of these

10. Black boxes
(A) This takes only two values. In general,

these values will be 0 and 1 and they
can be coded as one bit.

(B) The  natural  environment  of  a  certain
species

(C) Systems  that  can  be  used  without
knowledge of internal operations

(D) None of these

11. Artificial intelligence is
(A) It  uses  machine-learning  techniques.

Here  program  can  learn  from  past
experience and adapt themselves to
new situations

(B) Computational  procedure  that  takes
some  value  as  input  and  produces
some value as output.

(C) Science of making machines performs
tasks that would require intelligence
when performed by humans

(D) None of these

12. Cache is
(A) It is a memory buffer that is used to store

data  that  is  needed  frequently  by  an
algorithm  in  order  to  minimize  input/
output traffic

(B) The number of different values that a
given attribute can take

(C) A mathematical conception of space
where the location of a point is given by
reference to its distance from two or
three axes intersecting at right angles

(D) None of these

13. Cardinality of an attribute  is
(A) It is a memory buffer that is used to store

data that is needed frequently by an
algorithm in order to minimize input/
output traffic

(B) The number of different values that a
given attribute can take

(C) A mathematical conception of space
where the location of a point is given by
reference to its distance from two or
three axes intersecting at right angles

(D) None of these

14. Cartesian space is
(A) It is a memory buffer that is used to store

data that is needed frequently by an
algorithm in order to minimize input/
output traffic

(B) The number of different values that a
given attribute can take

(C) A mathematical conception of space
where the location of a point is given by
reference to its distance from two or
three axes intersecting at right angles

(D) None of these

15. Classification is
(A) A subdivision of a set of examples into a

number of classes
(B) A measure of the accuracy, of the

classification of a concept that is given
by a certain theory

(C) The  task of assigning a classification
to a set of  examples

(D) None of these

16. Classification accuracy is
(A) A subdivision of a set of examples into a

number of classes
(B) Measure of the accuracy, of the

classification of a concept that is given
by a certain theory

(C) The  task of assigning a classification
to a set of  examples

(D) None of these

17. Cluster is
(A) Group of similar objects that differ

significantly from other objects
(B) Operations on a database to transform

or simplify data in order to prepare it for
a machine-learning algorithm
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(C) Symbolic  representation  of  facts  or
ideas  from   which   information   can
potentially be extracted

(D) None of these

18. Data is
(A) Group of similar objects that differ

significantly from other objects
(B) Operations on a database to transform

or simplify data in order to prepare it for
a machine-learning algorithm

(C) Symbolic representation of facts or
ideas from which information can
potentially be extracte(D)

(D) None of these

19. A definition of a concept is——if it recognizes
all the instances of that concept.
(A) Complete (B) Consistent
(C) Constant (D) None of these

20. A definition or a concept is ———————if
it does not classify any examples as
coming within the concept
(A) Complete (B) Consistent
(C) Constant (D) None of these

21. Classification task referred to
(A) A subdivision of a set of examples into a

number of classes
(B) A measure of the accuracy, of the

classification of a concept that is given
by a certain theory

(C) The  task of assigning a classification
to a set of  examples

(D) None of these

22. Database  is
(A) Large collection of data mostly stored

in a computer system
(B) The   removal   of   noise   errors  and

incorrect input from a database
(C) The   systematic   description   of  the

syntactic    structure   of   a   specific
database. It describes the structure of
the attributes the tables and foreign key
relationships.

(D) None of these

23. Data cleaning is
(A) Large collection of data mostly stored

in a computer system
(B) The removal of noise errors and

incorrect input from a database
(C) The systematic description of the

syntactic structure of a specific
database. It describes the structure of
the attributes the tables and foreign key
relationships.

(D) None of these

24. Data dictionary is

(A) Large collection of data mostly stored

in a computer system

(B) The removal of noise errors and

incorrect input from a database

(C) The   systematic   description  of   the

syntactic    structure   of   a   specific

database. It describes the structure of

the attributes the tables and foreign key

relationships.

(D) None of these

25. Data mining is

(A) The   actual   discovery   phase  of  a

knowledge discovery process

(B) The stage of selecting the right data for

a KDD process

(C) A subject-oriented integrated time-

variant non-volatile collection of data in

support of management

(D) None of these

26. Data selection is

(A) The   actual   discovery   phase   of  a

knowledge discovery process

(B) The stage of selecting the right data for

a KDD process

(C) A subject-oriented integrated time-

variant non-volatile collection of data in

support of management

(D) None of these

27. Data warehouse is

(A) The   actual   discovery   phase  of  a

knowledge discovery process

(B) The stage of selecting the right data for

a KDD process

(C) A subject-oriented integrated time-

variant non-volatile collection of data in

support of management

(D) None of these

28. Coding is

(A)  Group of similar objects that differ

significantly from other objects

(B) Operations on a database to transform

or simplify data in order to prepare it for

a machine-learning algorithm

(C) Symbolic representation of facts or

ideas from which information can

potentially be extracted

(D) None of these
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29. DB/2 is
(A) A family of relational database manage-

ment systems marketed by IBM
(B) Interactive systems that enable decision

makers to use databases and models
on   a  computer  in  order  to  solve  ill-
structured problems

(C) It   consists  of  nodes  and  branches
starting  from  a  single  root  node.  Each
node represents a test, or decision.

(D) None of these

30. Decision support systems (DSS) is
(A) A family of relational database

management systems marketed by IBM
(B) Interactive systems that enable decision

makers to use databases and models
on a computer in order to solve ill-
structured problems

(C) It consists of nodes and branches
starting from a single root node. Each
node represents a test, or decision.

(D) None of these

31. Decision trees is
(A) A family of relational database

management systems marketed by IBM
(B) Interactive systems that enable decision

makers to use databases and models
on a computer in order to solve ill-
structured problems

(C) It consists of nodes and branches
starting from a single root node. Each
node represents a test, or decision.

(D) None of these

32. Deep knowledge referred to
(A) It  is hidden within a database and can

only be recovered if one is given certain
clues (an example IS encrypted
information)

(B) The process of executing implicit
previously unknown and potentially
useful information from dat(A)

(C) An extremely complex molecule that
occurs   in   human   chromosomes  and
that carries genetic information in the
form of genes.

(D) None of these

33. Discovery is
(A) It  is hidden within a database and can

only be recovered if one is given certain
clues (an example IS encrypted
information).

(B) The process of executing implicit
previously unknown and potentially
useful information from dat(A)

(C) An extremely complex molecule that
occurs in human chromosomes and
that carries genetic information in the
form of genes.

(D) None of these

34. DNA (Deoxyribonucleic acid)
(A) It  is hidden within a database and can

only be recovered if one is given certain
clues (an example IS encrypted
information).

(B) The process of executing implicit
previously unknown and potentially
useful information from dat (A)

(C) An extremely complex molecule that
occurs in human chromosomes and
that carries genetic information in the
form of genes.

(D) None of these

35. Enrichment is
(A) A stage of the KDD process in which

new data is added to the existing
selection

(B) The process of finding a solution for a
problem simply by enumerating all
possible solutions according to some
pre-defined order and then testing them.

(C) The distance between two points as
calculated using the Pythagoras
theorem.

(D) None of these

36. Enumeration is referred to
(A) A stage of the KDD process in which

new data is added to the existing
selection.

(B) The process of finding a solution for a
problem simply by enumerating all
possible solutions according to some
pre-defined order and then testing them

(C) The distance between two points as
calculated using the Pythagoras
theorem.

(D) None of these

37. Euclidean distance measure is
(A) A stage of the KDD process in which

new data is added to the existing
selection.

(B) The process of finding a solution for a
problem simply by enumerating all
possible solutions according to some
pre-defined order and then testing them.

(C) The distance between two points as
calculated using the Pythagoras theo-
rem

(D) None of these
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38. Heuristic is
(A) A   set   of   databases   from    different

vendors,   possibly   using   different
database paradigms

(B) An approach to a problem that is not
guaranteed to work but performs well in
most cases.

(C) Information that is hidden in a database
and that cannot be recovered by a
simple SQL query.

(D) None of these

39. Heterogeneous databases referred to
(A) A set of databases from different

vendors, possibly using different
database paradigms

(B) An approach to a problem that is not
guaranteed to work but performs well in
most cases.

(C) Information that is hidden in a database
and that cannot be recovered by a
simple SQL query.

(D) None of these

40. Hidden knowledge referred to
(A) A set of databases from different

vendors, possibly using different
database paradigms

(B) An approach to a problem that is not
guaranteed to work but performs well in
most cases.

(C) Information that is hidden in a database
and that cannot be recovered by a
simple SQL query.

(D) None of these

41. Hybrid is
(A) Combining different types of method or

information
(B) Approach to the design of learning

algorithms that is structured along the
lines of the theory of evolution.

(C) Decision support systems that contain
an Information base filled with the
knowledge of an expert formulated in
terms of  if-then  rules.

(D) None of these

42. Evolutionary computation  is
(A) Combining different types of method or

information
(B) Approach to the design of learning

algorithms that is structured along the
lines of the theory of evolution.

(C) Decision support systems that contain
an Information base filled with the
knowledge of an expert formulated in
terms of  if-then  rules.

(D) None of these

43. Expert systems
(A) Combining different types of method or

information
(B) Approach to the design of learning

algorithms that is structured along the
lines of the theory of evolution.

(C) Decision support systems that contain
an Information base filled with the
knowledge of an expert formulated in
terms of  if-then  rules

(D) None of these

44. Extendible architecture is
(A) Modular design of a software application

that facilitates the integration of new
modules

(B) Showing a universal law or rule to be
invalid by providing a counter example

(C) A set of attributes in a database table
that refers to data in another table

(D) None of these

45. Falsification is
(A) Modular design of a software application

that facilitates the integration of new
modules

(B) Showing a universal law or rule to be
invalid by providing a counter example

(C) A set of attributes in a database table
that refers to data in another table

(D) None of these

46. Foreign key is
(A) Modular design of a software application

that facilitates the integration of new
modules

(B) Showing a universal law or rule to be
invalid by providing a counter example

(C) A set of attributes in a database table
that refers to data in another table

(D) None of these

47. Hybrid learning  is
(A) Machine-learning involving different

techniques
(B) The learning algorithmic analyzes the

examples on a systematic basis and
makes incremental adjustments to the
theory that is learned

(C) Learning by generalizing from examples
(D) None of these

48. Incremental learning referred to
(A) Machine-learning involving different

techniques
(B) The learning algorithmic analyzes the

examples on a systematic basis and
makes incremental adjustments to the
theory that is learned
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(C) Learning by generalizing from examples
(D) None of these

49. Information content is
(A) The amount of information with in data

as opposed to the amount of redundancy
or noise

(B) One of the defining aspects of a data
warehouse

(C) Restriction that requires data in one
column of a database table to the a sub-
set of another-column.

(D) None of these

50. Inclusion dependencies
(A) The amount of information with in data

as opposed to the amount of redundancy
or noise

(B) One of the defining aspects of a data
warehouse

(C) Restriction that requires data in one
column of a database table to the a sub-
set of another-column

(D) None of these

51. KDD (Knowledge Discovery in Databases)
is referred to
(A) Non-trivial extraction of implicit

previously unknown and potentially
useful information from dat(A)

(B) Set of columns in a database table that
can be used to identify each record
within this table uniquely.

(C) collection of interesting and useful
patterns in a database

(D) none of these

52. Key is referred to
(A) Non-trivial extraction of implicit

previously unknown and potentially
useful  information from dat(A)

(B) Set of columns in a database table that
can be used to identify each record
within this table uniquely

(C) collection of interesting and useful
patterns in a database

(D) none of these

53. Inductive learning is
(A) Machine-learning   involving  different

techniques
(B) The learning algorithmic analyzes the

examples  on  a  systematic  basis  and
makes incremental adjustments to the
theory that is learned

(C) Learning by generalizing from examples
(D) None of these

54. Integrated is
(A) The amount of information with in data

as opposed to the amount of redundancy
or noise

(B) One of the defining aspects of a data
warehouse

(C) Restriction that requires data in one
column of a database table to the a sub-
set of another-column.

(D) None of these

55. Knowledge engineering is
(A) The process of finding the right formal

representation of a certain body of
knowledge in order to represent it in a
knowledge-based system

(B) It automatically maps an external signal
space into a system’s internal
representational space. They are useful
in the performance of classification
tasks.

(C) A process where an individual learns
how to carry out a certain task when
making a transition from a
situation in which the task cannot be
carried out to a situation in which the
same task under the same
circumstances can be carried out.

(D) None of these

56. Kohonen self-organizing map referred to
(A) The process of finding the right formal

representation of a certain body of
knowledge in order to represent it in a
knowledge-based system

(B) It automatically maps an external signal
space into a system’s internal
representational space. They are useful
in the performance of classification
tasks

(C) A process where an individual learns
how to carry out a certain task when
making a transition from a
situation in which the task cannot be
carried out to a situation in which the
same task under the same
circumstances can be carried out.

(D) None of these

57. Learning is
(A) The process of finding the right formal

representation of a certain body of
knowledge in order to represent it in a
knowledge-based system

(B) It automatically maps an external signal
space into a system’s internal
representational space. They are useful
in the performance of classification tasks.
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(C) A process where an individual learns
how to carry out a certain task when
making a transition from a situation in
which the task cannot be carried out to
a situation in which the same task under
the same circumstances can be carried
out.

(D) None of these

58. Learning algorithm referrers to
(A) An algorithm that can learn
(B) A sub-discipline of computer science

that deals with the design and
implementation of learning algorithms.

(C) A machine-learning approach that
abstracts from the actual strategy of an
individual algorithm and can therefore
be applied to any other form of machine
learning.

(D) None of these

59. Meta-learning is
(A) An algorithm that can learn
(B) A sub-discipline of computer science

that deals with the design and
implementation of learning algorithms.

(C) A machine-learning approach that
abstracts from the actual strategy of an
individual algorithm and can therefore
be applied to any other form of machine
learning.

(D) None of these

60. Machine learning is
(A) An algorithm that can learn
(B) A sub-discipline of computer science

that deals with the design and
implementation of learning algorithms.

(C) An approach that abstracts from the
actual strategy of an individual algorithm
and can therefore be applied to any other
form of machine learning.

(D) None of these

61. Inductive logic programming is
(A) A class of learning algorithms that try to

derive a Prolog program from examples*
(B) A table with n independent attributes can

be seen as an n- dimensional space.
(C) A prediction made using an extremely

simple method, such as always
predicting the same output.

(D) None of these

62. Multi-dimensional knowledge is
(A) A class of learning algorithms that try to

derive a Prolog program from examples
(B) A table with n independent attributes can

be seen as an n- dimensional space

(C) A prediction made using an extremely
simple method, such as always
predicting the same output.

(D) None of these

63. Naive prediction is
(A) A class of learning algorithms that try to

derive a Prolog program from examples
(B) A table with n independent attributes can

be seen as an n- dimensional space.
(C) A prediction made using an extremely

simple method, such as always
predicting the same output.

(D) None of these

64. Knowledge is referred to
(A) Non-trivial    extraction   of   implicit

previously   unknown   and  potentially
useful  information from dat(A)

(B) Set of columns in a database table that
can be used to identify each record
within this table uniquely.

(C) collection   of   interesting   and  useful
patterns in a database

(D) none of these

65. Node is
(A) A component of a network
(B) In the context of KDD and data mining,

this refers to random errors in a
database table.

(C) One of the defining aspects of a data
warehouse

(D) None of these

66. Projection pursuit  is
(A) The result of the application of a theory

or a rule in a specific case
(B) One of several possible enters within a

database table that is chosen by the
designer as the primary means of
accessing the data in the table.

(C) Discipline in statistics that studies ways
to find the most interesting projections
of multi-dimensional spaces

(D) None of these

67. Statistical significance is
(A) The science of collecting, organizing,

and applying numerical facts
(B) Measure of the probability that a certain

hypothesis is incorrect given certain
observations.

(C) One of the defining aspects of a data
warehouse, which is specially built
around all the existing applications of
the operational dat(A)

(D) None of these
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68. Prediction is
(A) The result of the application of a theory

or a rule in a specific case
(B) One of several possible enters within a

database table that is chosen by the
designer as the primary means of
accessing the data in the table.

(C) Discipline in statistics that studies ways
to find the most interesting projections
of multi-dimensional spaces.

(D) None of these

69. Primary key is
(A) The result of the application of a theory

or a rule in a specific case
(B) One of several possible enters within a

database table that is chosen by the
designer as the primary means of
accessing the data in the table

(C) Discipline in statistics that studies ways
to find the most interesting projections
of multi-dimensional spaces.

(D) None of these

70. Noise is
(A) A component of a network
(B) In the context of KDD and data mining,

this   refers   to   random   errors   in   a
database table.

(C) One of the defining aspects of a data
warehouse

(D) None of these

71. Quadratic complexity is
(A) A reference to the speed of an algorithm,

which is quadratically dependent on the
size of the dat(A)

(B) Attributes of a database table that can
take only numerical values.

(C) Tools designed to query a database.
(D) None of these

72. Query tools are
(A) A reference to the speed of an algorithm,

which is quadratically dependent on the
size of the dat(A)

(B) Attributes of a database table that can
take only numerical values.

(C) Tools designed to query a database.
(D) None of these

73. Prolog is
(A) A   programming   language   based  on

logic
(B) A computer  where each processor has

its own operating system, its own
memory, and its own hard disk.

(C) Describes the structure of the contents
of a database.

(D) None of these

74. Massively parallel machine is
(A) A programming language based on logic
(B) A computer  where each processor has

its   own   operating   system,   its   own
memory, and its own hard disk

(C) Describes the structure of the contents
of a database.

(D) None of these

75. Meta-data is
(A) A   programming    language    based   on

logic
(B) A computer  where each processor has

its   own   operating   system,   its  own
memory, and its own hard disk.

(C) Describes the structure of the contents
of a database

(D) None of these

76. n(log n) is referred to
(A) A    measure   of   the   desired  maximal

complexity of data mining algorithms
(B) A database containing volatile data used

for the daily operation of an organization
(C) Relational database management

system
(D) None of these

77. Operational database is
(A) A    measure    of    the    desired   maximal

complexity of data mining algorithms
(B) A database containing volatile data used

for the daily operation of an organization
(C) Relational     database     management

system
(D) None of these

78. Oracle is referred to
(A) A   measure   of   the   desired   maximal

complexity of data mining algorithms
(B) A database containing volatile data used

for the daily operation of an organization
(C) Relational     database    management

system
(D) None of these

79. Paradigm is
(A) General   class   of   approaches   to   a

problem.
(B) Performing      several     computations

simultaneously.
(C) Structures in a database those are

statistically relevant.
(D) Simple forerunner of modern neural

networks, without hidden layers.
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80. Patterns is
(A) General   class   of   approaches   to   a

problem.
(B) Performing several computations

simultaneously.
(C) Structures in a database those are

statistically relevant
(D) Simple forerunner of modern neural

networks, without hidden layers.

81. Parallelism is
(A) General   class   of   approaches   to   a

problem.
(B) Performing     several    computations

simultaneously
(C) Structures   in  a  database  those  are

statistically relevant.
(D) Simple forerunner of modern neural

networks, without hidden layers.

82. Perceptron is
(A) General class of approaches to a

problem.
(B) Performing several computations

simultaneously.
(C) Structures in a database those are

statistically relevant.
(D) Simple forerunner of modern neural

networks, without hidden layers.

83. Shallow knowledge
(A) The large set of candidate solutions

possible for a problem
(B) The information stored in a database

that can be, retrieved with a single query.
(C) Worth of the output of a machine-

learning program that makes it under-
standable for humans

(D) None of these

84. Statistics
(A) The science of collecting, organizing,

and applying numerical facts
(B) Measure of the probability that a certain

hypothesis is incorrect given certain
observations.

(C) One of the defining aspects of a data
warehouse, which is specially built
around all the existing applications of
the operational dat(A)

(D) None of these

85. Subject orientation
(A) The science of collecting, organizing,

and applying numerical facts
(B) Measure of the probability that a certain

hypothesis is incorrect given certain
observations.

(C) One  of  the  defining  aspects  of  a  data

warehouse,   which  is   specially   built

around all the existing applications of

the operational dat(A)

(D) None of these

86. Search space

(A) The  large  set  of  candidate  solutions

possible for a problem

(B) The information stored in a database

that can be, retrieved with a single query.

(C) Worth  of  the  output  of  a    machine-

learning    program    that    makes   it

understandable for humans

(D) None of these

87. Transparency

(A) The large set of candidate solutions

possible for a problem

(B) The  information  stored  in  a  database

that can be, retrieved with a single query.

(C) Worth   of  the  output  of  a  machine-

learning program  that  makes  it  under-

standable for humans

(D) None of these

88. Quantitative attributes are

(A) A reference to the speed of an algorithm,

which is quadratically dependent on the

size of the dat(A)

(B) Attributes of a database table that can

take only numerical values.

(C) Tools designed to query a database.

(D) None of these

89. Unsupervised algorithms

(A) It  do not need the control of the human

operator during their execution.

(B) An arrow in a multi-dimensional space.

It is a quantity usually characterized by

an ordered set of scalars.

(C) The validation of a theory on the basis

of a finite number of examples.

(D) None of these

90. Vector

(A) It  do not need the control of the human

operator during their execution.

(B) An arrow in a multi-dimensional space.

It is a quantity usually characterized by

an ordered set of scalars.

(C) The validation of a theory on the basis

of a finite number of examples.

(D) None of these
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91. Verification

(A) It  does not need the control of the

human operator during their execution.

(B) An arrow in a multi-dimensional space.

It is a quantity usually characterized by

an ordered set of scalars.

(C) The validation of a theory on the basis

of a finite number of examples

(D) None of these

92. Visualization techniques are

(A) A class of graphic techniques used to

visualize the contents of a database

(B) The division of a certain space into

various areas based on guide points.

(C) A branch that connects one node to

another

(D) None of these

93. Voronoi diagram

(A) A class of graphic techniques used to

visualize the contents of a database

(B) The division of a certain space into

various areas based on guide points.

(C) A branch that connects one node to

another

(D) None of these

94. Synapse is
(A) A class of graphic techniques used to

visualize the contents of a database
(B) The division of a certain space into

various areas based on guide points.
(C) A branch that connects one node to

another
(D) None of these

Answer Sheet

1. (A) 2. (B) 3. (A) 4. (B) 5. (A)
6. (B) 7. (C) 8. (A) 9. (B) 10. (C)

11. (C) 12. (A) 13. (B) 14. (A) 15. (A)
16. (B) 17. (A) 18. (C) 19. (A) 20. (B)
21. (C) 22. (A) 23. (B) 24. (C) 25. (A)
26. (B) 27. (C) 28. (B) 29. (A) 30. (B)
31. (C) 32. (A) 33. (B) 34. (C) 35. (A)
36. (B) 37. (C) 38. (B) 39. (A) 40. (C)
41. (A) 42. (B) 43. (C) 44. (A) 45. (B)
46. (C) 47. (A) 48. (B) 49. (A) 50. (C)
51. (A) 52. (B) 53. (C) 54. (B) 55. (A)
56. (B) 57. (C) 58. (A) 59. (C) 60. (B)
61. (A) 62. (B) 63. (C) 64. (C) 65. (A)
66. (C) 67. (B) 68. (A) 69. (B) 70. (B)
71. (A) 72. (C) 73. (A) 74. (B) 75. (C)
76. (A) 77. (B) 78. (C) 79. (A) 80. (C)
81. (B) 82. (D) 83. (B) 84. (A) 85. (C)
86. (A) 87. (C) 88. (B) 89. (A) 90. (B)
91. (C) 92. (A) 93. (B) 94. (C)

yoursmahboob.wordpress.com
        (shared by Sujoy)



M.C.Qs. on Computer  |  125

ELECTRONICS DATA PROCESSING

1. The  computers  communicate  by  sending
each other small ————of data
(A) Packets (B) Bags
(C) Bunch (D) None of these

2. Every computer in the network can
communicate
(A) directly with every other computer in the

network
(B) indirectly with  other computer in the

network
(C) only to some computers in network
(D) none of these

3. Every computer in a  network has a network
address, often called a
(A) hardware address
(B) software address
(C) computer address
(D) none of these

4. A computer can be joined to more than one
network through
(A) Gateways (B) Passages
(C) Connector (D) None of these

5. The examples of TCP/IP are
(A) HTTP (Hyper-Text Transfer Protocol)
(B) FTP (File Tranfer Protocol),
(C) SSH (Secure SHell)
(D) All the above

6. It refers to a particular family of standards for
expressing the structured data that represent
electronic commerce transactions; and
‘electronic auctions for a particular set of
mechanisms for setting prices.
(A) Electronic data interchange (EDI)
(B) Electronic Publishing
(C) Electronic Services Delivery (ES(D)
(D) None of these

7. Electronic Business  referred to
(A) The    conduct   of   business   with  the

assistance of telecommunications and
telecommunications-based tools

(B) The conduct of commerce in goods and
services,    with    the    assistance   of
telecommunications and telecommuni-
cations-based tools

(C) It refers to means whereby sellers can
communicate their offerings to potential

buyers.
(D) None of these

8. Electronic Commerce  referred to
(A) The   conduct   of   business   with   the

assistance of telecommunications and
telecommunications-based tools

(B) The conduct of  commerce in goods and
services,     with    the   assistance   of

telecommunications and telecommuni-
cations-based tools

(C) It refers to means whereby sellers can
communicate their offerings to potential

buyers.
(D) None of these

9. Electronic catalogues referred to
(A) The conduct of business with the

assistance of telecommunications and
telecommunications-based tools

(B) The conduct of commerce in goods and
services, with the assistance of

telecommunications and telecommuni-
cations-based tools

(C) It refers to means whereby sellers can
communicate their offerings to potential

buyers
(D) None of these

10. It is an electronic commerce in digital goods
and services, intended for consumption by

the human senses.  It encompasses a
range of formats, including text, structured

data, image, raster/bit-map and vector,
moving image (animation and video), sound,

and  combinations  of  the   above  (multi-
medi(A).

(A) Electronic data interchange (EDI)
(B) Electronic Publishing

(C) Electronic Services Delivery (ESD)
(D) None of these
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11. It is an electronic commerce in services, i.e.
the provision of services with the assistance
of telecommunications and telecommunica-
tions-based tools. It excludes traffic in
physical goods, and hence is concerned with
applications of electronic business where,
at least in principle, the entire activity can be
performed electronically.
(A) Electronic data interchange (EDI)
(B) Electronic Publishing
(C) Electronic Services Delivery (ES(D)
(D) None of these

12. In The Pre-Contractual Phase
(A) the buyer and seller are concerned with

the gathering of market intelligence
(B) a formal relationship is established

between buyer and seller, including
terms and conditions to be applied to
transactions under the contract.

(C) this involves the placement and
processing of purchase orders (or, in
contractual terms, an offer), and
acknowledgement by the seller of its
preparedness to deliver (in contractual
terms, an acceptance).

(D) deals with the delivery of goods and/or
the performance of services. In addition,
some post-delivery functions may be
involved, in particular inspection, and
acceptance or rejection.

13. In Contractual Phase
(A) the buyer and seller are concerned with

the gathering of market intelligence.
(B) a formal relationship is established

between buyer and seller, including
terms and conditions to be applied to
transactions under the contract.

(C) this involves the placement and
processing of purchase orders (or, in
contractual terms, an offer), and
acknowledgement by the seller of its
preparedness to deliver (in contractual
terms, an acceptance).

(D) deals with the delivery of goods and/or
the performance of services. In addition,
some post-delivery functions may be
involved, in particular inspection, and
acceptance or rejection.

14. A physical item is one which may be delivered
or performed
(A) entirely through a telecommunications

network
(B) involves logistical activities such as the

transportation of goods, or of the person
and/or facilities whereby the service will
be performed

15. In Ordering Phase
(A) the buyer and seller are concerned with

the gathering of market intelligence.
(B) a formal relationship is established

between buyer and seller, including
terms and conditions to be applied to
transactions under the contract.

(C) this involves the placement and
processing of purchase orders (or, in
contractual terms, an offer), and
acknowledgement by the seller of its
preparedness to deliver (in contractual
terms, an acceptance).

(D) deals with the delivery of goods and/or
the performance of services. In addition,
some post-delivery functions may be
involved, in particular inspection, and
acceptance or rejection.

16. Services are referred as
(A) an identifiable physical entity
(B) an act, which is ‘performed’.
(C) (A) and (B) both false
(D) (A) and (B) both true

17. In Logistics Phase
(A) the buyer and seller are concerned with

the gathering of market intelligence.
(B) a formal relationship is established

between buyer and seller, including
terms and conditions to be applied to
transactions under the contract.

(C) this involves the placement and
processing of purchase orders (or, in
contractual terms, an offer), and
acknowledgement by the seller of its
preparedness to deliver (in contractual
terms, an acceptance).

(D) deals with the delivery of goods and/or
the performance of services. In addition,
some post-delivery functions may be
involved, in particular inspection, and
acceptance or rejection.

18. In Settlement Phase
(A) the goods or services are paid for.

Relevant transactions include invoicing,
payment authorisation, payment, and
remittance advice transmission.

(B) the buyer and seller are concerned with
the gathering of market intelligence.

(C) a formal relationship is established
between buyer and seller, including
terms and conditions to be applied to
transactions under the contract.
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(D) this   involves   the   placement   and
processing of purchase orders (or, in
contractual  terms,  an  offer),  and
acknowledgement by the seller of its
preparedness to deliver (in contractual
terms, an acceptance).

19. Goods are referred as
(A) an identifiable physical entity
(B) an act, which is ‘performed’
(C) (A) and (B) both true
(D) None is true

20. A digital item is one which may be delivered
or performed
(A) entirely through a telecommunications

network
(B) involves logistical activities such as the

transportation of goods, or of the person
and/or facilities whereby the service will
be performed

(C) (A) and (B) both false
(D) None is true

21.  An audio-CD is

(A) a physical good

(B) a digital good

(C) (A) is false, (B) is true

(D) (A) and (B) both true

22. An audio-file downloaded over the Internet

is

(A) a physical good

(B) a digital good

(C) (A) is true, (B) is false

(D) (A) and (B) both true

Answer Sheet

1. (A) 2. (A) 3. (A) 4. (A) 5. (D)
6. (A) 7. (A) 8. (B) 9. (C) 10. (B)

11. (C) 12. (A) 13. (B) 14. (B) 15. (C)
16. (B) 17. (D) 18. (A) 19. (A) 20. (A)
21. (A) 22. (B)

yoursmahboob.wordpress.com
        (shared by Sujoy)



128  |  M.C.Qs. on Computer

PARALLEL COMPUTING

1. It   is   the   simultaneous   use   of  multiple
compute resources to solve a computational
problem
(A) Parallel computing
(B) Single processing
(C) Sequential computing
(D) None of these

2. Parallel Execution
(A) A sequential execution of a program,

one statement at a time
(B) Execution of a program by more than

one task, with each task being able to
execute the same or different statement
at the same moment in time

(C) A program or set of instructions that is
executed by a processor.

(D) None of these

3. Scalability  refers to a parallel system’s
(hardware and/or software) ability
(A) To demonstrate a proportionate

increase in parallel speedup with the
removal  of some  processors

(B) To demonstrate a proportionate
increase in parallel speedup with the
addition of more processors

(C) To demonstrate a proportionate
decrease  in parallel speedup with the
addition of more processors

(D) None of these

4. Parallel computing can include
(A) Single     computer    with   multiple

processors
(B) Arbitrary number of computers connec-

ted by a network
(C) Combination of both A and B
(D) None of these

5. Serial Execution
(A) A sequential execution of a program,

one statement at a time
(B) Execution of a program by more than

one task, with each task being able to
execute the same or different statement
at the same moment in time

(C) A program or set of instructions that is
executed by a processor.

(D) None of these

6. Shared Memory is
(A) A  computer  architecture  where  all

processors  have  direct   access  to
common physical memory

(B) It refers to network based memory
access for physical memory that is not
common.

(C) Parallel tasks typically need to exchange
dat(A) There are several ways this can
be accomplished, such as through, a
shared memory bus or over a network,
however the actual event of data
exchange is commonly referred to as
communications regardless of the
method employe(D)

(D) None of these

7. Distributed Memory
(A) A computer architecture where all

processors have direct  access to
common physical memory

(B) It refers to network based memory
access for physical memory that is not
common

(C) Parallel tasks typically need to exchange
dat(A) There are several ways this can
be accomplished, such as through, a
shared memory bus or over a network,
however the actual event of data
exchange is commonly referred to as
communications regardless of the
method employe(D)

(D) None of these

8. Parallel Overhead is
(A) Observed speedup of a code which has

been parallelized, defined as: wall-clock
time of serial execution and wall-clock
time of parallel execution

(B) The amount of time required to coordi-
nate parallel tasks. It includes factors
such as: Task start-up time, Synchro-
nizations, Data communications.
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(C) Refers to the hardware that comprises
a given parallel system - having many
processors

(D) None of these

9. Massively Parallel
(A) Observed speedup of a code which has

been parallelized, defined as: wall-clock
time of serial execution and wall-clock
time of parallel execution

(B) The amount of time required to coordinate
parallel tasks. It includes factors such as:
Task start-up time, Synchronizations, Data
communications.

(C) Refers to the hardware that comprises
a given parallel system - having many
processors

(D) None of these

10. Fine-grain Parallelism is
(A) In parallel computing, it is a qualitative

measure  of  the  ratio  of  computation
to communication

(B) Here   relatively   small   amounts   of
computational work are done between
communication events

(C) Relatively     large     amounts     of
computational    work    are    done
between communication / synchroni-
zation events

(D) None of these

11. In shared Memory
(A) Changes in a memory location effected

by one processor do not affect all other
processors.

(B) Changes in a memory location effected
by one processor are visible to all other
processors

(C) Changes in a memory location effected
by one processor are randomly visible
to all other processors.

(D) None of these

12. In shared Memory:
(A) Here all processors access, all memory

as global address space
(B) Here all processors have individual

memory
(C) Here   some    processors     access,   all

memory as global address space and
some not

(D) None of these

13. In shared Memory
(A) Multiple    processors     can    operate

independently    but    share    the    same
memory resources

(B) Multiple    processors    can   operate
independently   but   do   not   share   the
same memory resources

(C) Multiple    processors    can   operate
independently but some do not  share
the same memory resources

(D) None of these

14. In designing a parallel program, one has
to break the problem into discreet chunks
of work that can be distributed to multiple
tasks. This is known as
(A) Decomposition (B) Partitioning
(C) Compounding (D) Both A and B

15. Latency is
(A) Partitioning in that the data associated

with a problem is decompose(D) Each
parallel task then works on a portion of
the dat(A)

(B) Partitioning in that, the focus is on the
computation   that   is  to  be  performed
rather than on the data manipulated by
the   computation.   The   problem   is
decomposed according to the work that
must be done. Each task then performs
a portion of the overall work.

(C) It  is the time it takes to send a minimal
(0 byte) message from one  point to
other point

(D) None of these

16. Domain Decomposition
(A) Partitioning in that the data associated

with a problem is decompose(D) Each
parallel task then works on a portion of
the dat(A)

(B) Partitioning in that, the focus is on the
computation that is to be performed
rather than on the data manipulated by
the computation. The problem is
decomposed according to the work that
must be done. Each task then performs
a portion of the overall work.

(C) It is the time it takes to send a minimal (0
byte) message from point A to point (B)

(D) None of these

17. Functional Decomposition:
(A) Partitioning in that the data associated

with a problem is decompose(D) Each
parallel task then works on a portion of
the dat(A)

(B) Partitioning in that, the focus is on the
computation that is to be performed
rather than on the data manipulated by
the  computation.  The  problem  is
decomposed according to the work that
must be done. Each task then performs
a portion of the overall work.
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(C) It is the time it takes to send a minimal (0
byte) message from point A to point (B)

(D) None of these

18. Synchronous communications
(A) It require some type of “handshaking”

between tasks that are sharing dat(A)
This can be explicitly structured in code
by the programmer, or it may happen at
a lower level unknown to the pro-
grammer.

(B) It involves data sharing between more
than two tasks, which are often specified
as being members in a common group,
or collective.

(C) It involves two tasks with one task acting
as the sender/producer of data, and the
other acting as the receiver/consumer.

(D) It allows tasks to transfer data
independently from one another.

19. Collective communication
(A) It involves data sharing between more

than two tasks, which are often specified
as being members in a common group,
or collective.

(B) It involves two tasks with one task acting
as the sender/producer of data, and the
other acting as the receiver/consumer.

(C) It allows tasks to transfer data
independently from one another.

(D) None of these

20. Point-to-point communication referred to
(A) It involves data sharing between more

than two tasks, which are often specified
as being members in a common group,
or collective.

(B) It involves two tasks with one task acting
as the sender/producer of data, and the
other acting as the receiver/consumer.*

(C) It allows tasks to transfer data
independently from one another.

(D) None of these

21. Uniform Memory Access (UMA) referred to
(A) Here al l  processors have equal

access and access times to memory
(B) Here i f  one processor updates a

location in shared memory, all the
other processors know about the
update.

(C) Here one SMP can directly access
memory of another SMP and not all
processors have equal access time
to all memories

(D) None of these

22. Asynchronous communications
(A) It involves data sharing between more

than two tasks, which are often specified
as being members in a common group,
or collective.

(B) It involves two tasks with one task acting
as the sender/producer of data, and the
other acting as the receiver/consumer.

(C) It allows tasks to transfer data
independently from one another.

(D) None of these

23. Granularity is
(A) In parallel computing, it is a qualitative

measure of the ratio of computation
to communication

(B) Here relat ively small  amounts of
computat ional work are done
between communication events

(C) Relatively large amounts of computa-
tional  work  are  done  between
communication    /   synchronization
events

(D) None of these

24. Coarse-grain Parallelism
(A) In parallel computing, it is a qualitative

measure of the ratio of computation
to communication

(B) Here   relatively   small   amounts  of
computational work are done between
communication events

(C) Relatively large amounts of computa-
t ional work are done between
communication     /   synchronization
events

(D) None of these

25. Cache Coherent UMA (CC-UMA) is
(A) Here   all   processors  have  equal

access   and   access times to memory
(B) Here if   one   processor   updates   a

location in shared memory, all the
other   processors   know   about   the
update.

(C) Here one SMP can directly access
memory of another SMP and not all
processors have equal access time
to all memories

(D) None of these

26. Non-Uniform Memory Access (NUMA) is
(A) Here   all   processors   have   equal

access and access times to memory
(B) Here   if   one   processor   updates   a

location  in  shared  memory,  all  the
other  processors  know  about  the
update.
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(C) Here one SMP can directly access
memory of another SMP and not all
processors have equal access time
to all memories

(D) None of these

27. It distinguishes multi-processor computer
architectures according to how they can be
classified along the two independent
dimensions of Instruction and Dat(A) Each
of these dimensions can have only one of
two possible states: Single or Multiple.
(A) Single Program Multiple Data (SPMD)
(B) Flynn’s taxonomy
(C) Von Neumann Architecture
(D) None of these

28. In the threads model of  paral le l
programming
(A) A single process can have multiple,

concurrent execution paths
(B) A single process can have single,

concurrent execution paths.
(C) A multiple process can have single

concurrent execution paths.
(D) None of these

29. These applications typically have multiple
executable object files (programs). While the
application is being run in parallel, each task
can be executing the same or different
program as other tasks. All tasks may use
different data
(A) Single Program Multiple Data (SPMD)
(B) Multiple Program Multiple Data (MPMD)
(C) Von Neumann Architecture
(D) None of these

30. Here a single program is executed by all
tasks simultaneously. At any moment in time,
tasks can be executing the same or different
instructions within the same program. These
programs usually have the necessary logic
programmed into them to allow different
tasks to branch or conditionally execute only
those parts of the program they are designed
to execute.
(A) Single Program Multiple Data (SPMD)
(B) Multiple Program Multiple Data (MPMD)
(C) Von Neumann Architecture
(D) None of these

31. These computer uses the stored-program
concept. Memory is used to store both
program and data instructions and central
processing unit (CPU) gets instructions and/
or data from memory. CPU, decodes the

instructions and then sequentially performs
them.
(A) Single Program Multiple Data (SPMD)
(B) Flynn’s taxonomy
(C) Von Neumann Architecture
(D) None of these

32. Load balancing is
(A) Involves only those tasks executing a

communication operation
(B) It exists between program statements

when the order of statement execution
affects the results of the program.

(C) It refers to the practice of distributing
work among tasks so that all tasks are
kept busy all of the time. It can be
considered as minimization of task idle
time.

(D) None of these

33. Synchronous communication operations
referred to
(A) Involves only those tasks executing a

communication operation
(B) It exists between program statements

when the order of statement execution
affects the results of the program.

(C) It refers to the practice of distributing
work among tasks so that all tasks are
kept busy all of the time. It can be
considered as minimization of task idle
time.

(D) None of these

34. Data dependence is
(A) Involves only those tasks executing a

communication operation
(B) It exists between program statements

when the order of statement execution
affects the results of the program.

(C) It refers to the practice of distributing
work among tasks so that all tasks are
kept busy all of the time. It can be
considered as minimization of task idle
time.

(D) None of these

Answer Sheet

1. (A) 2. (B) 3. (B) 4. (C) 5. (A)
6. (A) 7. (B) 8. (B) 9. (B) 10. (B)

11. (B) 12. (A) 13. (A) 14. (D) 15. (C)
16. (A) 17. (B) 18. (A) 19. (A) 20. (B)
21. (A) 22. (C) 23. (A) 24. (C) 25. (B)
26. (C) 27. (B) 28. (A) 29. (B) 30. (A)
31. (C) 32. (C) 33. (A) 34. (B)
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WINDOW PROGRAMMING

1. Frames is
(A) the exterior of a window.
(B) the interior of a frame window.
(C) windows used for input/output that are

placed on a panel window
(D) None of these

2. Panels is
(A) the exterior of a window.
(B) the interior of a frame window
(C) windows used for input/output that are

placed on a panel window
(D) None of these

3. Controls are
(A) the exterior of a window.
(B) the interior of a frame window.
(C) windows used for input/output that are

placed on a panel window
(D) None of these

4. In frame windows
(A) One can put another frame windows
(B) One can not put another frame windows

5. A panel window is a window
(A) which can only exist inside a frame win-

dow
(B) which can not exist inside a frame win-

dow
(C) which can exist outside the frame win-

dow
(D) none of these

6. These exist ——— panel windows inside
the same frame window.
(A) Several (B) Only one
(C) None (D) None of these

7. Button in window programming
(A) displays text and can be clicked with the

mouse or spacebar
(B) a checkmark which the user can select
(C) a list from which one item can be se-

lected.
(D) area in which text may be entered.

8. Checkbox in window programming
(A) displays text and can be clicked with the

mouse or spacebar
(B) a checkmark which the user can select
(C) a list from which one item can be se-

lected.
(D) area in which text may be entered.

9. Combobox in window programming
(A) displays text and can be clicked with the

mouse or spacebar
(B) a checkmark which the user can select
(C) a list from which one item can be se-

lected.
(D) area in which text may be entered.

10.  Edit in window programming
(A) displays text and can be clicked with the

mouse or spacebar
(B) a checkmark which the user can select
(C) a list from which one item can be se-

lected.
(D) area in which text may be entered

11.  Groupbox in window programming
(A) does nothing except draw a rectangle, it

is used to visually group controls to-
gether

(B) displays text
(C) for input of multiple lines of text
(D) none of these

12. Label in window programming
(A) does nothing except draw a rectangle, it

is used to visually group controls to-
gether

(B) displays text
(C) for input of multiple lines of text
(D) none of these

13. Memo in window programming
(A) does nothing except draw a rectangle, it

is used to visually group controls to-
gether

(B) displays text
(C) for input of multiple lines of text
(D) none of these
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14. All the classes necessary for Windows pro-
gramming are in the module
(A) win.txt (B) win.std
(C) win.main (D) none of these

15. Window class,  onCreate/1 ,defines
(A) is executed when a visible window is

being created
(B) is executed when a window is being

closed, it is possible to prevent the win-
dow from closing

(C) when the background of a window must
be erased this event is executed

(D) when a window must be re-painted this
event is executed

16. Window class, on Close/2
(A) is executed when a visible window is

being created
(B) is executed when a window is being

closed, it is possible to prevent the win-
dow from closing

(C) when the background of a window must
be erased this event is executed

(D) when a window must be re-painted this
event is executed

17. Window class, onEraseBackground/1, de-
fines
(A) is executed when a visible window is

being created
(B) is executed when a window is being

closed, it is possible to prevent the win-
dow from closing

(C) when the background of a window must
be erased this event is executed

(D) when a window must be re-painted this
event is executed

18. Window class, onPaint/2, defines
(A) is executed when a visible window is

being created
(B) is executed when a window is being

closed, it is possible to prevent the win-
dow from closing

(C) when the background of a window must
be erased this event is executed

(D) when a window must be re-painted this
event is executed

19. Window class, onShow/2, defines
(A) is executed when a window is becom-

ing visible or is being hidden
(B) when a window is being disabled or en-

abled this event is executed
(C) this event is executed when the user

switches to another window of the same
application

(D) when a window receives the keyboard
focus this event is executed

20. Window class, onActivate/2, defines
(A) is executed when a window is becom-

ing visible or is being hidden
(B) when a window is being disabled or en-

abled this event is executed
(C) this event is executed when the user

switches to another window of the same
application

(D) when a window receives the keyboard
focus this event is executed

21. Window class, onEnable/1, defines

(A) is executed when a window is becom-
ing visible or is being hidden

(B) when a window is being disabled or en-
abled this event is executed

(C) this event is executed when the user
switches to another window of the same

application
(D) when a window receives the keyboard

focus this event is executed

22. Window class, onKBFocus/3, defines

(A) is executed when a window is becom-
ing visible or is being hidden

(B) when a window is being disabled or en-
abled this event is executed

(C) this event is executed when the user
switches to another window of the same

application
(D) when a window receives the keyboard

focus this event is executed

23. Window class, onSetCursor/3, defines

(A) the window wants to know what cursor
it must display for the mouse pointer

(B) the mouse is moved over a window
(C) when a mouse button is pressed this

event is executed
(D) a mouse button is released

24. Window class, onMouseMove/5 , defines

(A) the window wants to know what cursor
it must display for the mouse pointer

(B) the mouse is moved over a window
(C) when a mouse button is pressed this

event is executed
(D) a mouse button is released

25. Window class, onMouseDown/5, defines
(A) the window wants to know what cursor

it must display for the mouse pointer
(B) the mouse is moved over a window
(C) when a mouse button is pressed this

event is executed
(D) a mouse button is released
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26. Window class, onMouseUp/5 , defines

(A) the window wants to know what cursor

it must display for the mouse pointer

(B) the mouse is moved over a window

(C) when a mouse button is pressed this

event is executed

(D) a mouse button is released

27. Window class, onMouseDoubleClick/5, de-

fines

(A) a mouse button was double clicked

(B) the user clicks on a window

(C) a key on the keyboard is pressed

(D) a key on the keyboard is released

28. Window class, onClick/1, defines

(A) a mouse button was double clicked

(B) the user clicks on a window

(C) a key on the keyboard is pressed

(D) a key on the keyboard is released

29. Window class, onKeyDown/3 , defines

(A) a mouse button was double clicked

(B) the user clicks on a window

(C) a key on the keyboard is pressed

(D) a key on the keyboard is released

30. Window class, onKeyUp/3, defines

(A) a key on the keyboard is pressed

(B) a key on the keyboard is released

(C) a mouse button was double clicked

(D) the user clicks on a window

31. Window class, onChar/3, defines

(A) during the processing of a key this event

is executed with the ASCII value of the

key pressed

(B) a menu command was selected

(C) a menu item is selected

(D) a window was resized

32. Window class, onCommand/2, defines

(A) during the processing of a key this event

is executed with the ASCII value of the

key pressed

(B) a menu command was selected

(C) a menu item is selected

(D) a window was resized

33. Window class, onMenuSelect/2, defines

(A) during the processing of a key this event

is executed with the ASCII value of the

key pressed

(B) a menu command was selected

(C) a menu item is selected

(D) a window was resized

34. Window class, onSize/2, defines
(A) during the processing of a key this event

is executed with the ASCII value of the
key pressed

(B) a menu command was selected
(C) a menu item is selected

(D) a window was resized

35. Window class, onMove/2, defines
(A) a window is moved to a new position

(B) the user wants to view a floating popup
menu for the window

(C) an event from the vertical scrollbar of
the window

(D) an event from the horizontal scrollbar of
the window

36. Window class, onInitPopupMenu/2, defines
(A) a window is moved to a new position

(B) the user wants to view a floating popup
menu for the window

(C) an event from the vertical scrollbar of
the window

(D) an event from the horizontal scrollbar of
the window

37. Window class, onVScroll/3, defines
(A) a window is moved to a new position

(B) the user wants to view a floating popup
menu for the window

(C) an event from the vertical scrollbar of
the window

(D) an event from the horizontal scrollbar of
the window

38. Window class, onHScroll/3, defines

(A) a window is moved to a new position
(B) the user wants to view a floating popup

menu for the window
(C) an event from the vertical scrollbar of

the window
(D) an event from the horizontal scrollbar of

the window

39. SizerClient in window programming ?

(A) this type of sizer ensures that a panel
window  fills  the  complete  client  rect-

angle of a frame window
(B) this sizer class makes a panel ‘stick’ to

one side of a frame window and  the
size of the panel window is a fixed num-
ber of pixels.

(C) this sizer ensures that a panel window
is percentage of the size of a frame win-
dow.

(D) None of these
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40. SizerFixed in window programming
(A) this type of sizer ensures that a panel

window fills the complete client rect-
angle of a frame window

(B) this sizer class makes a panel ‘stick’ to
one side of a frame window and  the
size of the panel window is a fixed num-
ber of pixels

(C) this sizer ensures that a panel window
is percentage of the size of a frame win-
dow.

(D) None of these

41.  SizerPercent  in window programming
(A) this type of sizer ensures that a panel

window fills the complete client rect-
angle of a frame window

(B) this sizer class makes a panel ‘stick’ to
one side of a frame window and  the
size of the panel window is a fixed num-
ber of pixels.

(C) this sizer ensures that a panel window

is percentage of the size of a frame win-

dow.

(D) None of these

Answer Sheet

1. (A) 2. (B) 3. (C) 4. (A) 5. (A)

6. (A) 7. (A) 8. (B) 9. (C) 10. (D)

11. (A) 12. (B) 13. (C) 14. (A) 15. (A)

16. (B) 17. (C) 18. (D) 19. (A) 20. (C)

21. (B) 22. (D) 23. (A) 24. (B) 25. (C)

26. (D) 27. (A) 28. (B) 29. (C) 30. (B)

31. (A) 32. (B) 33. (C) 34. (D) 35. (A)

36. (B) 37. (C) 38. (D) 39. (A) 40. (B)

41. (C)
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DATA BASE MANAGEMENT

SYSTEM (DBMS)
1. The following  term applies to a collection of

related records in a database
(A) File (B) Layout
(C) File (D) Field

2. This set of related data items is known as a
(A) File (B) Record
(C) Table (D) None of the above

3. The   framework   for   storing   records   in
database is a
(A) Form (B) Report
(C) Query (D) Table

4. The following  command is used to search
the record that satisfies the specified criteria
(A) FOUND (B) SEARCH
(C) GET (D) LOCATE

5. The data in a record is of the following types
(A) four text fields and three numeric fields
(B) two integer fields and five text fields
(C) three text fields and four numeric fields
(D) none of the above

6. A treelike structure of records in a database.
Select the best fit for answer
(A) Hierarchical database structure
(B) Relational database structure
(C) Multidimensional database structure
(D) Sequential database access

7. The following  language used by most of the
DBMSs for helping their users to access
data
(A) High level language
(B) Query language
(C) SQL
(D) 4GL

8. What is a largest collection of data stored in
a computer? You might use this type of
program to keep a record of all the friends in
your address book.
(A) Information Processing
(B) Spreadsheet
(C) Operating system
(D) Database

9. Which command is used to replace ?
(A) REPLACE
(B) REPLACE ALL
(C) Add record from edit menu
(D) All of above

10. The following part of a database that holds
only one type of information
(A) Report (B) Query
(C) Record (D) Field

11. All of the following terms are related to
computerized databases except which one?
(A) Search (B) Sort
(C) Field names (D) Record grab

12. Need   to   see  all  the  information from  two
tables on one form. Insert
(A) A page break
(B) A subform
(C) A linked command button
(D) None of the above

13. What is the primary difference between a pivot
table report and a cross tab query?
(A) A pivot table report can contain sums,

counts, and averages while a cross tab
query cannot.

(B) You can’t pivot a cross tab query
(C) A cross tab query lets you group similar

items. A pitot table report does not
(D) None of above

14. The largest unit of a database is
(A) A record (B) A field
(C) A subfield (D) None of above

15. What’s the best Access object for an invoice
you’ll mail to customers?
(A) A report (B) A form
(C) A table (D) All of the above

16. What is a Grouped Report?
(A) A type of report that can be generated by

the Report Wizard
(B) A report that displays data that has been

sorted in ascending or descending order
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(C) A report that displays data grouped by
fields you specify

(D) None

17. Which field allow to select items from drop
down list?
(A) An OLE field (B) A Memo Field
(C) A lookup Field (D) A hyperlink field

18. What did the first Table Analyzer do?
(A) Analyze the data in a set of flat files and

automatically    create    a   relational
database system from that information

(B) Provide  a  graphic  way  to  design
relational databases

(C) Automate process of connecting tables
to SQL Server

(D) None

19. Pivot Table reports are good for
(A) Analyzing large amounts of data
(B) Turning tables upside down
(C) Breaking spreadsheet data into multiple

worksheet
(D) None of above

20. Which of the following are common ways to
enforce data validation when entering data
into an Access form?
(A) Create an input mask to restrict the kind

of value that can be entered in positions
across the field.

(B) Define a validation rule for that field
(C) A and B
(D) none of the above

21. The purpose of the Add-in Manager is to
(A) Create macros and automate data

processing
(B) Add or remove data in an existing

database
(C) Add or remove templates, macros, and

wizards
(D) All of above

22. Sub-schema can be used to
(A) Create very different, personalized views

of the same data
(B) Present information in different formats
(C) Hide sensitive information by omitting

fields from the subschema’s description
(D) All of the above

23. If you are entering data in a form, a quick way
to cpy a value from the previous record is to
press
(A) Ctrl+’ (B) F6
(C) Ctrl+D (D) None of the above

24. DBMS is
(A) Collection of data
(B) Set of programs to access those data
(C) Set of programs to update those data
(D) All of the above

25. COPY STRUCTURE command is used to
(A) Copy contents of an active database to

a new file
(B) Copy all records of an active database

to disk
(C) Copy contents of an active database to

disk
(D) Copy structure of an active database to

a new file

26. COUNT command is used to
(A) Count the number of data fields in an

active database file
(B) Count the number of data files which

are active
(C) Count the records which are updated
(D) Count the number of records in an active

database file

27. What is the term to ask the computer to pt
information in order numerically or
alphabetically ?
(A) Crop (B) Report
(C) Sort (D) Organize

28. The raw facts are called
(A) Data (B) Programs
(C) Commands (D) Responses

29. The  term refers to a collection of related
information
(A) Database (B) List
(C) Outline (D) Record

30. A form that is used to collect data in a
structured manner for entry to a database is
called a
(A) Database deign form
(B) Systems flowchart
(C) Data capture form
(D) None of above

31. The following command is used for inserting
records
(A) INSERT
(B) ADD
(C) Both of the above
(D) None of the above

32. The Query is a statement requesting for
(A) Insertion of information
(B) Deletion of information
(C) Update of information
(D) Retrieval of information
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33. The activity of a file
(A) Is  a  low  percentages  of  number  of

records added or deleted from a file
(B) If high, reduces processing efficiency for

sequential and non sequential files
(C) Is  a  measure  of  the  percentage  of

existing records updated during a run
(D) Refers to how closely the files fit into the

allocated

34. The following statement is not valid about
indexing
(A) it stores the index fields
(B) it   stores   the   corresponding  record

number
(C) it maintains the alphabetically order
(D) it duplicate the database file

35. The following devices can  be used to input
data into a database
(A) Keyboard, fax roller ball
(B) Mouse, keyboard, monitor
(C) Mouse, keyboard, touch screen
(D) None of the above

36. The following  command is used for sorting
(A) list (B) browse
(C) index (D) sort

37. List command is used to get
(A) List of database contents
(B) List of database contents
(C) List of variables used in database file
(D) None of the above

38. A field that uniquely identifies a record is
called a
(A) Main field (B) Header
(C) Key field (D) None of above

39. Corrupted index file is corrected using
(A) Modifyindex (B) Recreateindex
(C) Reindex (D) None of the above

40. The navigation buttons enable you to
(A) move from record to record in a table or

form
(B) move from page to page in report
(C) (A) and (B) both
(D) None of the above

41. Different levels of access are assigned to
personnel records in the health and fitness
gym. Only the system manager is able to
create delete or edit records. Certain other
personnel are allowed to view all the records,
whereas others are not permitted to view
complete records. The levels of access are
controlled by
(A) Password (B) User id’s
(C) Status (D) None of the  above

42. You  can  switch  back  and  forth  between
design and datasheet view by clicking the
(A) queries object tab
(B) switch command on the view menu
(C) view button
(D) select query title bar

43. The table wizard
(A) Quickly creates a default report
(B) Displays  a  subset  of  the  data  in  a

database
(C) Contains sample tables and fields you

can use to create a table
(D) Automatically edits your data as you

enter it

44. The names, address, and account balance
of all of your customers, select the best fit for
answer
(A) record (B) file
(C) database (D) key field

45. An integrated collection of all of the data
about your customers. Select the best fit for
answer
(A) Record (B) File
(C) Database (D) Key field

46. An identification field in a record. Select the
best fit for answer
(A) Record (B) File
(C) Database (D) Key field

47. What is part of database that holds all of the
information about one item or subject?
(A) Record (B) File
(C) Query (D) Chart

48. What is a stored question about information
in a database?
(A) Record (B) Field
(C) Report (D) Query

49. RDBMS stands for
(A) Relational Database Management

System
(B) Relation Data Module System
(C) Right Data Base Management System
(D) None of the above

50. Pack command is used to
(A) Remove records permanently
(B) Remove records temporarily
(C) Restore records permanently
(D) Restore records temporarily

51. Modules are
(A) selection   of   commands  used   to

automate repetitive tasks
(B) programs written in Visual C++
(C) Object tabs
(D) Group of records
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52. APPEND command is used to
(A) Add record to the end of active database

file and starts full screen data entry
(B) Add Record to the start of active

database file
(C) Add record to the start of active database

file and starts full screen data entry
(D) Add record to the end of database file

53. Append from command is used to
(A) Add records from information in an array
(B) Adds records from a file
(C) Add records from a variable
(D) Add records from stock

54. Examples    of   centralized    multi-user
databases are
(A) Barclays’ Bank customer accounts
(B) Supermarket stock control, organ donor

database, client database
(C) Airline reservations and other national

global booking systems
(D) None of above

55. New record is added using
(A) Append record from browse menu
(B) Append record into from browse menu
(C) Add record from edit menu
(D) All of above

56. When a customer makes an online hotel
booking, the database is updated in
(A) Batch mode (B) Pseudo real-time
(C) One month (D) All of above

57. A database that contains tables linked by
common fields is called a
(A) Centralized database
(B) Flat file database
(C) Relational database
(D) None of above

58. The use of integrated collections of database
records and files for data storage and
processing. The best fit for answer:
(A) Database management approach
(B) DBMS uses
(C) Database administrator
(D) Query language

59. DBMS allows you to create, interrogate, and
maintain a database, create reports, and
develop application programs, select the
best fit answer
(A) Database management approach
(B) DBBMS uses
(C) Database administrator
(D) Query language

60. A specialist in charge of the database of an

organization select the best fit for answer

(A) Database management approach

(B) DBMS uses

(C) Database administrator

(D) Query language

61. This DBMS feature allows users to easily

interrogate a database. Select the best fit for

answer

(A) Database management approach

(B) DBMS uses

(C) Database administrator

(D) Query language

62. The ….. presents data in a way similar to an

excel spreadsheet

(A) Datasheet view (B) Design view

(C) Print preview (D) Layout preview

63. It  Is used to build and modify database

objects and also to create new queries

(A) Datasheet view (B) Design view

(C) Print preview (D) Layout preview

64. It shows the appearance and layout of a

report, table or form in order to confirm what

will be printed.

(A) Datasheet view (B) Design view

(C) Print preview (D) Layout preview

65. It examines a small portion or sample of your

data in a report before printing it.

(A) Datasheet view (B) Design view

(C) Print preview (D) Layout preview

66. A report form

(A) Appears on the computer monitor during

data entry

(B) Is used during report generation to

format data

(C) Both (A) and (B)

(D) All of above

67. Which of the following columns can not be

found in the macro design window?

(A) Arguments column

(B) Comment column

(C) Conditions column

(D) Actions column

68. The ascending order of a data hierarchy ios:

(A) Bit, byte, field, record, file, database

(B) Bit, byte, record, field, file, database

(C) Byte, bit, field, record, file, database

(D) Byte, bit, record, field, file, database
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69. A good query system
(A) Can accept English language

commands
(B) Allows non-programmers to access

information stored in a database
(C) Can be accessed only by data prssing

professionals
(D) Both (A) and (B)

70. How do you freeze a field a column or field in
Microsoft Access?
(A) Click anywhere in the column and select

Edit>Freeze Column form the menu
(B) Place an ice cube in the column
(C) Click anywhere in the column and click

the freeze button on the toolbar
(D) Right click the column and select freeze

columns from the shortcut menu

71. Within Table Datasheet view, how can you
display associated records from another
table?
(A) Click the expand indicator (+) next to a

record
(B) Double click the record.
(C) Apply the filter by form command
(D) None of the above

72. Which of the following is not a command to
find specific word or phrases in a database?
(A) Click the find button on the toolbar
(B) Click the find button on the record

navigation button area
(C) Press Ctrl+F
(D) Select Edit>Find from the menu.

73. One of the type libraries that you can use to
programmatically connect to Microsoft
Access data is
(A) Collaborative Data Objects
(B) ActiveX Data Objects
(C) Dynamic Data Interfaces
(D) None of the above

74. The data in a Pivot Table report is categorized
using
(A) Column headings
(B) Items from the Pivot Table field list
(C) Header rows
(D) All of above

75. Records are deleted using
(A) DELETE command followed by pack
(B) DELETE command without pack
(C) DELETE command followed by zap
(D) DELETE  command without zap

76. You can enter data in a table in
(A) design view (B) datasheet view
(C) format view (D) None of the above

77. Creating a data file means
(A) Designing base and defining the

structure of the database
(B) Getting the information about database
(C) Selecting data from database
(D) Deleting data from database

78. In a large DBMS
(A) each user can “see” only a small part of

the entire database
(B) each user can access every

subschema
(C) each subschema contains every field

in the logical schema
(D) none of the above is true

79. You want to keep track of addresses, phone
numbers, parent/guardian names as well
as class attendance, average and grades.
Every so often you want to send reports home
that select failing grades and excessive
absences. The following of the Microsoft
Office suit used in this course is best suited
for this kind of information
(A) Excel (B) PowerPoint
(C) Access (D) Word

80. Each individual data items of record is called a
(A) Field (B) Data type
(C) Comment (D) All of the above

81. A large collections of files are called
(A) Fields (B) Records
(C) Databases (D) File system

82. Memo field in database file is used to
(A) Store lengthy number
(B) Store images
(C) Store audio files
(D) Store long textual information

83. Applications that rely on databases are
(A) Supermarket stock control, theater

bookings and payroll
(B) Accounts, online banking, PowerPoint

presentations
(C) Internet shopping, robotics, computer

games
(D) None of above

84. Which  of  the  following  is  not  a  Access
database object ?
(A) table (B) form
(C) query (D) datasheet

85. Data owners must protect their data against
corruption or loss. One sensible method to
achieving this is to
(A) Take regular backups
(B) Keep a hardcopy printout of all data
(C) Keep fingers crossed at all times
(D) None of above
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86. Facilities offered by databases are
(A) The ability to store a large amount of

data in a structured format, easy update,
sort, query, production of reports

(B) Easy   editing,   spell   check,   perform
calculations,  library  of  mathematical
functions, replication

(C) The ability to rotate images, copy and
paste, fill scale

(D) None of above

87. Users who store data about real people for
marketing purposes must register the data
and its potential use with
(A) The computer misuse controller
(B) The data protection controller
(C) HM customs and excise
(D) None of above

88. When you double click a query object, you
open
(A) The object in design view
(B) The object in print preview
(C) The result of the query
(D) The underlying table on which the query

is based

89. Checks that are added to databases to detect
unsuitable data on inpt are called
(A) validation (B) verification
(C) vegetation (D) none of above

90. Auto Report allows you to
(A) View a subset of your data
(B) Create a simple report
(C) Create a data entry form
(D) Enter records

91. Auto Form allows you to
(A) View a subset of your data
(B) Create a simple report
(C) Create a data entry form
(D) Enter records

92. The  asterisk (*)  is  sometimes  used  in
database queries. This character is then
called a
(A) Wildcard (B) Dummy
(C) Ditto (D) All of the above

93. When performing a look-up operation using
a form
(A) You enter the search value into the form
(B) You look at each form sequentially until

you see the one you want
(C) You type the key in an entry line, and the

correct form is displayed
(D) All of the above

94. Which custom date format displays the
numeric day of the year when a date is
entered?
(A) YY (B) YYYY
(C) Y (D) All of above

95. When you save an Access project, what file
format do you use?
(A) .adp (B) .xm.
(C) .mdb (D) All of above

96. Which of the following criterion would find
records whose personality field does not
equal “Nice”?
(A) <>Nice (B) NOT Nice
(C) <>”Nice” (D) IS NOT Nice

97. What is the maximum character field size
you can set for a field that has a text data
type?
(A) 64 (B) 255
(C) 512 (D) All of above

98. Which of the following fields would not make
a suitable primary key ?
(A) A date field
(B) An invoice number
(C) An autoNumber field
(D) A customer’s social security number

99. Auto reports can contain each of the
following elements except
(A) A detail section   (B) A page footer
(C) A group header (D) All of the above

100. What is the abbreviation used for a software
package that permits the user to create,
retrieve and maintain records in a database?
(A) DASD (B) FMS
(C) EMMS (D) DBMS

101. A repository for data, usually covering some
specific topic is called
(A) Data acquisition (B)Data bank
(C) Real time   (D) Database

102. A notation for defining the form and structure
of data is known as
(A) Data description language
(B) Binary language
(C) Data channels
(D) Data definition language

103. A data item, which is not broken down into
smaller units, is
(A) Data element
(B) Elementary data item
(C) Data entry
(D) Database management

104. Which of the following terms refers to the
degree to which data in database system
are accurate and correct?
(A) Data security  (B) Data validaity
(C) Data independence (D) Data integrity

105. A repository for data, usually covering specific
topic is
(A) Database (B) Data requisition
(C) Data bank (D) Data collection
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106. A set of programs that handle firm’s data
base responsibilities is called a
(A) Database Management System (DBMS)
(B) Database Processing System (DBPS)
(C) Data Management System (DMS)
(D) All of above

107. Which of the following is not a relational
database?
(A) dBase IV (B) 4th Dimension
(C) FoxPro (D) Reflex

108. Which is used to provide the sight
information to the right person at the right
time for proper decision making ?
(A) DBMS (B) MIS
(C) ISO (D) PSO

109. Dbase-III was developed by
(A) Dec (B) IBM
(C) Ashton-tate (D) All of the above

110. Which of the following database objects asks
a question of information in a database and
then displays the result?
(A) Tables (B) Reports
(C) Queries (D) Forms

111. What data type should you choose for a zip
code field in a table?
(A) Text (B) Number
(C) Memo (D) All of above

112. A list consists of last names, first names,
address and pin codes if all people in the
list have the same last and the same pin
code, a useful key would be
(A) The pin code
(B) The last name
(C) A compound key consisting of the first

name and the last name
(D) All of the above

113. What happens when you add the asterisk (()
from any field list ot a query?
(A) The table will not include any fields from

the table
(B) The query sorts the table’s record in the

order you specify
(C) The query will include every field from

the table*
(D) The query uses the records from the

table without displaying them

114. The modify operation is likely to be done after
(A) delete (B) look up
(C) insert (D) all of above

115. The criteria BETWEEN 1/1/99 and 12/31/99
would which is proper
(A) Display records between the dates 1/2/

99 and 1/1/00
(B) Display records between the dates 1/1/

99 and 12/31/99
(C) Display records whose dates equaled

1/1/99 or 12/31/99
(D) All of the above

116. DDP stands for
(A) Distributed Double Processing
(B) Double Decimal Processing
(C) Distributed Data Programming
(D) Distributed Data Processing

117. To see sales amount figures totaled, into
which drop area would you drag that field?
(A) Drop column fields here
(B) Drop row fields here
(C) Drop data items here
(D) None of the above

118. Which access feature do you use to develop
applications that host access data on the
web?
(A) Dynamic web data
(B) Data access pates
(C) Html data pages
(D) None of the above

119. What is the common name for a column of
data within an Access table?
(A) Field (B) Record
(C) Row (D) None of the above

120. A data structure consisting of several fields,
some or all of which are instances of the
same data structure, is called
(A) Field (B) Bead
(C) Database (D) Data collection

121. A group of characters used to identiry a given
low level instruction is
(A) File (B) Record
(C) Key field (D) Label

122. One or more characters used to identify a
data field in a computer program is
(A) File name (B) Database
(C) Label (D) Group

123. In Form view, which command displays
records alphabetically?
(A) Find (B) Advanced Filter/Sort
(C) Sort (D) All of the above

124. Where do report and forms get their
information form?
(A) Forms (B) Modules
(C) Tables (D) Queries

125. The number of logical records in a physical
record is
(A) group (B) blocking factor
(C) sector (D) field

126. A top to bottom relationship among the items
in a database is established by a
(A) Hierarchical schema
(B) Network Schema
(C) Relational schema
(D) All of the above

yoursmahboob.wordpress.com
        (shared by Sujoy)



M.C.Qs. on Computer  |  143

127. A command that lets you cange one or more
fields in a record is
(A) Insert (B) Modify
(C) Look up (D) All of the above

128. A logical schema
(A) Is the entire database
(B) Is a standard way of organizing

information into accessible parts
(C) Describes how data is actually stored

on disk
(D) All of the above

129. What is the purpose of the page field on a
pivot table report?
(A) It creates a new page for each type of

data
(B) It allows the data within the the Pivot

Table report to be filtered
(C) It displays a title for the Pivot Table report
(D) None of the above

130. What does the Special Effect button on the
formatting toolbar do?
(A) It lets you add animation to your forms

and reports to make them more
entertaining and amusing

(B) It lets you select a transitional effect for
how a form opens and closes.

(C) It applies a 30d effect to a selected
control

(D) None of these

131. Pivot Table report data must meet which of
the following criteria?
(A) It must be in tabular form, have unique

column labels, and each row must
represent a unique piece of data

(B) Any dates should be formatted with the
data format and blank rows or columns
should be removed

(C) It must be in tabular form, have unique
column lagels, and all rows must be
sorted

(D) Both (A) and (B)

132. Customers, Orders. What’s their best
relationship?
(A) Many-to-many (B) One-to-one
(C) One-to-many (D) All of the above

133. Which control does access use to link data
access page components to access data?
(A) Microsoft Dynamic Data Control
(B) Microsoft Data Connection Control
(C) Microsoft Office Data Source Control
(D) None of the above

134. Which program do you use to edit code for
data access pages?
(A) Microsoft script editor
(B) Microsoft code editor
(C) Microsoft data access pages editor
(D) None of above

135. The way a particular application views the
data from the database that the applicaton
uses is a
(A) Module (B) Relational model
(C) Schema (D) Sub-schema

136. Which of the following is a database
management system?
(A) Ms-Word (B) Lotus 1-2-3
(C) Oracle (D) None of above

137. What is the corresponding text for the <#1/1/
95# validation rule setting?
(A) Neter a value less or more than 1,195
(B) Value must be less than 95 characters
(C) Enter a date before 1995
(D) All of above

138. What is the name of the Visual Basic Editor
utility that allows you to view the Microsoft
Access type library’s available objects and
members?
(A) Object Viewer   (B) Object Browser
(C) Type Library Spy (D) None of above

139. A computer language for informing the DBMS
regarding the data structure used is
(A) PASCAL (B) DDL
(C) PROLOG (D) FORTRAN

140. Which of the following is not a data type ?
(A) Picture/graphic (B) Data/time
(C) Texst (D) Number

141. The executive responsible for the data
processing function in an organization is
(A) PM (B) DBMS
(C) DP (D) DPM

142. Which of the following is NOT a type of
Microsoft Access database object?
(A) Queries (B) Workbooks
(C) Forms (D) Tables

143. A file containing relatively permanent data is
(A) Random file (B) Transaction file
(C) Master file (D) Sequential file

144. The complete picture of data stored in
database is known as
(A) Record (B) Scheme
(C) System flowchart (D) DBMS

145. A subset of characters within a data field is
known as
(A) Record (B) File
(C) Data string (D) Byte

146. Data items groped together for storage
purposes are called a
(A) Record (B) Title
(C) List (D) string

147. Which of the following terms does not
describe a database structure used by a
DBMS to link data from several files?
(A) Relational (B) Structural
(C) Network (D) All of the above
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148. In a relational schema, each tuple is divided
into fields called
(A) Relations (B) Domains
(C) Queries (D) All of the above

149. How do you filter by selection?
(A) Right click the field value and select filter

by selection from the shortcut menu
(B) Find and double click the value on which

you want to base the filter
(C) Find and select the value on which you

want to base the filter and select
tools>filter by selection from the menu

(D) None of the above

150. What is a fast way to adjust the width of a
column?
(A) Right click the left side of the column

heading
(B) Double click the left side of the column

heading
(C) Double click the right side of the column

heading
(D) Select tools>adjust column width from

the menu

151. What are the columns in a Microsoft Access
table called?
(A) Rows (B) Fields
(C) Cells (D) Records

152. How do you update Pivot Table report data
after changes are made to the source data?
(A) Save your changes, close the workbook,

and then reopen it.
(B) Select the Pivot Table worksheet and

press F9 on the keyboard
(C) Click the report, and on the Pivot Table

toolbar, click the refresh data button
(D) All of the above

153. In access, the best types of queries to use
for data analysis are:
(A) Select queries (B) Parameter queries
(C) Action queries (D) All of the above

154. How can you add a table to the relationship
window?
(A) Select Tools>Add table from the menu
(B) Select the table from the table list on the

toolbar
(D) Click the show table button on the

toolbar
(D) Select Edit>Add table from the menu

155. What is the first step in creating a form or
report with the form wizard or report wizard?
(A) Selecting the fields that you want to

appear in the form or report
(B) Selecting the underlying table or query

on which you want to base the form or
report

(C) Reading several screens of mostly
useless information and clicking next

(D) Selecting how the form or report should
be formatted

156. Which action will optimize your database
performance?
(A) Set the record set type to Snapshot
(B) Use the compact and repair database

tool
(C) Create a replica of the database
(D) All of the above

157. The arranging of data in a logical sequence
is called
(A) Sorting (B) Classifying
(C) Reproducing (D) Summarizing

158. If a piece of data is stored in two places in
the database, then a
(A) Storage space is wasted
(B) Changing the data is one spot will cause

data inconsistency
(C) It can be more easily accessed
(D) Both (A) and (B)

159. A relational database management
(RDBMS) package manages data in more
than one file at once. How does it organize
these file? As
(A) Tables (B) Relations
(C) Tuple (D) Both (A) and (B)

Answer Sheet
1. (A) 2. (B) 3. (C) 4. (A) 5. (B)
6. (A) 7. (A) 8. (D) 9. (C) 10. (D)

11. (A) 12. (B) 13. (B) 14. (B) 15. (A)
16. (C) 17. (C) 18. (A) 19. (A) 20. (C)
21. (C) 22. (D) 23. (A) 24. (D) 25. (D)
26. (D) 27. (C) 28. (A) 29. (C) 30. (C)
31. (A) 32. (D) 33. (A) 34. (D) 35. (C)
36. (C) 37. (A) 38. (C) 39. (C) 40. (C)
41. (A) 42. (C) 43. (D) 44. (D) 45. (B)
46. (C) 47. (A) 48. (D) 49. (A) 50. (A)
51. (A) 52. (A) 53. (A) 54. (C) 55. (A)
56. (B) 57. (C) 58. (D) 59. (D) 60. (B)
61. (C) 62. (C) 63. (C) 64. (B) 65. (D)
66. (B) 67. (B) 68. (D) 69. (B) 70. (D)
71. (A) 72. (B) 73. (B) 74. (B) 75. (A)
76. (C) 77. (A) 78. (A) 79. (C) 80. (B)
81. (B) 82. (D) 83. (A) 84. (D) 85. (A)
86. (A) 87. (B) 88. (B) 89. (A) 90. (B)
91. (B) 92. (A) 93. (D) 94. (C) 95. (A)
96. (C) 97. (B) 98. (A) 99. (D) 100. (D)

101. (B) 102. (D) 103. (B) 104. (D) 105. (C)
106. (D) 107. (D) 108. (B) 109. (C) 110. (C)
111. (A) 112. (C) 113. (C) 114. (B) 115. (B)
116. (D) 117. (C) 118. (B) 119. (A) 120. (B)
121. (D) 122. (C) 123. (C) 124. (C) 125. (D)
126. (A) 127. (B) 128. (B) 129. (B) 130. (C)
131. (D) 132. (C) 133. (C) 134. (A) 135. (D)
136. (C) 137. (A) 138. (B) 139. (B) 140. (A)
141. (B) 142. (B) 143. (C) 144. (B) 145. (C)
146. (A) 147. (B) 148. (B) 149. (A) 150. (C)
151. (B) 152. (C) 153. (A) 154. (B) 155. (B)
156. (B) 157. (A) 158. (D) 159. (D)
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